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Finding the Information You Need

I’s in the Documentation

Business Objects documentation continues to deliver timely and in depth
coverage of product information. Not just facts about product features, but a
world of knowledge in the way of tips, samples, and troubleshooting
instructions.

For your convenience, Business Objects documentation comes in a variety of
formats including Windows online help, HTML, Acrobat PDF, paper, and
multimedia. What’s more, you can gain quick access to it at any time directly
from the product you are working with.

Documentation has been carefully designed to meet your needs for speed and
ease of navigation. All the information you need is there just a few mouse clicks
away.

The next sections highlight the key features of our documentation.

A Documentation Service on the Web

From the Help menu of all our products, you can check out More Tips and
Samples, the Business Objects documentation service on the Internet. From here,
you can discover the latest updates, tips, samples, and troubleshooting.

You can also get there by pointing your browser to the following URL:
http:/ /www .businessobjects.com/services/infocenter

From the Tips and Tricks page, registered customer support contacts can explore
the electronic version of the Business Objects documentation set. It offers
extensive information on all Business Objects products, updates,
troubleshooting, tips, and much more.

In addition, registered DEVELOPER SUITE customers can download new
documentation and code samples.
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Multimedia

I’s in the Documentation

Business Objects multimedia comprises the BUSINESSOBJECTS Quick Tour, the
INFOVIEW Quick Tour, and the BUSINESSMINER tutorial, all of which cover the
essential features of these products.

The BusinessObjects Quick Tour

The BUSINESSOBJECTS Quick Tour is a multimedia presentation that takes you on
a guided tour of the key features of BUSINESSOBJECTS. Its didactic approach makes
it an ideal primer for first-time users of the product.

You may wish to use it as an accompaniment to the guide Getting Started with
BusinessObjects.

The InfoView Quick Tour

The INFOVIEW Quick Tour is a multimedia presentation that highlights the key
features of INFOVIEW. Intended primarily for new users, it offers an overview of
all the features necessary for managing and distributing documents.

The INFOVIEW Quick Tour can be used as an accompaniment to the guide Getting
Started with WeblIntelligence.

The BusinessMiner Tutorial

This multimedia tutorial teaches novice users how to use the powerful desktop
datamining software, BUSINESSMINER. Each lesson in this tutorial has a narrated,
animated presentation which shows users how to answer a business question
using BUSINESSMINER. Users can then try out the demonstrated tasks themselves
by following the step-by-step exercises in the accompanying guide.

InfoView User’s Guide xi



Finding the Information You Need

Online Guides

Xii

User’s Guides

All user’s guides are available as Acrobat Portable Document Format (PDF) files.
Designed for online reading, PDF files enable you to view, navigate through, or
print any of their contents. The full list of Business Objects guides is provided in
the Deployment Guide.

From a Business Objects product, you can open a guide from the commands of
the Help menu.

e

? Businezz0Objects Help... F1

Businezz0bjects User's Guide. ..
Infoiiew User's Guide. ..
Getting Started...

Buick Tour...

Developer's Guide...

More Tipz and Samples...

Emor Meszages Explained...

Business Objects on the Web ¥

Office 97 Compatible Help...

About BuzinessObjects. ..

The Help menu of BusinessObjects provides commands for viewing documentation.

During installation, the BUSINESSOBJECTS installer program automatically copies
these files to:

Business Objects\BusinessObjects 5.0\ Online Guides\En

You can open a document from the Help menu provided that you have installed
the Adobe Acrobat Reader, version 3.0 or higher on your machine. This Reader is
available on the Business Objects CD-ROM. You can also download it for free
from the Web site of Adobe Corporation.

InfoView User’s Guide



I’s in the Documentation

The Error Message Guide

The Error Message Guide is a compilation of the error messages that can appear
with ordinary use of Business Objects products.

This guide provides you with detailed troubleshooting information so that you
can determine the reasons for an error and take the appropriate steps to resolve
it. It allows you to search for error messages by code. Each error message appears
with its probable cause and the recommended course of action.

You can open this online guide from any of the Business Objects products by
selecting the Error Messages Explained command from the Help menu. From
IINFOVIEW, click Error Messages in the navigation bar.

Click an error message fto go fo its explanation

in the guide.

Acrobat Beader - [Errors51en_pdi] [_ (O] %]

'E File Edit Document Wiew ‘window Help 2 |ﬁ'|1|
Click the Nes B[O T o« DO A
List of Error Messages | |[ Bookmarks “{ Thumbnail » ﬂ
bookmark to view [] Contents - =
the error messages -] Using this Guide |
by code | List of Error Messages

{] Chapter 1 Set-Up and Adminis Lis'l- of Error Messqges

j Chapter 2 Security Error Mess:

j Chapter 3 Universe Error Mess

j Chapter 4 Document and Unive

j Chapter 5 Connectivity Errar Me T.Iu-urmr messages are listed by ._m]u.in .?k_\ll.ll.\-li:..:' order.
Click any error o go o its exact location in the guide.

j Chapter 6 BusinessObjects Ge

j Chapter 7 BusinessOhjects Re 1322224 - An eeror oecurred during the creation of OLE DB for OLAF ebjects,
j Chapter & Data Access Error A
j Chapter 9 OLAP Error Massag AJJ.\l\:lN‘f‘i-L'm\'MM d.mn:lin. mame is no longer valid
. ADMOOM - Document domain name i no longer vald.
j Chapter 10 BusinessQuery Err ADMO01Z - Cannet connect b universe domain,
j Chapter 11 Broadcast Agent Ei ADMOOTA - Integgrity problen Please contect Technical Support
. ADMO015 - Operation failed.
j Chapter 12 Wemnte'“gence Er ADMO0T - Tew many candidates
j Chapter 13 BOManager Error b ADMON26 - Unsupported RDBMS
j Chapter 14 Miscellaneous Errc ADMO3Z - Ersor encountered during processing,
. ADMOI - Ervor upgrading repository.
-] Appendix © Troublesh ! -
(1 Appendix Commaon Traubleshe ADMIGT - You do not have access b this owner name.,

ADMO3S - Urisble b0 delete this Broadcast Agent.
Ask your sdministrator o scan and repair erross on your repository.
ADMO051 - Password expiry information for user name is invalid.
ADMO052 - The regular expression you gave for the st of charschers allowed in the repository is i
ADMO0ES - Parent class has changed.
ADMOO70 - Parent class definition is incorrect.
ADMOOTT - It file ercor: o growp defined on line number.
- Input file error: incorrect action en line number.

%~ Ingpurt file error: no user name defined on line number.
- User in group caused the following error: error message.
annot open the import file name.

- T . -
ADBIOOTY - Cannot open the log fle fle name.
4 | v B [ roos | =[] 4] 13 0re00 | w|m]|[ 7avxcnen | EL] ] »

The Error Message Guide in PDF format.
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Finding the Information You Need

Online Help

For Business Objects Windows desktop products, online help is available in the
form of .hlp and .cnt files that comply with the standards of Microsoft Windows
online help.

From INFOVIEW, online help is available for both INFOVIEW and
WEBINTELLIGENCE.

What to Do for More Information

If you cannot find the information you are looking for, then we encourage you to
let us know as soon as you can. We welcome any requests, tips, suggestions, or
comments you may have regarding the contents of this or other Business Objects
documentation. You can contact us by e-mail at:

documentation@businessobjects.com

To find out information about Business Objects products and services, visit our
Web site at:

http:/ /www .businessobjects.com

xiv InfoView User’s Guide


http://www.businessobjects.com
mailto:documentation@businessobjects.com 

About this Guide

About this Guide

Audience

This guide is about INFOVIEW, a BUSINESSOBJECTS product that provides an
overview of all the documents that you can access in the corporate repository. It
also allows you to view, manage, and distribute these documents.

You can view these document lists in two ways:

* In your Web browser over your corporate intranet, extranet, or the World
Wide Web, using INFOVIEW.
INFOVIEW is described in Part I of this guide.

e From your desktop using the BUSINESSOBJECTS Reader.
This is described in Part II of this guide.

Note: At the end of each of these parts, you will find an index covering the
information in that part of the book only.

The guide is intended for the end user who will be viewing and distributing
documents.

For more information about BUSINESSOBJECTS and WEBINTELLIGENCE, see their
User’s Guides.

InfoView User’s Guide xv



Finding the Information You Need

Conventions Used in this Guide

XVi

The conventions used in this guide are described in the table below.

Convention

How Used

Small capitals

The names of all products such as BUSINESSOBJECTS,
WEBINTELLIGENCE, SUPERVISOR, DESIGNER.

This font The names of BUSINESSOBJECTS classes, objects and

conditions.

For example, Customer, Sales, Revenue, Service, etc.
This font Code, SQL syntax, computer programs.

For example: @el ect (Country\ Country 1d)
() Placed at the end of a line of code, the symbol (...)

indicates that the next line should be entered
continuously with no carriage return.

InfoView User’s Guide
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Chapter 1 Introduction to InfoView

What is InfoView?

INFOVIEW is your personal gateway to your corporate information capital. It
allows you to access documents generated from your corporate data storage from

your office, home, or around the world, using your corporate intranet, extranet,
or the World Wide Web.

To use INFOVIEW, you don’t need to install any additional software on your
computer. All you need is a standard Web or Internet browser.

At the core of INFOVIEW are the document lists that give you an instant overview
of all the documents available to you in the corporate database.

|ﬁ:lEWVIIEW Upload [z Delete Search for:— Refresh List Expand
Welcome
Categories: |All categories 'l 15 available documents This list was last refreched: Jan 25 14:17:56 2000
Corporate B |Name a From Date Size
Documents
Personal ¥ Accessaries Revenue G2 james Jan 05 11:156:46 2000 16 K
Documents M8 documentation uger Jan 25 14:08:07 2000 8003 K
Inbox l‘ﬂ eFashion Analysis pete Moy 17 18:05:44 1559 Ak
Documents rﬂ Holiday Revenue 1999 Fhilip Jan 05 10:58:43 2000 40 K
Scheduled [} T htrnlconvert maryn Jan 05 10:43:22 2000 19 K
Bl T noview User's Guide user Jan 25 14:16:01 2000 1640 K
Create ™ ¥ ko yward List boss Mov 16 14:16:15 1959 13K
Documents 7% price tracking 2000 user Jan 25 14:17:56 2000 7K
¥ Projected Sales - @1 2000 janis Jan 05 11:00:04 2000 4K
Search M ¥ 04 sales with discount Fhilip Jan 05 10:57:11 2000 804 K
Options l'ﬂ Sales Comparison-G3taQ4 james Jan 05 11:14:35 2000 36 K
r® Tips released on InfoCenter bass Mov 03 18:26:47 1959 18K
Logout "™ TipsExample pete Mov 04 13:04:17 1993 45K
Help ¥ Tatal Sales - 1999 maryn Jan 05 10:54:36 2000 16 K
- T Useful info maryn Jan 12 16:58:23 2000 K

INFOVIEW includes up to three document lists:

* The Corporate Documents page is a catalog of all the documents that you are
allowed to access in the corporate repository, the centralized BUSINESSOBJECTS
storage and distribution mechanism that manages universes, user
information and document exchange.

As long as you have the right to view a single corporate document, INFOVIEW
contains this list.

e The Personal Documents page lists the documents you've saved for your own
personal use.

* The Inbox Documents page shows you the documents that other users have
sent you.
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What Documents Can You Access with InfoView?

These lists not only keep you on top of all the documents likely to impact your
work, but provide you with the means to view, update and manage those
documents. You can save documents for your personal use, send them to other
users, and publish them to the corporate repository for broader circulation.

What Documents Can You Access with InfoView?

INFOVIEW allows you to access documents that have been created using either
WEBINTELLIGENCE or BUSINESSOBJECTS, and any other documents that are
uploaded to the repository, such as Word documents, Excel spreadsheets, and
PDF files. For information about how WEBINTELLIGENCE and BUSINESSOBJECTS
documents are created, see “How are Documents Created?” on page 24.

You can use INFOVIEW as your common entry point for viewing, managing,
distributing, and downloading any document in your corporate repository.

The documents you view may contain simple tables or charts or complex
documents with hyperlinked indexes created in WEBINTELLIGENCE, which allow
you to navigate instantly between a document’s sections.

Download Drill Refresh Edit Sawve Publish Send <

Last reffech: 1/12/00 02:49:03 PR & |

Sales Revenue

Accessories

Sales revenue

$600,000 |
5400.000 |
$200.000

Massachussetts
New ok

Texas a1

Because you're using a Web browser, you may also read documents containing
hyperlinked images and sound or video objects. For example, by clicking the
name of a model in an imported car catalog, a document could launch a video
showing a 360° view of the car, as well as its interior features.

InfoView User’s Guide 21



Chapter 1 Introduction to InfoView

You can view and edit documents that have been uploaded to the repository from
other sources, such as a Word document, an Excel spreadsheet, or a document in
Acrobat PDF format as shown below:

WEBINTEWIGENCE
INE*VIEW

weicome UNERALEE S RO s e
[ Bookmarks 3 id
E+L ] Chapter 1 Infroduct = =
Corporate ) ] :
Documents [ wihatis Infovie —
-[] What Documen
Personal [ How are docur H H
Documents [ WhatCan You Chapter 1 |n|‘rOdUCfI0n 10 |nfOV!9
Inbox -Dcugmm\zmg\m R, B
Documents D Gaing straic
Scheduled D Choosing h In this chapter
Documents -] Ghoosing a
rhatis InfoView?
Create ) Infoiew and B O Whatis InfoVIew? ....ovveieinesiiiaiaiieeaieiaiaea, 21
Documents 4 What Documents Can You Access with InfoView? ............ 23
4 How are documents created? ...........o.uuieiueneeiiieiiio, 35
Search
4 What Can You Do with InfoView? 2
Options
a . . b2
©formation you need z
Logout splay document lists 2
ument format 2%
Help
4 InfoView and BusinessObjects Reader..........ooouiiciii., 28
';I B
4 | » L0 T . N I T S 1 | e N = W | r
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What Documents Can You Access with InfoView?

And, depending on your user rights, you may even be able to install
BUSINESSOBJECTS from your browser to view, create and edit documents.

!‘ BusinessDbjects - eFashion Analysis.rep - [user@casal
ﬁ File Edit Wiew Insert Fomat Tools Dats Analesis Window Help &1 x|
CERIER[ (2R Xals « | BARE@|£Q | <[k |
_— %] 3l
& Data I@ Map | 7 R a
. g Product Sales by City
g EIE;S for year 2001
@ Month
-8 Quarterfctual) Austin salesrevenue $1 ,135,479.10
@ QuarterBudgst)
- @ Region "
@ Average margin frarain $424s790'00
@ M
@ Vorginas ey i Boston salesrevenue $887,169.20
- @ Projected Sales Reveny
@ Cuantity sold margin
- @ Sales revenue $336,574.10
(-8 Fomulas Chicago sales revenue $1 ,134,08540
margin $439,865.00
Colorado Springs sales revenue $6843,584.20
margin $309,966.00
Dallas salesrevenue $803,420.80
| ] L i margin EAOE A AR AN _’lLI
© a o El Revenue Tear 2001 I @ Rewenue by Region I @ Product Analysis I
[ [LastExec: 2/23/93 01:53 PM MM 4

Note: The actions you may perform on a particular document or document type
depends on your user rights. If you have a question regarding your user rights,
ask your system administrator.
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Chapter 1 Introduction to InfoView

How are Documents Created?

WEBINTELLIGENCE and BUSINESSOBJECTS users use the same BUSINESSOBJECTS
technology to query a database or data warehouse for the purpose of generating
documents.

The two basic mechanisms in this technology are:
* The Universes used to build queries

e The Queries used to retrieve information from data storage

Universes

A universe is the business-intelligent semantic layer that isolates users from the
technical issues of the database.

Universes are made up of classes and objects.

* Objects are elements that map to a set of data from a relational database in
terms that pertain to your business situation.

For example, the objects in a human resources universe might include Names,
Addresses and Salaries.

e Classes are logical groupings of objects.
For example, the objects listed above might belong to a class called Employees.

In your company or organization, universes are created by a universe designer,
using BUSINESSOBJECTS DESIGNER. WEBINTELLIGENCE and BUSINESSOBJECTS
REPORTER users then use these universes to access the data they need from the
database through an intuitive, user-friendly interface.

Queries

If you have the right to create documents, you can build queries by adding objects
from a universe to a document editor and organizing the objects so that the data
is clearly displayed. When the users run the query, the data mapped to the objects
in the query is retrieved from the database. A document is then generated using
the data and formatting defined by the user who designed it.
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Example

How are Documents Created?

Running a query to retrieve data and generate a document

The image below displays three objects that a document designer has added to
the WEBINTELLIGENCE document editor. Each of these objects represents a unit of
data that WEBINTELLIGENCE will retrieve from the database.

& Resort | & Sales Personl @ |Revenue |

When the query is run, WEBINTELLIGENCE generates a document containing the

following simple table:

Bahamas Beach |Fischer £9,696.00
Eahamas Beach|Galagers 20778400
Bahamas Beach |Ishimoto 180,348.00
Eahamas Beach |Magata 470000
French Riviera  |Fischer £9,240.00
French Riviera |Galagers 24639500
French Riviera  |Ishimoto 226,275.00
Hawaiian Club  |Fischer 94 950.00
Hawiaiian Club | Galagers 288 960.00
Hawaiian Club  |Ishimoto 23826000

Note: For more information about creating WEBINTELLIGENCE and
BUSINESSOBJECTS documents, refer to the Weblntelligence User’s Guide and the
BusinessObjects User’s Guide.
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Chapter 1 Introduction to InfoView

What Can You Do with InfoView?

All the rights you have as a user are granted by your BUSINESSOBJECTS supervisor
using SUPERVISOR. The supervisor defines:

e The parts of the INFOVIEW interface you can access.
If required, your supervisor can restrict the availability of INFOVIEW
functionality, such as access to particular document lists, publishing, etc.

* Your database connections

e The document domains you can access in the repository
This includes both reading corporate documents stored in those document
domains, and publishing documents to those domains

The rights accorded each user define the user’s profile. It is this profile-based
security system that allows a single document to be distributed to many users --
with end users having access only to the information that they are authorized to
see.

Customizing InfoView

You can maximize your efficiency by personalizing INFOVIEW to conform to and
even enhance your working habits. Here are some ideas to get you started.

Going straight to the information you need

Waste no time getting down to the vital tasks you perform most often. Here’s an
example of how to go straight to the information you need. You can set up My
InfoView to instantly show you the information you need by dividing the
browser window into several panels, each displaying different information.
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Example Always viewing the most important information first

If your job centers around sales strategy, analysis of the latest sales figures from
your company’s branches throughout the country is crucial to your work. You
may therefore want to set My InfoView to display, a web page showing you how
your company is doing in the stock market, Ca particular document from the
Corporate Documents list showing the sales figures that are updated daily, and
your Inbox Documents list so you can quickly access the documents sent to you
by other people in your company. Your page would look similar to this:

WERINTEIL

- "
I N F VI Ew BusINESS OBJECTS*

Zoom

My InfoView

YAHOO! FINANCE 74 Hame - ehool- Helo B

Corporate
Documents
Thu May 18 10:17am ET - U.S. Markets close in 5 hours 44 minutes.
Do 10857.98 +35.24 (+U.82%)|Nasdag 3650.43 +5.47 (+U.15%)|S&P 500 1456.81 +2.01 (+0.62%)

MYEE Volume 150,965,[I[IU|Nasdag “olume 234,?1B,UU[I|3UVW Band 6.195% +0.021 |

Personal
Documents

4 Inbox
Documents

Scheduled
START INVESTING oNLIN
Documents e : WITH JUSTEqu.

Create

Documents
Zoom |ty o page I /7 » M

Search

=1

iy

meritrade®

Inhox Documents : 9 available documents This list w:

Options

B |Name a

) Accessories Revenue 02 use Sales

EAECESEDHEE Revenue 02 mar evenue
™ euroconye mar
i Holiday Revenue 1393 i E $297
) lessons

D @ 1A oo itk dineg et
< |

Logout

Help

To find out how to set up My InfoView, refer to “Configuring My InfoView” on
page 50.

Choosing how to display document lists

Decide whether you want your document lists displayed in Compact mode --
thus displaying more document titles per view -- or in Expanded mode to include
both more information about each document, and a range of instant action links.
For more information, refer to “Compact or expanded document list display” on
page 41.
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Choosing a default document format

The default format in which you view BUSINESSOBJECTS documents depends on
the browser and the operating system you use. If you want to be able to view
BUSINESSOBJECTS documents exactly as they appear in the BUSINESSOBJECTS
product, but don’t have access to BUSINESSOBJECTS, you can choose either
Enhanced document format or PDF Acrobat Reader. Both of these formats allow you
to take advantage of WYSIWYG (What You See Is What You Get) printing. You
can also choose to view BUSINESSOBJECTS documents in Standard HTML format.

To find out how to set a default document format in INFOVIEW, refer to “Selecting
how you want to view BusinessObjects documents” on page 58.

InfoView and BusinessObjects Reader

BUSINESSOBJECTS READER lets you view, refresh and distribute BUSINESSOBJECTS
documents directly from your desktop. It has the advantage of allowing you to
work with BusinessObjects documents in offline mode, i.e., no network or web
connection is required. You can also view unformatted versions of
WEBINTELLIGENCE documents in BUSINESSOBJECTS READER.

INFOVIEW is the Web interface to your business information, whereas
BUSINESSOBJECTS READER provides access to information from your desktop. Part
One of this guide explains how to use INFOVIEW to view and manage documents,
and Part Two explains how to use BUSINESSOBJECTS READER.

For more information on what you can do with BUSINESSOBJECTS READER, refer to
“Introduction to BusinessObjects Reader” on page 145.
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Checking Your Browser Configuration

Checking Your Browser Configuration

For INFOVIEW to run correctly, you need to make sure your browser configuration
is adapted to INFOVIEW use. For example, your browser needs to be cookie
enabled so that you can log in.

You should run an automatic check for any potential configuration problems
before you log into INFOVIEW for the first time. If your browser is not supported
by INFOVIEW, click Supported Browsers in the Browser Check page. This page
contains a list of supported browsers and the links to the web pages where you
can download the browser you need.

To check your browser:
1. Start your Internet browser.

2. Point your browser to INFOVIEW using either the bookmark or the URL your
INFOVIEW system administrator has given you.
The INFOVIEW login page opens.

WeBINTEILICENCE

Vv =
I N F . I EW BusINESS OBJECTS*

‘Welcome to InfoView, the personal gateway to your enterprise infarmation capital. Info'iew lets you access
and distribute documents fram hame, the office, or around the world

» MNew Users: click the Check Browser button 1o the left to make sure your browser is properly
configured to use this system.
» Toaccess on-line help, click the User Help button to the left.
» Click the Log In button below to access the system.

If your login page doesn’t look like the image above, don’t worry. Your system
administrator may have customized it for use in your company or
organization.
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3. Click Check Browser. The Browser Check page opens.

WenlMTe L IcEMAE

INF* VIEW

BUSINESS OBJECTS*

» Browser Check

To make sure that the systern will run properly, this check page evaluates your browser configuration
and suggests how to make any needed adjustments.To star, click the Check Browser button below.
Then follow instructions in the Status section. You can also click the Supported Browsers button to
see which browsers are supported.

Supported Browsers

4. Click Check Browser.

After a few seconds, INFOVIEW displays information about the browser you're
currently using in the lower part of the page.

Your browser settings are fine. Click the Back to Login' button to log in to InfoView. If you experience
problems logging in, ask your systern administrator to make sure your firewall accepts cookies. If your
Java Virtual Machine (VM) is highlighted blue, it is a non-supported one, but it may still work properly. If
you have problems creating new reports, reguest instructions from your Administrator about installing a
supported Java Yirtual Machine. To see a list of supported JvMs, click here

Client Configuration Details

Erowser MWlicrosoft Internet Explorer
Browser Version 50

Script engine JScript

Script engine version 503715

Cookies enabled Yes

Java enabled Yes

Java Virtual Machine Microsoft Corp. 1.1.4{5.0.3167)
Erowser platform Win32

If you can’t see all this information, use the scrollbar to scroll downward.

In this page’s fields, fatal problems are displayed in bold and in red. Warnings
are highlighted in bright blue.
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Note: If your browser isn’t JavaScript-enabled, it cannot run the Check Browser
feature, and an error message appears.

If your Java Virtual Machine (JVM) was highlighted in blue when you performed
the Browser Check, then the JVM you are using is a non-supported one.
INFOVIEW may still work properly, but if you encounter any problems when
creating documents in WEBINTELLIGENCE, you may need to install a new JVM.
Click Supported Browser for a list of supported browsers and instructions on
where to find them.

5. For a suggested solution to any problem or warning, simply click on the text.
6. For a list of supported browsers, click Supported Browsers.

7. Click the Back to Login button to return to the INFOVIEW login page.
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Logging Into InfoView

To log into INFOVIEW, you need the following from your INFOVIEW system
administrator:

* Your user name and password
If you're already a BUSINESSOBJECTS user, you can use your BUSINESSOBJECTS
user ID and password to enter INFOVIEW.

* The URL or a bookmark which allows you to access INFOVIEW

Note: Depending on how your system administrator has set up your account, the
pages giving you access to INFOVIEW may not resemble the pages displayed
below. You may not even be prompted for a username and password.

If you need help launching INFOVIEW, contact your administrator.

To log in:
1. Start your Internet browser.

2. Point your browser to INFOVIEW using either the bookmark or the URL your
system administrator has given you.

The INFOVIEW login page opens.

WERINTEILI

N v AENAE
INF . IEW BUSINESS OBJECTS'

m Welcome to InfoView, the personal gateway to your enterprise information capital. Infotview lets you access
and distribute documents from home, the office, or around the world

m = Mew Users: click the Check Browser button to the left to make sure your browser is properly
configured to use this system.
s Toaccess on-line help, click the User Help button to the left.
« Click the Log In button below to access the systam

If your login page doesn’t look like the image above, don’t worry. Your system
administrator may have customized it for use in your company or
organization.
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3. Click the round Log In button.
The Login dialog box appears.
[ 7] ]

Enter Network Password

Fleaze type your uger name and password.

Site: casa

Fealm ‘weblnteligence [17:21:45 Feb 16 2000]

User Mame Iuser

Passward I"""ﬁ

™ Save this password in pour password list

()8 I Cancel |

4. Enter your user name and password in the entry boxes, then click OK.
Your INFOVIEW start page loads up and you can begin working in INFOVIEW.
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Your InfoView Start Page

The INFOVIEW start page is the first page that opens when you start INFOVIEW and

is your main interface for viewing, managing and distributing all of the
documents in your corporate database, including WEBINTELLIGENCE and

BUSINESSOBJECTS documents.

The first time you start INFOVIEW, the Welcome page or the default page created

by the supervisor opens. The Welcome page contains short descriptions of

INFOVIEW and WEBINTELLIGENCE features and provides links that let you access

them immediately.

INF* VIEW

Welcome linkin
the navigation
bar

Welcome User

InfoVisw s you
IndoViow Walcome page, =
BusinussOhjects o« Weblntelig

sword, how your Socumant §a1e 4 displaged, youl stat page, sad mese

J can pesdorm

Use the Options page 10 set your parsonal InfoView preferances, such &

Aok hese st gn the Opthens ok o the nevgatieo b o ihe #f 10 ga 1 ihe Opdions page.
Go!

 Create Naw Documents

ot 3 wharwese you e . Infollew s your steting point for Susinesebjects and Weehinselligence, i fkchet

nsgation bae on the beh side The Walcome page is the defush stant page, and & guide |0 wewng ssd

Nined s0me hlp gecing séated? Ga 10 the Qnlime Lisar linlp bom ks, § describes infoView and Webiniediigence leaturea and inéeraces. I also provides completn instructions f
Wz,
Y allthe InfoView tasks n

You can define a different start page, however, simply by selecting it from the list
in the Options page. For example, you can customize the start page to display up
to four panels of information at once. See page 50 for more information on setting

your Default Start Page.

You can get back to the start page at any point by clicking Welcome or My

InfoView in the navigation bar.
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What InfoView Pages Look Like

INFOVIEW pages have three parts:
e The page contents
* The topbar

e The navigation bar

The page contents

The page contents occupy the largest frame in the browser window, and are the
part which most visibly changes as you navigate from page to page.

Page Contents Top Bar
Iﬁi?grvim Upload [51 Delete Sear[:hfur:— Refresh List
My InfoView -
Cateqories: | All categaries 'I 15 available documents This list was last refreshed: Jan 25 14:17:56 2000
Corporate
Documents
Personal I #9 Accessories Revenus 02 james Jan 05 11:15:46 2000 16
ESS @ documentation user Jan 25 14:08:07 2000 5003
. . = Inbox r ™) eFashion Analysis pete Mow 17 18:05:44 1999 1189
Navigation Bar Documents = % Holiday Revenus 1559 Philip Jan 05 1055 43 2000 a0
pcheduled N T htmlconvert maryn Jan 05 10:43:22 2000 19
ocu(:nen ® = T Infaview User's Guide user Jan 25 14:16:01 2000 1640
reate .
Documents [l Keyword List boss Mov 16 14:18:15 1999 13
rﬂprice tracking 2000 user Jan 25 14:17:56 2000 17
™ ¥ Projected Sales - @1 2000 janis Jan 05 11:00:04 2000 41
Rl [ P 04 cales with discount Philip Jan 05 10:57:11 2000 804
Options - M sales Comparison-G5toQd lames Jan 05 11:14:38 2000 36
Y t ™ ¥ Tips released on InfaCenter boss Mow 03 18:26:47 1999 18
Ml ™) TipsErxamole pete Now 04 13:04:17 1593 45
Help I~ # Total Sales - 1999 maryn Jan 05 10:54:36 2000 16
- T Useful info maryn Jdan 12 16:58:23 2000 26
'l | >|

INFOVIEW document lists, and all the interfaces which permit you to view and act
on documents are displayed in this part of the browser window.
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The topbar

The topbar running across the top of the page changes according to the page’s
contents:

e If the page’s contents include a document list, the topbar is a contextual
toolbar containing links which allow you to upload documents, delete them,
search for them, or refresh the document list.

lﬁi?wvl'(éw Upload [z Delete Search for:— Refresh List Expand

e If a document is open, the topbar contains links allowing you to act on the
open document.

My InfoView € page_,.-‘nz Download Drill Refresh Edit Save Publish Send Delete ¢

* Otherwise, the topbar can simply be a graphical header.

The navigation bar

The navigation bar on the left side of the INFOVIEW page remains constant no
matter what page you open. The links it contains are determined by your user
profile which is set by your system administrator.

L
My InfoView

Corporate
Documents
Personal
Documents . . . . . . . .
nbox Tip: You can customize the navigation bar by inserting a picture at the top of it.
Documents For instructions on how to do this, see page 48.
Scheduled
Documents
Creat . . 7
Documents Depending on the access rights you've been accorded by the BUSINESSOBJECTS
supervisor, the navigation bar lets you access up to three different document
Search catalogs:

Options

e The Corporate Documents page

Logout e The Personal Documents page

e ¢ The Inbox Documents page

Depending on your user rights, Create Documents may appear in the navigation
bar. This option allows you to create documents in WEBINTELLIGENCE and /or
BUSINESSOBJECTS. Refer to “Selecting the type of documents you want to create”
on page 56 for information about setting the options for creating documents. The
navigation bar also gives you access to other INFOVIEW pages:

e The Welcome Page or My InfoView Page
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* The Search page
e The Options page
e The Help page

Note: For information about creating documents with WEBINTELLIGENCE, see the
printed Weblntelligence User’s Guide or the WEBINTELLIGENCE On-line User’s Help.
For information about creating a BUSINESSOBJECTS report, refer to the
BusinessObjects User’s Guide.
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Accessing Documents

40

IS

oo

You can access existing documents from document lists in the Corporate
Documents Page, Personal Documents Page, and /or Inbox Documents Page.

* To open any of these pages, just click its name in the navigation bar.

You can always access the Personal Documents and Inbox Documents pages. To
access the Corporate Documents page, however, you must have the right to read
atleast one corporate document. You have been granted these and all other rights
by your BUSINESSOBJECTS supervisor.

Document lists can include WEBINTELLIGENCE and BUSINESSOBJECTS documents,
as well as any other documents that have been uploaded to the system. You can
recognize each type of document by the icon preceding the document in the list.
Some examples of document types are:

Categaries: |All categaries 'I 15 available documents This list was last refreshed: Jan 25 14:17:56 2000
B |Name a From Date Size
¥ Accessories Revenue 02 james Jan 05 11:15:45 2000 16K
—1— B documentatian user Jan 25 14:08:07 2000 8003 K
——F'FT eFashion Analysis pete Moy 17 18:05:44 1999 ERS
™ ¥ Holiday Revenue 1999 Philip Jan 05 10:58:43 2000 40 K
— ' ralconvert maryn Jan 05 10:43:22 2000 18 K
——rﬂ Infoview User's Guide user Jan 25 14:18:01 2000 1640 K
m® Keyword List boss MNow 16 14:18:15 1999 13K
—— price tracking 2000 user Jan 25 14:17:56 2000 17K
™ ¥ Projected Sales - 1 2000 janis Jan 05 11:00:04 2000 41K
—— ¥ 04 sales with discount Philip Jan 05 10:57:11 2000 804 K
) 2ales Comparison-G3toQ4 jarmes Jan 05 11:14:35 2000 36 K
a. Zip file

b. BusinessObjects document
c. Microsoft Word document

d. Adobe Acrobat PDF file

e. Microsoft Excel spreadsheet
f. Weblntelligence document

These icons also let you perform the following operations on their corresponding
document:

e (lick on an icon to view the document’s attributes.

¢ Right-click an icon to open a contextual menu which provides you with a
variety of Web-related actions on the document.

e To view a document, just click its name in the document list.
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Note: For more information about document lists, see “Compact or expanded
document list display” in the next section, “Filtering document lists” on page 43,
and “Using the Quick Search facility” on page 43.

Compact or expanded document list display

You can display document lists in either Compact or Expanded mode by clicking
Compact or Expanded in the toolbar.

The default setting is Compact, which lets you see more document entries
without having to scroll. However, you can change the default setting for each
document list page in the Options page.

Compact mode

In Compact mode, each entry consists of a single line:

7 9 Annual Results Mov 16 15:53:39 1993 14 K
e CQuarterly Restauration Revenue Mov 16 15:55:33 1993 oK
I ¥ Resort Revenue Mav 16 15:54:35 1593 4 K
7™ SR1996 Mov 16 15:56:26 1598 5K

It includes:

¢ The document name

* The name of the document publisher (for corporate documents)
e The date the document was last published or updated

e The file size

Setting the sorting order in document lists

Use the bar at the top of the document list to set the order in which documents
are displayed.

Click the attribute you want to use as the sorting criterion, for example, name.
The first time you click an attribute, a white triangle pointing upward appears
next to the attribute, for ascending order.

If you click the same attribute again, the triangle points down, and the documents
are displayed in descending order.
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Deleting multiple documents

When you have the right to delete a document, a small box is displayed at the left
of its entry.

e To delete one or more documents, check this box for each document you want
to delete, then click Delete in the toolbar. For complete information, see
“Deleting Documents” on page 117.

Expanded mode

In Expanded mode, each document entry contains four lines:

¥ Q4 sales with discount (Dacument)
Description: 4 sales including post-Christmas discount.

Jan 05 08:57: 11 2000 - From: Philip - Docurment size: 804 K
Load into spresdshest Save Send to wsers Edit Delete Propedies

Line no.... Contains...

1 The document’s name. If it’s a corporate document, the
document domain in which the document is stored is displayed
in parentheses.

2 The document’s description, if it has been given one.

3 The time and date the document was last modified, the
document’s author (corporate documents only), and its size.

4 A series of links which let you perform actions on the document
without having to open it. These can include:

* Load its data into a .csv or other spreadsheet file such as
Microsoft Excel (for WEBINTELLIGENCE documents)

¢ Download it to a BUSINESSOBJECTS .rep file (for
BUSINESSOBJECTS documents)

* Save it as a personal document

¢ Send it to another INFOVIEW, WEBINTELLIGENCE or
BUSINESSOBJECTS user

e Edit the data in the document (depending on your user rights)

e Delete it

* View the document’s properties
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Filtering document lists

Over time, the document lists in your Corporate and Personal Documents pages
can include so many documents that the lists are no longer manageable--even in
Compact mode.

Documents can be assigned to filtering mechanisms called categories. You can
filter the documents in a list to display a more selective subset of documents by
selecting a category from the Categories drop-down list at the top of the
Corporate or Personal Documents page. INFOVIEW instantly filters the list to
display the documents in the selected category only.

For example, when you select Marketing in the Categories list box, only
documents that were assigned to the Marketing category when they were
published are listed. This makes the list of documents shorter, more manageable
and more pertinent.

By default, the attribute All Categories is selected. This means that the entire list
is displayed.

If you have the appropriate rights, the word Categories is blue and underlined,
indicating a hypertext link. If you click on this link, the Category Management
page is displayed, where you can create, update and delete categories.

For complete information about categories, see “Using Document Categories” on
page 96.

Using the Quick Search facility
If you're having trouble finding a document on a page, you can use the Search for
feature in the INFOVIEW toolbar to search for that document.
To do a quick search:
1. Enter part or all of the document name in the entry box.
2. Press Enter.
The list of documents corresponding to your search criterion is displayed.
To return to your original document list, click the Back button in your browser.

INFOVIEW also provides you with a more sophisticated search tool on the Search
page. See also “Searching for Documents” on page 71 for information on more
powerful document searches.

Tip: If you find yourself using the Quick Search facility often, it may be time to
start assigning your documents to categories so that you can filter your document
lists.
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Note: You can also search for documents by extension, for example, .doc or .txt.
This type of search is only available for non-BUSINESSOBJECTS documents.

The Corporate Documents Page

44

Corporate documents are documents that have been saved to a document domain
in the corporate repository and made accessible to workgroups within your
corporation or organization.

To access the list of corporate documents you're allowed to read, click Corporate
Documents in the navigation bar.

|I‘\V:ICIEWVIWE:W Upload m'i Delete Search for:_ Refresh List Expand
Welcome
Categories IA” categonies ¥| 15 available documents This list was last refreshed: Jan 25 14:17:56 2000.
Corporate B [Name a From Date Size
Documents
Personal I ¥ Accessories Revenue G2 James Jan 06 11:15:46 2000 16 K
Documents & documentation uger Jan 25 14:08:07 2000 8003 K
Inbox 1™ eFashion Analysis pete Mov 17 18:05:44 1999 LELS
Documents r L) Holiday Revenue 1339 Philip Jan 05 10:65:43 2000 40 K
Scheduled [l T bimlconvert maryn Jan 05 10:43:22 2000 18 K
Documents Iy R e user Jan 25 14:16:01 2000 1640 K
Create [l pwinrd List boss Mov 16 14:18:15 1999 13 K
Rasitdl ¥ vics tracking 2000 user Jan 25 14:17:56 2000 17 K
¥ Projected Sales - @1 2000 janis Jan 05 11:00:04 2000 41 K
Search rﬁ Q4 sales with discount Philip Jan 05 10:67:11 2000 804 K
Options r ¥ cales Caomparison-Ci3tali4 james Jan 05 11:14:38 2000 36 K
7 ¥ Tips released on InfaCenter bass Mov 08 18:26:47 1999 18 K
Logout ™ TinsExample pete Mov 04 13:04:17 1999 15K
Help r ¥ Total Sales - 1999 maryn Jan 05 10:54:35 2000 16 K
r % seful info maryn Jan 12 16:58:23 2000 26 K

By default, all the documents for which you have read rights are displayed. These
rights, as well as the actions you can take on these documents, are determined by
the BUSINESSOBJECTS supervisor.

If this document list becomes overly long and unwieldy, you can make it easier
to manage and understand if you display only a subset of all these documents.
See “Filtering document lists” on page 43.
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The Personal Documents Page

Personal documents are documents you have saved for your personal use. They
can be documents you have created, corporate documents of which you have
saved a personal copy, or documents sent to you by other users that you've
saved.

To access the list of your personal documents, click Personal Documents in the
navigation bar.

A N GENC .
|“EWV|IM upoat  (ZAnetete  search for: [ | | | A oo

My InfoView
Persanal Categories: IA” calegories 'l 3 available documents
Corporate K |[Name & Date Size
Documents
Personal - ED gocumentation Jan 25 14:08:07 2000 8003 kK
Documents [ "1 eFashion Analysis Nev 17 18:05:44 1999 M9 K
O % Holiday Revenue 1999 Jan 0 10:56:-43 2000 40 K
Documents % himlconvert Jan 06 10:43:22 2000 19 K

By default, all the documents in your Personal Document storage area are
displayed. If there are too many documents, however, you can make this list
easier to manage and understand if you display only a subset of the documents.
See “Filtering document lists” on page 43.

The Inbox Documents Page

Your Inbox Documents page contains documents that other people have created
and mailed to you.

If you have documents waiting in your Inbox Documents page when you log in,
the envelope outline next to the Inbox Documents link in the navigation bar
changes to a yellow envelope.

Your inbox contains no new | Someone has sent you a document
documents. that you haven't yet read.

Inbox = Inbox
Documents Documents
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To access the list of documents in your inbox, click the Inbox Documents link.

Wy InfoView 2 available documents This list was last refreshed: Jan 05 15:12:24 2000.

B |Name a From Date

Corporate

Documents
personal ™ eFashion Analysis pate Moy 17 18:06:11 1998 119 K]
[LPVbroal |~ SO Total Sales - 1990 maryn Jan 05 15:11:41 2000 16 K

2 Inbox

Documents

Documents that you have not read are flagged with envelope icons (see image
above).

The envelope does not change to indicate that you have received a new document
in your Inbox while you are logged in. To see any documents that you receive
while you are logged in, you must refresh the Inbox Documents list.

Tip: INFOVIEW does not automatically clear your inbox of documents you've read.
To prevent this page from becoming cluttered you should immediately delete the
documents that you are done with.

Act on the remaining documents as soon as possible, by downloading, saving,
publishing, or sending them, then delete them from the inbox.
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Customizing InfoView

INFOVIEW allows you to customize your account so that it is tailored to your

needs.

The Options page has six sections containing settings that allow you determine
what types of documents you create, how you view documents, and the
appearance of your INFOVIEW account. The options available to you depend on
the user rights given to you by the supervisor.

The Options page looks like this:

» Personal Options
Document Lists

Create and Edit Documents

View Documents = Universe Password

Personalized Picture

INDne
The picture will he maized t TS,

To include an image in the upper left cormer of your browser's
window, enter the URL for the image in the box

Test

Default Start Page
Select the page you want displayed whenever you
open Info'view.

@ ielcome page

 Corporate Documents page

' Personal Documents page

© Inbox Documents page

My Infoview custamize your Start Page

Feset This Form

Apply All Changes

e Start Page

Lets you specify your INFOVIEW start page and insert a picture at the top of the
navigation bar.

* Document Lists lets you:

* Set whether document lists are displayed in Compact or Expanded format.

* Specify a document category to be used as default filtering criterion.

* Specify when to refresh the list (Corporate and Inbox Documents lists

only).

e Create and Edit Documents

Lets you choose what type of documents you want to create,
WEBINTELLIGENCE or BUSINESSOBJECTS, and what form of the Web Panel you
use to create and edit WEBINTELLIGENCE documents.

e View Documents

Lets you specify in which format you view BUSINESSOBJECTS documents.

e Universe

Lets you specify how you view the list of available universes and how often
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the list is refreshed.
e Password

Lets you change your INFOVIEW / WEBINTELLIGENCE / BUSINESSOBJECTS
password.

Setting a picture

You can configure INFOVIEW to display a picture at the top of the navigation bar.

WEBINTELLIGENC
INE*'VIEW

Categaries: IAII categories 'l
r®

Welcome r 1-—.*] AddDac

- ™ Annual

rEa
~ ¥ Country1

Corporate

This picture should be a .gif, .jpg or .jpeg image 70 pixels wide by 95 pixels high.
If it isn’t, the browser forces the picture to those dimensions, resulting in a
distorted picture.

You can put your picture on an available HTTP server then use that server’s URL.
In some cases it might be easier to have the picture file on your own computer.
The URL could appear in one of the following formats:

e file://<Drive Name>/<FilePathAndName>

e http://<Server Name>/<FilePathAndName>

For example, a valid URL might be file://C:/Windows/Myself.gif
To define the picture to be displayed in your INFOVIEW:

1. Click Options in the navigation bar.
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Document Lists Create and Edit Documents

» Personal Options

View Documents  Universe Password

Personalized Picture

Toinclude an image in the upper left comer of your browser's
window, enter the URL far the image in the box

|Nnne Test

The picture will be resized to 70095..

Default Start Page

Select the page you want displayed whenever you
open Info'view

& Welcome page

€ Corporate Documents page

© Personal Documents page

© Inbox Documents page

© My Infoview customize your Start Page

Feset This Form | Apply All Changes |

2. Inthe Start Page options, type your picture’s URL in the Personalized Picture/

URL Location box.

» Personal Options

Start Page Document Lists Create Documents

Personalized Picture
To include an image in the upper left comer of your browser's
window, enter the URL for the image in the box.

Is BN JserDocs\Efashion. JPG  Test |
The pickure will e maized fo Fok9S5..

3. Click the Test button.

This makes sure that the picture is at a valid URL that can be reached by your

browser and INFOVIEW.

4. Your browser displays the picture at the top of the navigation bar. Click the
Apply All Changes to save your changes.
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Setting your Start Page
Once you have logged in to INFOVIEW, your start page opens automatically. By
default, this is the Welcome page.

You can set the default start page to display the Welcome, Corporate Documents,
Personal Documents, Inbox Documents page, or My InfoView.

To specify your default start page:
1. Click Options in the navigation bar.
The Options page is displayed.

2. Inthe Default Start Page section of the Start Page options, select the page you
want to be your start page.

ints View Documents  Universe Password

Default Start Page

Select the page you want displayed whenever you
open Infoiew.

& Welcome page

' Corporate Documents page
' Personal Documents page
' Inbox Documents page

' My Infoview customize your Start Page

3. Click Apply All Changes to save your changes.

Note: If you selected My Infoview as your start page, refer to “Configuring My
InfoView” on page 50 for information on how to set up My InfoView.

The next time you launch INFOVIEW, it will automatically open to the selected
page.

Configuring My InfoView

The My InfoView start page allows you to divide your browser window into
several panes. This allows you to view important information from different
sources at the same time in your browser window. You can display up to four
panes at once, each pane containing one of the following:

e Inbox Documents list
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* Corporate Documents list

e Corporate document

* Personal Documents list

* Personal document

° Web page

To configure your My InfoView:

1. Click Options in the navigation bar.

2. Inthe Default Start Page section of the Start Page options, select My InfoView
to be your start page.

3. Click Customize your Start Page.

nts View Documents  Universe Password

Default Start Page

Select the page you want displayed whenever you
open Infoiew.

& Welcome page

' Corporate Documents page
' Personal Documents page
' Inbox Documents page

' My Infoview customize your Start Page

L Click here

The My InfoView Layout page appears.

» My Infoview Layout

Choose the layout of your My Infoview statup page
‘= TH ‘Hl ‘=

Back to Options | Next)l

4. Select the number of panes you want to display.

5. Click Next.
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The Block 1 options appear. This is where to set what you want to appear in
the first pane.

» My Infoview Contents
Block 1 Block Type : |Inbox List A

T Edit Sort by : |Name Ascending 'I
i

List Format: & Cornpact with details
© Campact with name only
© Expanded

I Refresh before showing

Cancel | Apply All Changes | Mext > |

6. Select the options you want to apply.

For descriptions of Block Types and options, see “Block Type Options” on
page 52.

7. Click Next to proceed to the next pane, or click one of the Edit links to edit
another pane.

» My Infoview Contents
Block 1 Block Type : |¥eh Fage vl

Edit

— | Edit URL Location : |hitp:;/iwwyahoo.com
a. ——Edit I £ Y

Cancel | Apply All Changes | Mext » I b.

a. Click here to edit a particular pane.
b. Click here to edit the next pane.

8. When you have configured each pane, select Apply All Changes.

Block Type Options
When you are configuring My InfoView, you can choose from among the
following options:

* Inbox List - displays the documents you have received from other users in
your Inbox

e Corporate List - displays the documents in the Corporate Documents

e Corporate Document - displays a particular document from the Corporate
Documents list

* Personal List - displays the documents you have saved to your Personal
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Documents list

e Personal Document - displays a particular document from your Personal

Documents list
* Web Page - displays a web page
Each of these block types has different options you can set:

Inbox List
The Inbox List block type allows you to display the Inbox Documents list in a
pane:
» My Infoview Contents
Block 1 Block Type : |Inbox List vl
Edit
T Edit Sort by : |Mame Ascending 'I
Edit
List Format: & Compact with details
€ Compact with name only
© Expanded
[T Refresh before showing
Cancel | Apply All Changes | et » |

e Sort by - choose the order the documents appear in the list

e List Format - choose how the documents are displayed

* Refresh before showing - refreshes the document list each time you view My

InfoView

Corporate List

The Corporate list block type allows you to display the Corporate Documents list

in a pane:

» My Infoview Contents
Block 1 Block Type : | Corporate List -

Edit —— Category : |All categaries 'I
Sort by : |[Name Ascending x

List Format : & Camnpact with details
© Compact with name only
© Expanded

T Refresh before showing

Cancel | Apply All Changes | Mext > |

* Sort by - choose the order the documents appear in the list
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* Category - choose the corporate category you want to display

e List Format - choose how the documents are displayed

* Refresh before showing - refreshes the document list each time you view My

InfoView

Corporate Document

The Corporate Document block type allows you to display a document from the

Corporate Documents list in a pane.

» My Infoview Contents
Block 1 Block Type : | Corporate Document >

Edit
Edit

Edit T Document Name : | j

[T Refresh before showing

Cancel | Apply All Changes | hext > |

* Document Name - enter the name of the document you want to display

* Refresh before showing - refresh the document each time it is displayed

Personal List

The Personal List block type allows you to display the Personal Documents list in

a pane:

» My Infoview Contents
Block 1 Block Type : |Persanal List -

Edit
Edit

Edit T Category : |All categaries *
Sort by : [Name Ascending =

List Format: & Carnpact with details
© Compact with name only
© Expanded

Cancel | Apply All Changes | hext > |

* Sort by - choose the order the documents appear in the list
* Category - choose the corporate category you want to display

e List Format - choose how the documents are displayed

* Refresh before showing - refreshes the document list each time you view My

InfoView
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Personal Document

The Personal Document block type allows you to display a document from the
Personal Documents list in a pane.

» My Infoview Contents
Block 1 Block Type : |Personal Document | ¥

Edit
Edit

Edit T Document Name : [JRaEIREE R EER

[ Refresh before shawing

Cancel | Apply All Changes | MNext > |

* Document Name - enter the name of the document you want to display

* Refresh before showing - refreshes the document each time it is displayed

Web Page

The Web Page block type allows you to display any web page. Simply enter the
URL in the URL Location text box.

» My Infoview Contents
Block 1 Block Type :IWeb Fage A

Edit
Edit ——  URL Location :I
Edit

Cancel Apply All Changes | hext >

Note: For detailed descriptions of each List Format, see “Compact or expanded
document list display” on page 41.

Changing the document list display

The Corporate, Personal, and Inbox Documents page document lists can be
displayed in Compact or Expanded form. The biggest difference is that Compact
mode lets you see more document names at a glance, but the Expanded version
includes documents’ descriptions if they have them, as well as links that let you
perform actions on documents directly from the list.

By default, the Personal Documents list is refreshed automatically each time you
visit that page. For the Corporate and Inbox Documents pages, however, you can
decide when the document list is refreshed.
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You can also specify a document category to be used as default filtering criterion
in the Corporate and Personal Documents pages.

To determine document list display:
1. Click Options in the navigation bar.
The Options page is displayed.

2. Click the Document Lists link.
The Document List options page opens. By default all lists appear in Compact

format.
» Personal Options
Start Page Create and Edit Documents View Documents Universe  Password

Corporate Document list

List Format Default Categor Refresh the List

I Expanded All categories 'I Manually anly 'I
Personal Document list

List Format Default Personal Category

I Expanded All categaries =

Inbox Document list

List Farmat Refresh the List
¥ Expanded Once peruser session *
Reset This Forn | Apply All Changes |

3. Toview the Corporate, Personal or Inbox Documents list in Expanded format,
check Expanded under the corresponding list.

4. For the Corporate and Personal Documents pages, you can select a category
to serve as the default filtering criterion for each page. This means that when
you open each of these pages, only the documents in the specified category
will be displayed in the document list.

By default, All categories, or the category set by the supervisor for your user
profile, is selected.

5. For the Corporate and Inbox Documents page, select a refresh option.

6. When you are finished, click Apply All Changes.

Selecting the type of documents you want to create

Depending on your user rights, you may have the option to create and edit
documents in WEBINTELLIGENCE or BUSINESSOBJECTS. If you choose to create
documents in WEBINTELLIGENCE you can choose from several Web Panels.
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To create Weblintelligence documents
1. Click Options in the Navigation bar.

The Options page opens.
2. Click the Create and Edit Documents link.

Start Page  Document Lists Create and Edit Documents View Documents  Universe Password

Choose what type of document you want to create. For Weblntelligence, you can choose from several web panels.
@ VWeblntelligence

' BuginessObjects (Windows NT 4.0, or later versions)

Choose the type of YWeb Panel you want to use to create and edit Weblinteligence documents. For descriptions of each Web
Panel option, refer to the Yeblntelligence Online User's Help.

O Full Java applet

C Light Java applet

© ActiveX cantrol

@ Optimized for my browser

Feset This Form | Apply All Changes |

3. Select Weblntelligence from the options for the type of document you want to
create.

4. Select the Web Panel you want to use to create WeblIntelligence documents.
e Full Java applet

e Light Java applet
* ActiveX control
* Optimized for browser

5. When you are done, click the Apply All Changes button.

Note: For information about creating and editing WeblIntelligence documents, or

a complete description of Web Panel options, refer to the Weblntelligence User’s
Guide or WEBINTELLIGENCE On-line Help.
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To create BusinessObjects documents
1. Click Options in the Navigation bar.
The Options page is displayed.

2. Click the Create and Edit Documents link.
Start Page  Document Lists Create and Edit Documents View Documents  Universe  Password

Choose what type of document you want to create. For Weblntelligence, you can choose from several web panels.
& \Weblntelligence

' BusinessOhjects (Windows NT 4.0, or later versions)

Choose the type of Web Panel you want to use to create and edit Weblntelligence documents. For descriptions of each YWeb
Fanel option, refer to the Weblntelligence Online User's Help.

€ Full Java applet

€ Light Java applet

€ ActiveX control

& Optimized far my browser

Reset This Form | Apply All Changes |

3. Select BusinessObjects from the options for the type of document you want to
create.

4. When you are done, click the Apply All Changes button.

Note: The first time you view a document with BUSINESSOBJECTS, you must follow
a short installation procedure. For instructions on installing BUSINESSOBJECTS,
refer to “Viewing BusinessObjects documents in InfoView” on page 74. For
information about creating and editing documents in BUSINESSOBJECTS, refer to
the BusinessObjects User’s Guide.

Selecting how you want to view BusinessObjects documents

You can specify whether you want to view BUSINESSOBJECTS documents with
WEBINTELLIGENCE or with BUSINESSOBJECTS. If you do not have the right to view
BUSINESSOBJECTS documents in BUSINESSOBJECTS, the option is greyed.

If you choose to view BUSINESSOBJECTS documents with WEBINTELLIGENCE, you
may choose how the document appears in your browser by selecting one of the
following viewing formats.

e Standard HTML format
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* Lets you view BUSINESSOBJECTS documents exactly as they appear in the
BUSINESSOBJECTS product. For example, you can navigate through the
document by sections and zoom into the document.

e Unlike HTML format, allows WYSIWYG (What You See Is What You Get)
printing.
e PDF Acrobat Reader

Allows you to view documents using Adobe Acrobat Reader. You must have
Adobe Acrobat Reader installed on your machine to view files in this format.

¢ Optimized for my browser
This selection uses the viewing format best suited for your browser. Enhanced
document format for Internet Explorer and Standard HTML for Netscape.

Note: If you choose to view documents in Enhanced document format with a
Netscape browser, you must install a plugin. If you do not have the plugin, you
will be prompted to install it the first time you attempt to open a document.

For more detailed information about the different viewing options, see “Viewing
Documents” on page 73.

To select a format for viewing BusinessObjects documents:

1. Click Options in the navigation bar.
The Options page is displayed.
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2. Click the View Documents link.

» Personal Options

Start Page Document Lists Create and Edit Documents VTN Universe  Password

BusinessObjects documents can be viewed with BusinessObjects or in a browser with Info'view.
For descriptions of Infoliew options, see the Infoview Online User's Help.

Note: This option is for BusinessObjects documents only (1)
Weblntelligence documents abways appear in HTML (ﬁ]

View BusinessObjects documents ﬁ) with:

@ Infatview
Select one of the following format options:
€ Standard HTHL format
€ Enhanced document farmat
C PDF Acrobat Reader
@ Qptirnized for my browser
€ BusinessOhjects (Windows NT 4.0, ar later versions)

Reset This Form | Apply All Changes |

3. Select how you want to view BUSINESSOBJECTS documents:
* InfoView

* BusinessObjects

4. If you choose to view BUSINESSOBJECTS documents with INFOVIEW, you may

select on the following viewing formats:

Standard HTML format
Enhanced document format
PDF Acrobat Reader
Optimized for browser

5. When you are done, click Apply All Changes.

Note: If you select to view BUSINESSOBJECTS documents in BUSINESSOBJECTS, you
must initially follow a short installation procedure. For instructions on installing
BUSINESSOBJECTS through the InfoView portal, refer to “Viewing BusinessObjects

documents in BusinessObjects” on page 80.
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Changing your password

Your initial INFOVIEW password is created by the BUSINESSOBJECTS supervisor
who defined your user profile. Once you have logged into INFOVIEW for the first
time, however, you can change your password to one of your choice if you have
the user right to do so.

When you change your password, it changes for BUSINESSOBJECTS as well.

To change your password:
1. Click Options in the navigation bar.
The Options page opens.

2. Click the Password link.
The Password page appears.

» Change Password

Start Page Document Lists Create Documents Wiew Documents Universe

Old Password I
Mew Password I
Confirm Mew Password I

Change Passwaord

3. In the Change Password section:
e Type your current password in the Old Password box.
e Type your new password in the New Password box. This is case-sensitive.
e Confirm the new password by typing it again in the Confirm New
Password box.

4. Click the Change Password button.

The next time you log in to INFOVIEW, you will need to use the new password.

Switching to a different language

INFOVIEW is available in different languages. The languages that you can work
with depend on the licenses your company or organization purchased. The
Deployment Guide provides a list of supported languages.

Only WEBINTELLIGENCE administrators can change the language that you work in
with INFOVIEW. The WeblIntelligence System Administrator’s Guide provides
information on how to do this.
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Using a different language for enhanced document format

If you have been viewing BUSINESSOBJECTS documents in enhanced document
format, you will have downloaded the document viewer from INFOVIEW to your
desktop. So, even if your administrator has switched INFOVIEW to a different
language, the language of the document viewer will remain, because it resides on
your desktop, not on the server.

The only way to change the language of the viewer is to:
* Have your administrator switch to a different language on the server side
* Delete the file corresponding to the viewer that you are currently using

* View a document in the new language; doing so automatically downloads the
viewer in the new language to your desktop from the server.

Here’s the step-by-step procedure:
1. Have your administrator switch to a different language on the server side.
2. Open Windows Explorer, or equivalent on other operating systems.

3. Delete the appropriate file depending on the browser you use:

Using... Search for then delete...
Internet Explorer RptViewerAX.dll
Netscape NPaxvnet.dll

4. Log in to INFOVIEW, which has been changed by your administrator.
5. In INFOVIEW, open a BUSINESSOBJECTS document.

Troubleshooting: what to do if you can’t find RptViewerAX.dll

Internet Explorer users should delete the file named RptViewerAX.dIL If you
can’t find this file on your system, use your operating system to search for
RptViewerAX Class.

When you locate RptViewerAX Class, delete it. If you are using Windows:
1. Search for the file, RptViewerAX Class, using Windows Explorer.
2. Right click RptViewerAX Class.

3. Select Delete from the pop-up menu that appears.
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Getting Help

INFOVIEW provides you with two kinds of on-line help:
e The Interface Reference
* The On-line User Help

The Interface Reference

The Interface Reference is your guide to every page and dialog box in the
INFOVIEW interface. As you use INFOVIEW, you can obtain contextual help for the
interface element you are currently using simply by clicking Help in the
navigation bar.

A new browser window opens, with a modified navigation bar and toolbar, and
a description of the interface element you are using in the contents area of the

page.
lﬁ(ﬁwTVi(E(W Interface Reference On-Line User's Help
Available = st
UI‘I‘I"V;]’SES O O
BCA
Console
e | Corporate Documents Page
Management
Documents)
Delets This page containg a list of all the docurments In the corporate repository that you
b . have the right to view, Corporate documents are documents that have been
Proserties published and made accessible to groups of users within your corporation or
perties X :
organization. See .
Document
Results To view any document in the list, just click its name.
Help
Inbox When this document list is in mode, the last line in the docurment's =
Documents entry contains links which permit you to do the following without even opening the
Logout document
Options « If the document was created using WebTIntelligence, the document's
o Pe’“";' data into a spreadsheet such as Microsoft Excel
ocument « If the document was created using BusinessObjects, the document
Publish as a .rep file
299. - the document for your own uge e g personal docurment, =

You will also find hypertext links to relevant sections in the On-line User Help.
From this page, you can:

* Jump to other topics in the Interface Reference by clicking their names in the
navigation bar
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* Access the on-line user documentation by clicking On-line User’s Help in the

toolbar

When the User’s Help is open, the navigation bar changes to display links to

its major topics.

To return to INFOVIEW, either close the browser containing the Help window, or

give the focus to the browser window running INFOVIEW.

The On-line User Help

The INFOVIEW On-line User Help provides you with a detailed description of
both INFOVIEW and the concepts behind it, as well as complete instructions for
using the product, every step of the way. You can also open a PDF version of the

InfoView User’s Guide as well as other related documentation.

To access the INFOVIEW On-line User’s Help:

1. Do one of the following:

e From the InfoView login page, click the User Help link (either the text or

the Help! image).

e From the Welcome page, click the User Help link (either the text or the

Help! image).

e From the Interface Reference, click On-line User’s Help in the toolbar.

The InfoView /Weblntelligence On-line User’s Help page is displayed.

More Tips
and Samples

Error Messages

|3
Weblntelligence
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lﬁi?wvréw Interface Reference On-Line User's Help

Ge

InfoView/WeblIntelligence On-line User's
Help

welcome to the On-line User's Help!

It describes the various concepts, tasks, and procedures required to
use the Infoview/WebIntelligence system. It includes an overview of
what the systerm does, a complete description of its principal
components, and procedures for obtaining the documents you neead,
easily and reliably.

The describes how to access the
document lists that constitute your corporate information capital, and
how to manage and distribute documents.
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Click either the InfoView link in the navigation bar to the left, or the InfoView On-
line User’s Help link in the page contents. The InfoView On-line User’s Help
overview opens.

lﬁiEwTViEW Interface Reference On-Line User's Help

o ) i

InfoView On-line User's Help

Introduction

Getting Up
and Running
Welcome to the Infoview On-line User's Halp!

Managing
Documents ' N
It describes how to access the document lists that form your personal

Publishing, gateway to your corporate data storage. It also tells you how to:
Sending and

Schedul . .

Doctment « Manage the documents in those lists
« Save documents for your own personal use

Trouble- « Distribute documents by sending them to other users or

shooting publishing them to the corporate repository
Quick Tour « Automate the distribution of documents by scheduling them with

Broadcast Agent

Index

7 5 Each major section of this On-line Help is displayed in the navigation

This page provides overall information about the on-line documentation. You
can also access a particular topic by clicking its name, under InfoView in the
navigation bar to the left.

Tip: You can expand or collapse the INFOVIEW Help links in the navigation bar
simply by clicking the underlined InfoView link again.

Notice that the navigation bar also contains links to the WEBINTELLIGENCE Help.
To expand this section of the navigation bar and display an overview of the
WEBINTELLIGENCE On-line User’s Help, click the underlined WeblIntelligence
link.
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The Multimedia Quick Tour

This multimedia presentation gives you a step-by-step tour of the basic functions
of INFOVIEW to help you get started. To access it, click the Quick Tour link on the
navigation bar. The Quick Tour appears in a separate browser window:

WEBINTEL IGENC) .
lNF' VIEW Interface Reference On-Line User's Help
=

Menu

Weblntelligence InfoView QuickTo

Error Messages| Webintelligence InfoView is the gateway to your Corporate MNarrow down the
information. You can access all of the documents in your document list so you can
corporate data storage using your corporate intranet, extranet, find the document you are
or the world wide web. looking for more easily.

Introduction Accessing Information About Your Business

Getting Up

and Running nding the Information You Need

Managing ow Has Your Product Line Performed
Documents

Publishing,
Sending and
Scheduling
Documents

Trouble-
shooting

Quick To

To return to INFOVIEW, either close the browser containing the Help window, or
give the focus to the browser window running InfoView.
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Logging Out Of InfoView

When you are done using INFOVIEW, log out of the product instead of just closing
your browser. This helps INFOVIEW system administrators keep track of which
users are logged into the system and active at any given time. This allows them
to configure the system to handle transaction loads most efficiently.

Logging out is easy. If you're inactive longer than the maximum time period
defined by your administrator, INFOVIEW logs you out automatically. You can
also actively log out at any time.

To log out of INFOVIEW:
1. Click Logout in the Welcome Page, or click the Logout button on the
navigation bar.

The Logout page opens.

Do you really want to log out? es | Mo |
2. Click Yes.
If you decide you don’t want to log out after all, do any of the following:
e Click No.

* Return to the previous HTML page you viewed by clicking the browser’s Back
or Previous button.

* Go to any other part of INFOVIEW by clicking a link in the navigation bar.
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Searching for Documents

INFOVIEW manages a large number of documents. To make it easy to find the
document you need, you can search for documents based on the document’s
name, author name, keywords, and date of last modification using the Search
page. You can even combine one, two, or all of these search criteria—document
name, author name, and date modified—to search through a narrower array of
documents.

The only thing you cannot combine is storage areas. That is, you cannot search
through the corporate documents in the repository and your personal documents
stored on the INFOVIEW server at the same time.

Note: If you remember at least part of the document’s name, as well as the
document list it belongs to, it’s probably quicker to do a Quick Search. See
page 43.

To search for one or more documents:

1. Click Search in the navigation bar.

The search page is displayed.

» Search for document(s)

Search in: & Corporate Documents page

' Personal Documents page
' Inbax Documents page

Doc t name contai |

Author name contains:l

Keywords: |

Date between: [MM | /[DD | /[""vv  and [MM | /[DD | ffvey

Order by: & Document name
' Author name
' Document size
' Dacument type

Search |

2. Select which area you want to search: Corporate Documents, Personal
Documents, or Inbox Documents.
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8.

If you want to search by document name, enter some part or all of the name
you want to search for in the Document name contains box.

You don’t have to enter the entire document name. For example, if you want
to search for a document entitled “Revenue by quarter and sales district,” just
enter the word “Revenue.” If you use too common a word, the search may
take a long time, or return too many document names to be useful.

If you want to search by document author, enter some or all of the name you
want to search for in the Author name contains box.

You can launch a search either by entering the author’s entire name, or a
partial name. Again, avoid using common names to prevent time-consuming
searches and long document lists.

If you want to search by keyword, you can enter keywords that may be
associated with the document that you are looking for. Note: The search by
keyword is a character search. It returns all documents related to the letters
you entered.

You can also specify a range of dates within which the document was last
modified by entering the starting and ending dates in the boxes (Month/Day/
Year). Only documents that were last modified on or between those two dates
are returned as a result of the search.

Note that the creation, first publication, or first saved dates are not taken into
account in this search. The only date that is matched is the date the document
was last saved to the selected storage area.

In the Order by area, select the criterion you want to use for sorting the search
results.

Click the Search button to begin the search.

Once the search engine returns a list of matching documents, you can view any
of them by clicking the document’s name in the list.

Note: You can also search for documents by extension, for example, .doc or .txt.
This type of search is only available for non-BUSINESSOBJECTS documents.
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Viewing Documents

To view an existing WEBINTELLIGENCE or BUSINESSOBJECTS document, or any
document uploaded from another source, just click its name in any INFOVIEW
document list.

The document appears in the Document Results page in your browser.

Download Drill Edit Save Send <

Germany

$35,900

If the document you want to open was created in WEBINTELLIGENCE or
BUSINESSOBJECTS, it may contain a user prompt, however, a dialog box appears
instead, prompting you for information. Refer to “Viewing or Refreshing
Documents with Prompts” on page 90 for more detailed information.

The document above is an example of a WEBINTELLIGENCE document. All
WEBINTELLIGENCE documents are in HTML format.

You can choose to view BUSINESSOBJECTS documents, however, in either
BUSINESSOBJECTS or WEBINTELLIGENCE, depending on your user rights.
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Note: When you view a BUSINESSOBJECTS document in WEBINTELLIGENCE, you
can choose to view it in standard HTML format, or in enhanced document
format. All of the viewing formats are compatible with the new Euro currency
format, but to be able to use this feature, you must be using a recent version of
windows or an older version equipped with the appropriate patch.

If you encounter problems viewing or editing reports that contain Object Linking
and Embedding (OLE 2) objects. This may be because the report has been shared
via Enterprise Server products installed on UNIX or your current session has
been opened from Enterprise Server products installed on UNIX. You should
contact your WEBINTELLIGENCE or BROADCAST AGENT administrator.

To insert a logo or other image in a report and share the report via Enterprise
Server products installed on UNIX, you should save the image as a bitmap
(.bmp). You can do this in Microsoft Paint or a similar application.

Viewing BusinessObjects documents in InfoView

You can view BUSINESSOBJECTS documents either as standard HTML documents,
in Acrobat PDF format, or in a special enhanced document format. You indicate
which format you want to use in the Options page (see “Selecting how you want
to view BusinessObjects documents” on page 58).

There is a substantial difference in how the same document looks -- and prints --
depending on the option you choose:

e “Viewing BusinessObjects documents in HTML format” on page 75
¢ “Viewing BusinessObjects documents in enhanced format” on page 76
* “Viewing BusinessObjects documents in PDF Acrobat Reader” on page 78

Once the document is open in the Document Results page, you can perform a
slightly different set of actions on the document than on a WEBINTELLIGENCE
document. See page 79.

Note: If a BUSINESSOBJECTS document has a macro attached which makes calls to
external files or applications, you must have these installed on your machine.
Likewise, if you have installed a BUSINESSOBJECTS add-in, you must have any files
which the add-in calls installed. If external files such as these are not installed
locally, then you may not be able to refresh certain documents. For more
information on working with macros and add-ins, see the BusinessObjects SDK
Reference Guide
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Viewing Documents

When you open a BUSINESSOBJECTS document in standard HTML format, the
BUSINESSOBJECTS tabs are converted into hyperlink text, which appear at the
bottom of the screen. You can click to view individual reports within the file.

| 1999|

January F1,003 541 F1,200,000

February FE30,073

March F1,027 085 F1.0m.000

April Fas5 260 Fe00,000

hay FaEs5 615

June Fa17 818 F&O0,000
Huly F525 904

August F173 756 F400.000

September FEES, 181

October FB55,206 Fa00.000

Movember Faa4 024 Fo Sales  revenus
December FE49 350 & 88 813 838 28 8 38 8 8

| 2000]

Revenue per Month Revenue per Month {1) Report1 Report1 (1)

You can view documents easily and rapidly in HTML format, however, HTML
has various printing restrictions -- which means that when you print the
document, you may find certain document elements missing from the printout.

Note: With WEBINTELLIGENCE and INFOVIEW you cannot launch the same session
in multiple browser windows. To open several windows simutaneously run a
second browser and re-login.

InfoView User’s Guide 75



Chapter 3 Managing Documents

Viewing BusinessObjects documents in enhanced format

When you open a document in enhanced format, it looks as if it has been opened
in BUSINESSOBJECTS:

T EEE e (DS 0« E» ]
-4y FB0 =
Y8 Fevenue by Region
A (-4, Yearly Variance
Selected report || Dty Yariarce

-8y Color Sold

sl 2 LA B

1 »

You see the same formatting as in BUSINESSOBJECTS, including page headers and
footers which you don’t see in HTML documents. And you can take advantage
of BUSINESSOBJECTS navigation and zooming features.

Fonts that are unavailable with HTML are perfectly rendered in this format.

Enhanced format also brings you WYSIWYG (What You See Is What You Get)
printing.
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When you view documents in enhanced format, the viewer toolbar provides
additional features for viewing, browsing and printing documents:

EEE@mElea D&l «&»m

b ¢ d e f g h i j k | m

a. Show/Hide Sections Tree

Lets you show or hide the navigation window on the left of the document.
This window lets you jump from section to section on the document.
b. Normal Size

Displays the document in the display window.

c. Fitto Window

Makes the document fit the display window

d. Fit Width to Window

Widens the document to the width of the window.

e. Panning

Lets you push the document up or down using a hand-shaped cursor.
f.Zooming

Lets you zoom in or out by clicking the document.

g. Page Setup

Lets you select margin size, paper size and document orientation.
h. Print

Lets you set print options and prints the document.

i.Beginning

Sends you to the first page of the document.

j. Previous

Displays the previous page of the document.

k. Go to Page

Lets you select the page you want to navigate.

I. Next

Displays the next page of the document.

m. End

Displays the last page of the document.

Viewing enhanced format documents using Netscape

To view BUSINESSOBJECTS documents in enhanced format with a Netscape
browser, you need to define BUSINESSOBJECTS as an external helper application.
To do this:

1. Choose Options / General Preferences in Netscape Editor.

2. Define BusinessObjects as a helper application in the Helpers tab.
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Selected report

Viewing BusinessObjects documents in PDF Acrobat Reader

You must have Adobe Acrobat Reader installed on your machine in order to view
PDF documents in the INFOVIEW window.

When you open a BUSINESSOBJECTS document in PDF Acrobat Reader format,
Adobe Acrobat Reader automatically launches and appears in the page contents
area of your INFOVIEW window.

Acrobat toolbar

|ﬁi§‘37v|"éw Download Refresh Save Publish Send
weicome IINERZIREIE D R IR N s R
3

| Bookmarks

[ Revenue Year 20074

[ v]=

Corporate
Documents

Personal Revenue for Year 2001
Documents

= Inbox
Documents

Quantity sold  Sales revenue
New York 19,109] §23,151,022]

Houstan 13.342] §2,246,194(
Scheduled Los Angeles 9.860) §1,656 676
Documents San Franclaco 7.000) §1,336,003
Austin 6.818| $1,135.474|

Create Chicago 8,518 $1,134,085|
Documents 6.451 §$1.053.581

Boston 5.268) S8BT, 16|
(Coloraco Spring: 5,116| $843,584]
il 4,830 $811,824

Search

Dallas 4,833 $803,421)
Sum §15,059,143)

‘Options
Logout

Help

3L

EEE R 8.27 x 11.69in

Report titles

To view another report, click on the report titles that appear below the document
as hyperlinks. If the BUSINESSOBJECTS report contains multiple sections, they will
appear below the report title in the Bookmarks pane.You can also print the PDF
document without having to worry about whether or not you have the correct
fonts installed on your machine.

When you view documents that contain OLE 2 objects in PDF format, you may
encounter problems displaying the OLE 2 objects.

To insert a logo or other image in a report and save the report as a PDF document,
you should save the image as a bitmap (.bmp). You can do this in Microsoft Paint
or a similar application.
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What you can do with BusinessObjects documents in InfoView

The following tables describe what you can and cannot do with BUSINESSOBJECTS
documents using INFOVIEW:

Action You can You
cannot

Refresh the document with the latest data

Publish the document to the Corporate Documents
repository where others can access it

Download the document to a BUSINESSOBJECTS.rep U
file

Save the document as a personal document

Send the document to another user

Delete the document

View the document’s attributes

Ol ol g OO

Print the document

Load the document’s data into a spreadsheet

Turn the block of data into a chart or a different table

Note: If your user rights allow you to view BUSINESSOBJECTS and
WEBINTELLIGENCE documents in BUSINESSOBJECTS, the BusinessObjects option
appears in the View Documents tab in your personal options page. For complete
descriptions of these options, refer to “Selecting how you want to view
BusinessObjects documents” on page 58.
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Viewing BusinessObjects documents in BusinessObjects

80

If your user rights allow it, you may also view BUSINESSOBJECTS documents in
BUSINESSOBJECTS. You indicate how you view BUSINESSOBJECTS on the View
Documents tab of the Options page. For instructions on setting this option, see
“Selecting how you want to view BusinessObjects documents” on page 58.

The first time you choose to view a document using BUSINESSOBJECTS, you will be
prompted to install BUSINESSOBJECTS. Once it is installed, BUSINESSOBJECTS
automatically launches each time you open a BUSINESSOBJECTS document. If you
already have version 5.1 of BUSINESSOBJECTS installed from the CD on your
machine, the document will open in that version, and the installer will not
appear.

If the version of BUSINESSOBJECTS is updated on the server, you will be prompted
to update your version of BUSINESSOBJECTS via the INFOVIEW portal.

To install and view a document in BUSINESSOBJECTS:

Note: To install through the portal, you must be logged in to your Windows 2000
machine as a local administrator.

1. Click a BUSINESSOBJECTS document in any INFOVIEW document list to open it.

If you do not already have BUSINESSOBJECTS installed, the BusinessObjects 5i
installation wizard appears.

Welcome to the
BusinessObjects 5i Installation
Wizard

BUSINESS OBJECTS® This wizard installs BusinessObjects 5i on your computer.

BusinessObijects 5i is a powerful solution for all of your
query, reporting, and analysis needs.

To continue with Setup, click Next.

< Bank I Hewt> I Canoel
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2. Click Next to continue installing.

You are prompted to select a location for BusinessObjects 5i program files.

Installation Folder '_.‘
“ou can choose where to install BusinessDbjects 5i.

Choose an installation folder.

& lnstall to defauit folder;

BuginessObjects 5i will be installed to C:4\Program Files'Buzsiness Dbjects.

1 Install to folder:

Biowse...

To continue with Setup, click Next.

< Back I Next > I Cancel |

By default, the files are installed to C:\Program Files\ Business Objects.
3. If you want to install the files to another location, select Install to folder.

4. Enter a new path in the text box and click Next to continue.
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The BusinessObjects 5i setup window appears.

Note: If you select a drive that does not have enough disk space available to
download and install BUSINESSOBJECTS, one of the following error messages
appears:

If you have the ability to change the installation drive, you have the option to go
back in the installation wizard and choose another drive.

The message looks like this:

Digk Space Requirements
The Buziness0bjects Siinstallation wizard requires more free disk space

“here is not enough available disk space on your machine to install
BusinessObjects.

~ou need 49 MBE of available disk zpaca to proceed,

To s=lect another installation drive. click Back
| o exit Setup, click Lanzel.

ders | raneal |

If you cannot choose the installation drive, contact you system administrator.
The error message looks like this:

Disk Space Regquirements
The Business0bjects Siinstallation wizard requires more free disk space

& "here is not enough available disk space on your machine to install
BusinessObjects.

“ou need 49 MB of available disk spacs to proceed.

To et Setup, click Canzel

< Bk et s
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5. Click Next.

6MB of compressed files are downloaded to your computer.

BusinessObjects 51 Setup
The BusinessDbjects 5i installation wizard needs to download and extiact the
setup files

Setup will naw perform the following tasks;
* Download installation package
Extract installation files
Install BusinessObjects 5i on wour computer

Delete installation files

Cigad | tews | conedl |

Once the files are downloaded, they are uncompressed and installed. Once
installed, BUSINESSOBJECTS will take up about 20MB of disk space.

6. If you do not have the correct version of VBA (Visual Basic for Applications)
required to work with BUSINESSOBJECTS, you may be prompted to install it. To
install the compatible version, check the box Download and install VBA, and
click Next to continue installation

BusinessObjects 5i Installation Wizard

Microsoft® Visual Basic® for Applications Setup
WB& is required in order ta take advantage of BusinessDbjects 5i object madel

Check the box below if pou wish ta install VBA,

I~ Download and install VBA

To conlinue with ¥B& Setup, click Nest.

< Back I Mext > I Cancel
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7. Click Finish to end the installation procedure.
BUSINESSOBJECTS opens and displays the document.

Note: To view a BUSINESSOBJECTS document with macros or add-ins enabled, you
must view it in BUSINESSOBJECTS. If you open a BUSINESSOBJECTS document with
macros or add-ins in any other format the macros are disabled.

If you have version 5.1 or earlier of BUSINESSOBJECTS installed on your machine,
you will not be able to update to the latest version through the INFOVIEW portal.
To be able to install the updated version through INFOVIEW, you will first have to
uninstall the existing version on your machine. Then you can follow the
procedure "Viewing BusinessObjects documents in BusinessObjects".

If your user rights allow it, you may also be able to create and edit
BUSINESSOBJECTS documents with BUSINESSOBJECTS. You set this option in the
Create and Edit Documents tab of the Options page. For information about
creating and editing documents with BUSINESSOBJECTS, refer to the
BusinessObjects User’s Guide.
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Example

Viewing Documents

Your Documents lists may contain documents created in many applications other
than BUSINESSOBJECTS and WEBINTELLIGENCE. You can view, send, publish, and
download any of these documents if your user rights allow you to do so.

You must have the application that the document was originally created in
installed on your computer to be able to view it. For example, if you want to view
a Microsoft Word document in INFOVIEW, you must have Word installed.

Some examples of the types of documents you can view in INFOVIEW are:

Viewing Microsoft Word documents

When you open a Microsoft Word document in INFOVIEW, it appears in Word
format with the standard formatting toolbar.

WEBINTERAIGENC,
INF*Vi

Welcome

Eedashy|izace o e

Heading 1

~ Arial

Corporate EE '

Documents

Personal
Documents

= Inbox
Documents

Scheduled
Documents

Create
Documents

Al o o

Search
Options 11
Logout 13

Help 15

-14-”?1g
CRUELN I S

P T

lgaving Checklist:

Save file onto my computer as working copy.

Iake all final changes

Update book

Re-generate master TOC

Ee-generate and Update all local TOC

Frint to check changes

Frint i Postscript (refer to RTM checklist)

Drop on pg file PDF to Paper “in” folder

Print for last check

Bave as secure file. (Save as: replace file)

Drop on PDF to CD “in” folder

Iake changes to CD PDF file (refer to Steps: Optimize the PDF)

Bave as secure file. (Save as: replace file)

Baveto I, Create afolder in each; PDF to paper, and PDF to CD with product name as title
Compress the file in PDF to paper with WinZip.

Save final wersion onto K:»Doc. F# = user> en®, create a new folder “RTM Fersion#t”

Elo|al=] |

| 1v]

|_|«|0|»|<
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Example Viewing Microsoft Excel spreadsheets

When you open an Excel spreadsheet, the document appears in an Excel page in
the INFOVIEW window.

INF¥VIEW

" = Sales_revenue
My InfoView A ! B = 5 I E | E = =
Sales revenue!Quantity_snld Lines City Category kMaonth_MName =
Corporate | 15007 13/Accessories  Brussels Belts bagswallets  March —
Documents | 4681 19 Accessories  Brussels Hair accessories April
Personal 249 1 City Skirts Brussels Full length Februany
Documents 456.4 2 City Skirts Brussels Full length karch
| 2608 12 City Trousers  Brussels Bermudas December
# Inbox 22138 1| City Trausers  Brussels Bermudas January
Documents 1374 6 City Trousers  Brussels Long lounge pants  Fehruary
Scheduled : 705.4 3| City Trousers  Brussels Long lounge pants ~ March
Documents | 209108 161 Dresses Brussels Ewvening wear August
Create | 4418.5 31 Dresses Brussels Ewvening wear September
Documents | 2766.1 19 Dresses Brussels Sweater dresses QOctober
1261.8 8 Dresses Brussels Sweater dresses MNowember
b 447 3| Jackets Brussels Boatwear September
Search BI§ 249 1 Jackets Brussels Outdoor October
" 17731 8 Leather Brussels Shirts June
Options ; 1614 6 Owercoats Brussels DOy wear July
Logout | 0 0 Owercoats Brussels Dy wear August
| 1444 6| Shirtvaist Brussels 2 Pocket shins Agpril
Help | 212.2 1 Shint'waist  Brussels 2 Pocket shirts bty
177893 111 Shirt\Waist Brussels Long sleeve June
6699.4 44| ShirtWaist Brussels Long sleeve July
222837 116 Shirt Waist Brussels Short slesve August
2958.9 17 ShirtWaist Brussels Short sleswve September
41736.1 215 Sweat-T-Shirts Brussels T-Shirts Septermnber -

Note: The way the Excel document appears in your INFOVIEW window depends
on the browser you use.
If your user rights allow it you can edit the cell contents of the spreadsheet.
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Viewing Portable Document Format (PDF) files

When you view a PDF file in INFOVIEW, the standard Acrobat Viewer window
and toolbar allows you to navigate and zoom on the document.

WEBINTEWIGENCE
INE*VIEW

My tnfoview LA = REANN
[ Bookmarks
C n E+L ] Chapter 1 Infroduct =
orporate 7 . )
Documents [ wihatis Infovie
[ what Docurmen
Personal - .
Docaments [ Howsare docure Chapter | Introduction to InfoView
[ wihat Can You [
& Inbox DCuStom\Zing\m e
Documents D Going siraic
Scheduled {1 hoosing h
Documents i [ choosing a W Whatis InfoView? ..o 20
L[ Infoview and Bt

AT 4> M« s DOMAEBOE
)

L]

In this chapter

Create

4 What Documents Can You Access with InfoView? ............ 23
Documents

i How are documents created? . L R

d What Can You Do with InfoView? ..............c....o... 26
Search

Options

Logout

4 InfoView and Busi

Help sObjects Reader ... - ™

Other file types you may see in your document lists:
o Text files
* GIF and JPEG images

You must have the software that the document was created in installed on your
machine. If you do not have the necessary software installed, you will be

prompted to choose another application that is installed on you machine, or save
the file.

It is possible to upload any document to the repository, but it is not possible to
view all document types in your browser. Even if you cannot view the files, you
can still distribute them to other users, or save it to your hard disk. The following
are examples of files that you may find in your Documents lists, but cannot view
in the INFOVIEW window:

o ZIP files
e Executable files (for example, .bat, .com, .exe)

* Files with extensions that the operating system cannot recognize
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Example Opening a non-viewable .zip file in InfoView

If you select to open a .zip file from any document list, the File Download dialog
box is displayed.

File Download x|

“ou have chosen to download a file from this location

More_rubbish.zip from casa

What would you like to do with this file?

€ Dpen this fils from its current location
& Save this file to disk

¥ Always ask before opening this type of file

oK | Cancel I More Info |

You can choose to Run the file from its current location, which allows you to view
the contents of the file, or Save the file to disk, which allows you to save the file

to your computer.
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Refreshing Documents

A document generated some period of time ago accurately reflects the data as it
existed at that time, but may be inaccurate now. You can update
WEBINTELLIGENCE and BUSINESSOBJECTS documents, keeping the same
formatting but querying the database for the most recent data. This is known as
refreshing it.

Documents can be refreshed in two ways:
* Manually

* Automatically at specific times or intervals
This type of scheduled refresh in fact represents a way of distributing
documents using a powerful BUSINESSOBJECTS server product called
BROADCAST AGENT.

Refreshing a document manually

You can refresh any document manually as long as you have refresh rights to the
universe used to create the document.

To refresh a document manually:

1. Click the document’s name in any InfoView document list to open it in the
Document Results page.

2. Click Refresh in the toolbar.

INFOVIEW submits the document to the server for refreshing, then displays the
new results on the Document Results page.

If the document contains a user prompt, however, a dialog box appears instead,
prompting you for information. For complete information, see the following
section.
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Viewing or Refreshing Documents with Prompts

Some documents can contain conditions, which allow readers to limit the data in
a document. Instead of viewing a large document with a large quantity of
information, they can choose to view only the information they need.

The following illustrations show how a condition works.

MTASALAMN Couniry | Quarter | Reverue
condition to Country Country |Quarter| Revenue

by selectingoneof  |FRANCE |Q1 £208,565.00
its values: US.

FRANCE |Q2Z $242,165.00
FRANCE|Q3 $226,125.00
FRANCE |Q4 £158,565.00

U3 1 £582 051 .00
U3 2 £573,652.00
U3 3 $658,572.00
U3 4 $630,829.00

Only the data for - -
that value is now

displayed. us 1 £582,051 .00
us 2 579,652 .00
us 3 658,572 00
us 4 $630,829 00

A condition can also affect calculations. For example, the total number of guests
for all resorts changes when you restrict the data to a single resort instead of all
resorts.

Document designers can include condition prompts in documents, which means
that when you open or refresh the document, you are asked to provide
information that will restrict the data contained in the document. For example,
you are asked to enter the particular year for which you want financial
information. If you don’t provide this information, you cannot view the
document.
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The types of prompts you can encounter may vary slightly according to whether
the document was created using WEBINTELLIGENCE or BUSINESSOBJECTS, but in
general, you can be asked for information in two ways:

* A dialog box appears prompting you to select one or more values from a pre-
defined list:

Values Prompt
Flease fill the following prompt(s):

Country In List

Fefresh List |

Fun Query | Cancell

In this case:
* Refresh the list of values by clicking the Refresh List button.

The values in the prompt list may change, for example, if a resort is opened
in a country that wasn’t previously on the list. In this case you would want
to refresh the list of prompts to include the new country.

e Select a value from the list, then click OK.

The size of the list box adapts to the number of displayed values. A
maximum of 6 values can be displayed in the list box. If there are more than
6 values you must scroll down to view the full list of values.

The updated document opens in the Document Results page.

* An entry box appears prompting you to enter a value.

Flease fill the following prompt(s):

State Equal to |

Fun Query | Cancell

InfoView User’s Guide 91



Chapter 3 Managing Documents

92

Example

You must enter a value before you can run the query or refresh the document.

Note: If no data in the database corresponds to this value, you receive the message
“No data to fetch.” When you click OK, the entry box reappears. Enter a valid
value then click OK.

Document designers can also create documents that automatically display the
condition values that restrict the data in the document. Here’s an example, which
also explains how to get a different viewpoint on the information in the
document.

A document with condition values displayed

Your document designer set a condition on the Resort object and displayed the
prompt options in the document:

Prompt options
O STEIRGY Eahamas Beach Refresh List Run Query
Bahamas Beach
Accommodation |1 167.296.00
Arcommodation |2 177.272.00
Accommodation |33 175.472.00
Arcommodation | Q4 153,624.00
Food & Drnks |01 26,985.00
Food & Drnks |02 27770000
Food & Drnks |03 54.950.00
Food & Drnkes |04 60,045.00

The condition is set to Bahamas Beach. Therefore, the only resort information
displayed pertains to Bahamas Beach.
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If you want, you can get a different viewpoint on your data by selecting a
different value directly from the prompt options in the Document Results page.
But before you select to view a different resort, you will refresh the list of prompt
options. Some new resorts might have been added to the list since the document
was created, and when you refresh the list, the new data is retrieved from the
database. To do this:

1. Click the down arrow next to the current condition value, Bahamas Beach in
this case.

2. Click Refresh List to update the list of condition values.
3. Select a new value from the list.

4. Click Run Query to update the document with information pertaining to the
condition value you selected.

The updated document opens.
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Viewing Document Properties

Every document that you can view in INFOVIEW has certain properties, such as its
description, the categories it belongs to, its keywords, and, if it’s a corporate
document, its selected refresh option.

You can view any document’s properties in the Corporate or Personal
Documents pages by:

* Clicking the document’s icon

* Displaying the document list in Expanded mode, then clicking the Properties
link in the document’s entry.

INFOVIEW has two pages for document properties:

* The Document Properties (Read-only) page lets you view but not modify the
current document’s properties.

You see this page if you are neither a BUSINESSOBJECTS supervisor nor the
document’s owner (creator), and therefore do not have the right to modify the
document’s category or categories:

» Document Properties (Read-Only)

Name: eFashion Sales Eval
Description: Evaluation of sales over the last three years
Categories: marketing
Sales
Keywords: Eval, sales,

[ Backto Document List |
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* The read-write Document Properties page lets you view all the document’s
attributes and modify the categories to which it belongs:

Document Properties

Name: Sales Revenue by Store

Description: Displays the sales revenue per store across all years

Select Categories:

FlnanC|
Accounting
Fesults
Keywords: Sales
Data Providers:
Apply | | Biack to Docurment List |

This page opens if you are a supervisor or the document’s creator.
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Using Document Categories

Over time, the document lists in your Corporate and Personal Documents pages
can include so many documents that the lists are neither meaningful nor
manageable.

Documents can be assigned to categories, attributes you can use to filter the
documents into smaller subsets. By selecting a category from the Categories
drop-down list box at the top of the Corporate and Personal Documents pages to
filter the list to display only documents in the selected category.

For example, when you select Marketing in the Categories list box, only
documents that were assigned to the Marketing category when they were
published are listed. This makes the list of documents shorter and more
manageable.

Managing categories

INFOVIEW handles two kinds of categories:

* You can use repository categories to filter lists of corporate documents. To
create, update and delete these categories, you must have the rights to do so
from the BUSINESSOBJECTS supervisor.

Even if you have these rights, if you are not a supervisor yourself, you can
only update and delete categories that you have created.

* You can use personal categories to filter your list of personal documents. You
alone have the right to create, update, delete and use these categories.
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Managing corporate categories

If your user rights allow it, you can manage repository categories in the Category
Management page. You can access this page:

e From the Corporate Documents page

e From the Document Attributes page

* From the Publish page

In each of these pages, if you have the right to manage corporate repository
categories, the Categories title next to the list box is underlined, indicating a

hypertext link.
Click here — Categuaries: |4l categories 'I 45 available documents This
— @ Aoz ias Davanna m iamac

Click the link to display the Category Management page.

Category Management

Select from the list or enter a new one.

Name From Date

eFashion Eric Oct 02 18:00:12 1995
lsland Resorts Eric Oct 02 18:02:11 1995
Technology Eric Oct 25 14:34:20 1995

Category. |Island Resorts

Create | Delete | Update | Close |

It displays all existing repository categories, their owners (the users who created
them and therefore have update and delete rights for those categories), and the
date each category was last saved. You cannot delete or update a category
created by another user.

To create a category, type the category’s name in the Category entry box, then
click Create. The new category appears in the list above.

To update a category, select its name in the list. The name appears in the
Category entry box below. Make your modifications, then click Update. The
updated category name is inserted in the list.

To delete a category, select its name in the list. The name appears in the
Category entry box below. Click Delete. The category disappears from the list.

To close the Category Management page, click Close.
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Managing personal categories

98

You manage personal categories in the personal Category Management page.
You can access this page in any of the following manners:

e From the Personal Documents page
e From the Save page

In both these pages, the Personal Categories title next to the list box is underlined,
indicating a hypertext link.

Click here — Personal Categaries: |4l categaries 'I 4 available documents

B |Name a Date

= Blavral tact Fah 14 2000 1311

Click this link to open the personal Category Management page.

Category Management
Select from the list or enter a new one.

Invoices Oct 25 14:27:35 1995
Orders Oct 25 14:27:42 1995
Revenue Oct 25 14:27:15 1995
Sales Oct 25 14:27:24 1995
Category: |

Create | Delete Update Close

status: New category successiully created.

It displays all existing personal categories and the date each category was last
saved.

e To create a category, type the category’s name in the Category entry box, then
click Create. The new category appears in the list above.

* To update a category, select its name in the list. The name appears in the
Category entry box below. Make your modifications, then click Update. The
updated category name is inserted in the list.

* To delete a category, select its name in the list. The name appears in the
Category entry box below. Click Delete. The category’s entry in the list
disappears.
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To close the personal Category Management page, click Close.

Assigning documents to categories

InfoView lets you assign:
* Corporate documents to repository categories

e Personal documents to personal categories

Assigning corporate documents to categories

If your BUSINESSOBJECTS supervisor has given you the right, you can assign
WEBINTELLIGENCE and BUSINESSOBJECTS documents to repository categories.

To assign a corporate document to a category, or to modify a corporate
document’s category, you must be the owner of the document or have supervisor
rights.

You can assign a corporate document to a category in two ways:
*  When you publish a new document.

* By modifying the document’s properties in the Document Properties page.
This way you don’t have to actually open the document, then publish it.

To do this, just click the document’s icon in the document list.
The Document Properties page is displayed:

Document Properties

Name: Sales Revenue by Store
Description: Displays the sales revenue per store across all years
Select Categories:

Financial

Accounting

Results
Keywords: Sales
Data Providers:

Apply | | Biack to Docurment List |

The categories the document belongs to are highlighted in the Categories list.

¢ To assign a document to, or remove a document from a category, click the
desired category in the list.

e Toassign a document to, or remove it from multiple categories, hold down
the Ctrl key while clicking each category.
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When you are done, click Apply.

To return to the document list, click the Back to Document List button.
Assigning personal documents to categories
You can assign a personal document to a personal category:
* When you save a document.

* By modifying the document’s attributes in the Document Properties (Apply
new categories) page.

To do this, just click the document’s icon in the Personal Documents page. The
Document Properties page is displayed.

Document Properties

Name: Sales Revenue by Store

Description: Displays the sales revenue per store across all years

Select Personal Categories: |_ Mo Cateioiisemded_

Keywords: Sales

Data Providers:

B | Name Source Date

Apply | | Biack to Docurment List |

The categories to which the document belongs are highlighted in the Personal
Categories list.

* To assign a document to, or remove a document from a category, click the
category in the list.

e To assign a document to, or remove a document from multiple categories,
hold down the Ctrl key while clicking each category.

When you are done, click Apply.
To return to the document list, click the Back to Document List button.

Filtering document lists by category

100

Once your personal and corporate documents have been assigned to categories,
you can use those categories to display pertinent subsets of documents in your
Personal and Corporate Documents pages.

For complete information, see “Filtering document lists” on page 43.
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Uploading Documents

You can upload any document other than BUSINESSOBJECTS or WEBINTELLIGENCE
documents from a location other than the corporate repository, such as your
personal hard disk. This allows you to upload, for example, a Microsoft Excel
spreadsheet, and publish it to the Corporate Documents list, save it to your
Personal Documents list, or send it to another user.

The action you perform on the document depends on which document list you
are viewing.

You must have the appropriate version of the application that the document was
created in installed on your computer to be able to view it inINFOVIEW. The
following table shows you some examples of document types you can upload
and view in INFOVIEW:

Icon Document Type

Portable Document Format (PDF)

Microsoft Word document

Microsoft Excel spreadsheet

Microsoft PowerPoint

mE® G

Unidentified file type

The upload feature also allows you to use InfoView as a method of distributing
files within your company. The following are examples of files that you can
distribute to other users through the repository:

o ZIP files
* Executable files (for example, .bat, .com, .exe)
* Files with extensions that the operating system cannot recognize

To view the contents of one of these file types, for example a .zip file, click the file
name and choose to Open this file from current location or Save this file to disk.

Note: You cannot upload agnostic documents that have no file extension.
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Upload a document and publish as corporate document

To upload a document and make it available to other users:

1. Click Corporate Documents in the navigation bar.

The Corporate Documents list is displayed.
2. Click Upload in the top bar.
The Upload and publish as corporate document window appears.

» Upload and publish as corporate document

Upload any file other than a Business Objects document, and publish it to the Corporate
Documents list in Info'view.

Enter the file to upload: I Brawse.

Agsign a document name to the file: I

Enter the document description: =]

Select Categories: - Mo Category Selected -
Tutorial Samples
Infocenter Tips
Developer Suite

Enter the docurment keyword(s) I

Select the document domain IDDDument -

Select the destination groups:

Overwrite if document exists Cyes O No
Refresh options MNone

Fublish | Back to Document List |

3. Click Browse to search for the document, or enter the file name with its path
in the Enter the file to upload text box.

4. Enter aname for the document in the Assign a document name to the file text box.

5. Inthe document description box, enter a description if you wish. Descriptions
are displayed in document lists when the document list is in Expanded mode.

6. If you wish, assign the document to one or more corporate categories by
highlighting your choice(s) in the Select categories list:
e To assign the document to a single category, click the category in the list
box.
e To assign the document to more than one category, hold down the Ctrl key
while clicking the desired categories in the list box.
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e If the document is already assigned to a category and you want to remove
it, just click the highlighted category. To remove the document from
multiple categories, hold down the Ctrl key while clicking the categories.

e If you want to assign the document to a category that isn’t in the category
list, click Categories to open the Category Management page. For
information about creating personal categories, see “Managing categories”
on page 96.

7. You can also enter one or more keywords to serve as search criteria for this
document.

8. Select the groups to which you want to make this document accessible.
Available groups are listed in the accompanying listbox.

9. If you want this document to overwrite any other document with the same
name, select yes for the option, Overwrite if document exists.

10. Click Publish.

A message confirms that the document has successfully been published.
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Upload a document and save as personal document

To upload a document and save it for your own personal use:

1. Click Personal Documents in the navigation bar.

The Personal Documents list is displayed.

2. Click Upload in the top bar.

The Upload and save as personal document window appears.

» Upload and save as personal document

Upload any file other than & Business Objects document, and save it to your Personal
Documents list in Info'iew.

Enter the file to upload I Browse...
Assign a document name to the I
file:
Enter the document description: =]
|

Select Personal Categories:

Enter the document keyword(s): I

Overwrite if document exists: © Yes & ho

Save | Back to Document List |

3. Click Browse to search for the document, or enter the file name with its path
in the Enter the file to upload text box.

4. Enter aname for the document in the Assign a document name to the file text box.

5. In the document description box, enter a description if you wish. Descriptions
are displayed in document lists when the document list is in Expanded mode.

6. If you wish, assign the document to one or more corporate categories by

highlighting your choice(s) in the Select categories list:

e To assign the document to a single category, click the category in the list
box.

e To assign the document to more than one category, hold down the Ctrl key
while clicking the desired categories in the list box.

e If the document is already assigned to a category and you want to remove
it, just click the highlighted category. To remove the document from
multiple categories, hold down the Ctrl key while clicking the categories.
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e If you want to assign the document to a category that isn’t in the category
list, click Personal Categories to open the Category Management page. For
information about creating personal categories, see “Managing categories”
on page 96.

7. You can also enter one or more keywords to serve as search criteria for this
document.

8. If you want this document to overwrite any other document with the same
name, select yes for the option, Overwrite if document exists.

9. Click Save.

A message confirms that the document has successfully been saved.

Upload a document and send it to other users

To upload a document and send it to specific users or groups:

1. Click Inbox Documents in the navigation bar.

The Inbox Documents list is displayed.
2. Click Upload in the top bar.

The Upload and send to users window appears.

» Upload and send to user(s)

Upload any file other than a Business Objects document, and send it to the user(s) of your
chaice

Enter the file to upload I Browse...
Assign a document name to the file: I
Enter the document description: =]

=l

Enter the document keyword(s): |

Select the repository: Diocurment vl

Select the destination users:

George Carlton ;I

Refresh options: Mone

Send | Back to Docurent List |

3. Click Browse to search for the document, or enter the file name with its path
in the Enter the file to upload text box.
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4. Enter aname for the document in the Assign a document name to the file text box.

5. In the document description box, enter a description if you wish. Descriptions
are displayed in document lists when the document list is in Expanded mode.

6. If you wish, enter one or more keywords to serve as search criteria for this
document.

7. Select the users to whom you want to send this document.

Available users are listed in the accompanying listbox.

8. Click Send.

A message confirms that the document has successfully been sent.
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Saving Documents

When you save a document, you save it to your Personal Documents storage
area. You are the only person who can access these documents. This allows you
to create your own personal documents, modify shared documents for your own
purposes, and create different versions of standard documents.

When you save a document, you can also:

Assign it to one or more existing categories and modify previous category
assignments.

If you want to create, update or delete your personal categories, you can do it
directly from the Save page.

Define keywords for it.

To save a document:

1.

Do one of the following:

e If the document is open in the Document Results page, click Save in the
toolbar.

e From a document list, display the list in Expanded mode, then click Save
in the document entry’s last line.

The Save page opens.

Save as personal document

Enter the document name: IpR_ggQ

Enter the document description: [proficability by Quarter 1999 =]

|

Select Personal Cateqories: accounting =]
marketing
revenue 4

sales

Enter the document keyword(s): I

Refresh options: " Refreshed manually

& Refreshed when apened

Overwrite if docurment exists: e F No

Sawve | Biack to Document List |

At any point before you actually save the document by clicking the Save
button on this page, you can return to where you were in INFOVIEW by
clicking the Back to Document or Back to Document List button.
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2. In the document name box, enter the document’s name.

3. Inthe document description box, enter a description if you wish. Descriptions
are displayed in document lists when the document list is in Expanded mode.

4. If you wish, assign the document to one or more personal categories by
highlighting your choice(s) in the Personal Categories list:

e To assign the document to a single category, click the category in the list
box.

e To assign the document to more than one category, hold down the Ctrl key
while clicking the desired categories in the list box. This creates a multiple
selection.

e If the document is already assigned to a category and you want to remove
it, just click the highlighted category. To remove the document from
multiple categories, hold down the Ctrl key while clicking the categories.

e If you want to assign the document to a category that isn’t in the category
list, click Personal Category to open the Category Management page. For
information about creating personal categories, see “Managing categories”
on page 96.

5. You can also, enter one or more keywords to serve as search criteria for this
document.

6. Select a refresh option:
* Refreshed manually, if you want the document to be refreshed only when
the reader requests.
* Refreshed when opened, if you want the document to be refreshed each
time it is opened.

7. If you want this version of the document to overwrite any pre-existing
versions currently in your personal storage area, select Yes for the option,
Owerwrite if document exists.

8. Click Save.

A flashing message confirms that InfoView has successfully saved the
document.
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Prinfing Documents

INFOVIEW makes it easy to print your WEBINTELLIGENCE or BUSINESSOBJECTS
documents, but the results you obtain vary depending on whether you are
printing a standard HTML document, or a BUSINESSOBJECTS document in
enhanced format.

Printing Weblntelligence or BusinessObjects HTML documents

Example

Printing WEBINTELLIGENCE documents, or BUSINESSOBJECTS documents in HTML
format, is very different from printing standard BUSINESSOBJECTS documents.
These documents are prepared as HTML pages to be displayed in a Web browser.
When you print a document, the headers, footers, width and the number of
printed pages per HTML page are all determined by the browser.

To print a document displayed in the standard HTML viewer, simply choose
File | Print in your browser.

You may be able to improve the appearance of printed HTML documents by
activating more printing options in your browser. Here is an example.

Improving the appearance of printed HTML documents

In Microsoft Internet Explorer 4.0 or later, choose Internet Options from the View
menu. Click the Advanced tab in the Internet Options dialog box. Scroll down
until you reach the Printing section. Check the Print background colors and
images option, then click OK.
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Printing BusinessObjects documents in enhanced format

& To print a BUSINESSOBJECTS document when using the enhanced viewer format,
click the Print button in the document viewer toolbar.

Note: The Page Setup button in the toolbar lets you set margin size, paper format,
and page orientation.

Printing BUSINESSOBJECTS documents has one restriction: you cannot print
BUSINESSOBJECTS documents on text-only printers.

Printing BusinessObjects documents in PDF format

@ To print a BUSINESSOBJECTS document when viewing it in PDF format, click the
Print button in the Adobe PDF viewer toolbar.
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Loading Document Data into a Spreadsheet

You can load the data from any WEBINTELLIGENCE document into a .csv
spreadsheet such as Microsoft Excel, simply by pressing a button. You can do this
from two different places:

e From the Corporate Documents, Personal Documents, and Inbox Documents
pages (in Expanded mode), click Load into spreadsheet in the last line in the
document entry.

* From an open WEBINTELLIGENCE document, click Download in the toolbar.

By default, INFOVIEW tries to load the data results into Excel. If Excel isn’t
installed, the browser prompts you to indicate an installed application associated
with files with the extension .csv.

If you have already done this, you are not prompted, and your browser loads the
document data into the application you specified.

INFOVIEW also allows you to specify another spreadsheet application for this
purpose.

Different results in different browsers

This feature differs according to the browser you are using;:

e If you are using Internet Explorer, the spreadsheet is shown directly in the
browser.

e If you are using a Netscape browser, an Excel session is opened and appears
next to the INFOVIEW session indicator in the taskbar. The spreadsheet
containing the data is opened in the Excel session.

The following example shows data from INFOVIEW loaded into a spreadsheet.
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Example How data from InfoView appears in a spreadsheet

A WEBINTELLIGENCE document’s data loaded into Microsoft Excel from a
Netscape browser, for example, looks like this:

™ Microsoft Excel =101 ]

File Edit W¥iew Insert Format Tools Data Window Help

DEHSRY | $BBT o @ = £ 4% @@ P 0w~
BIZIUES=H$%, %3
A1 & =| Country

@

Arial - 10 -

Country  Revenue |Service_Line Serice Resort
France 9000 Recreation Activities French Riviera
France 28440 Food & Drinks Fast Food French Riviera
France 32640 Food & Drinks Restaurant French Riviera
France 35720 Recreation Sports French Riviera
France 46320 Food & Drinks Poolside Bar French Riviera
France 116790 Accommodation  Hotel Room French Riviera
France 120050 Recreation Excursion French Riviera
France 126240 Accormmodation  Bungalow French Riviera
France 320220 Accommodation  Hotel Suite French Riviera
16080 Food & Drinks Fast Food Bahamas Beach
20000 Recreation Sports Bahamas Beach
30600 Recreation Sports Hawaiian Club
35200 Food & Drinks Poolside Bar Hawaiian Club
38080 Food & Drinks Poolside Bar Bahamas Beach
38350 Food & Drinks Fast Food Hawaiian Club
42500 Recreation Excursion Bahamas Beach
65600 Recreation Activities Bahamas Beach
89000 Recreation Excursion Hawaiian Club

101100 Recreation Activities Hawaii?n ICluh
[

Modifying your choice of spreadsheet application

By default INFOVIEW uses Microsoft Excel as the spreadsheet application when
you request the loading of document data into a spreadsheet. You can also define
another spreadsheet application by changing the browser’s MIME (Multipurpose
Internet Mail Extension) types.

The World Wide Web uses MIME types to define the type of a particular piece of
transferred information. A browser in turn determines, from the MIME type, how
the data should be treated. Each browser has a configuration (menu or file) that
maps the types of the data to particular functions.
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Loading Document Data into a Spreadsheet

A browser can handle many types of data itself (e.g. HTML documents, GIF
images) while other types are passed to auxiliary programs, such as image
viewers, movie or sound players -- or in this case, spreadsheet applications.

You can define the new spreadsheet setting either in your browser’s file type
configuration file, or if you are using a recent Microsoft browser, in the Windows
File Types settings.

Below are two examples. If you are using a different browser or browser version,
see its on-line help for instructions.

Choosing a spreadsheet application with Windows Internet Explorer 4.0

1. In Windows Explorer, on the View menu, click Options.
. Click the File Types tab.

. In the list of file types, click BUSINESSOBJECTS document.

. In Actions, click Open.

2
3
4. Click Edit.
5
6. Click Edit.
7

. In Application used to perform action, enter the spreadsheet program you want
to use to open BUSINESSOBJECTS document files, then click OK.

The settings for selected file types are shown in File type details.
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Example Choosing a spreadsheet application with Netscape version 4.*

1. Select Edit | Preferences.

The Preferences dialog box opens.

2. In the Category browser to the left, click Applications, located beneath
Navigator.

3. Inthe Description listbox, select Microsoft Excel Worksheet, then click the Edit
button. The Edit Type dialog box opens.

4. In the MIME Type field, type the mime type used by the desired application.
Ask your system administrator or the application manufacturer’s technical
support for the exact information to enter.

5. In the Application box, type or select the name and complete path of the
desired application.

6. Click OK.
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Downloading BusinessObjects Documents

When you view a BUSINESSOBJECTS document from INFOVIEW, you are either
working in WEBINTELLIGENCE with an HTML version of the original document,
or a version adapted for the ActiveX viewer (enhanced document format). If your
user rights allow it, you may also view the document in BUSINESSOBJECTS.

You can also download the original BUSINESSOBJECTS .rep file so that you can
work on it using BUSINESSOBJECTS on your local machine. The person who sent or
published the BUSINESSOBJECTS document used an option, to enable you, the
INFOVIEW user, to download the document from your Web browser. This option,
BusinessObjects Document, is described under “Setting HTML Options” on

page 225.

How you download documents is described below under "To download
documents". If the download options described do not appear in INFOVIEW,
contact the person who sent or published the document, and have them either
resend or republish the document with the BusinessObjects Document option
switched on in BUSINESSOBJECTS.
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Requirements for downloading documents

From INFOVIEW, you can download documents coming from different versions of
BUSINESSOBJECTS: versions 4.1 and 5.x.

* To download BUSINESSOBJECTS 4.1 documents, you must have
BUSINESSOBJECTS 4.1 or later installed on your computer. You can open
BUSINESSOBJECTS 4.1 documents in BUSINESSOBJECTS 4.1 or 5.x.

* To download version 5.x documents, you must have version 5.x installed on
your computer. You cannot download 5.x documents into
BUSINESSOBJECTS 4.1.

To download documents

You can download the document to BUSINESSOBJECTS in either of two ways:

* From any INFOVIEW document list (in Expanded mode), you can download
the original .rep file without even opening the document. Just click Load
BusinessObjects Document in the last line in the document’s entry.

* INFOVIEWFrom any open BUSINESSOBJECTS document, click the Download
button in the toolbar.

Note: The first time you download a document, your browser displays an
“unknown file” message and asks you if you want to open the file or save it to
disk. Once you’ve made your selection, you are prompted to select the program
to use to open the document.
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Deleting Documents

You can delete any documents you want from your Inbox Documents and your
Personal Documents page storage areas.

In the Corporate Documents page, you can delete any document you created, as
well as other documents if you have the rights to do so.

Note: When you have the right to delete a corporate document, there is a small
box next to the document name when you view the list in Compact mode.

To delete a document:

1. Do one of the following:

* To delete one or more documents from a document list in Compact mode,
just click the box next to the name of each document you want to delete,
then click Delete in the toolbar.

* To delete a document from a document list displayed in Expanded mode,
click Delete in the last line of the document entry.

e If the documentis already open in the Document Results page, click Delete
in the toolbar.

The Delete page opens.

Confirm deletion of documentis)

1 ARWOS
™ Annual Report

oK | Biack to Document List |

2. Click OK to confirm that you want to delete the document(s).

At the bottom of the screen, a message tells you when INFOVIEW has
successfully deleted the document(s).
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Publishing Documents

When you publish a document with INFOVIEW, you save it to a document domain
in the common corporate repository. This allows multiple INFOVIEW,
WEBINTELLIGENCE, and BUSINESSOBJECTS users to access the same document and
information.

When you publish a document, you can also:

* Assign it to one or more categories, or modify previous category assignments,
thus making it easier for other users to find this document.

For example, if this document contains information of interest to the
marketing department in your company, you might assign the document to
the “Marketing” category. When the document is published, people in
Marketing can filter their Corporate Document lists to display only
documents in that category.

* Schedule the document to be automatically refreshed and re-published
through a BROADCAST AGENT in your cluster. If you don’t have the right to
schedule documents or access the BROADCAST AGENT, this option is hidden.

To publish a document:

1. Do one of the following:

e If the document is already open in the Document Results page, click
Publish in the toolbar.

e To publish a document from the Personal Documents or Inbox Documents
page without opening it, display the document list in Expanded mode,
then click Publish in the last line of the document entry.

e Tore-publish a corporate document, open it in the Document Results page,
then click Publish in the toolbar.
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The Publish page opens.

Enter the document name:

Enter the document description:

Select Categories:

Enter the document keyword(s):
Select the docurment domain:

Select the destination groups:

Overwrite if docurment exists:

Refresh options:

Publish |

Publish as corporate document

|RegExas

Expenses by Region 1998 ﬂ

H

revenues =]
Lty

|Expenses

IDDcument 'l

e F No

" Refreshed manually
'_(‘_:Refreshed when opened
E‘Scheduled Refresh

Biack to Document List |

Publishing Documents

At any point before you actually publish the document by clicking Publish,
you can return where you were in INFOVIEW by clicking the Back to Document
or Back to Document List button.

2. By default, the document’s current name appears as the document’s name. If
you want to change it, do so in the entry box.

3. In the document’s description box, describe the document (optional).

4. If the document has already been assigned to one or more categories, the
category is highlighted in the Categories list box.
You can assign the document to one or more repository categories by
highlighting your choice(s) in the Categories list. Select one of the following
options to assign your document to one or more categories.

e To assign the document to a single category, click the category in the list

box.

e To assign the document to more than one category, hold down the Ctrl key
while clicking the desired categories in the list box. This creates a multiple

selection.
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e If the document already belongs to a category and you want to remove it,
just click the highlighted category. To remove a document from multiple
categories, hold down the Ctrl key while clicking the categories.

¢ If a desired category isn’t in the list, click the Categories link to go to the
Category Management page, where, if your user rights allow it, you can
create new repository categories.

. If you want, enter one or more keywords to serve as search criteria for this

document.

. Select the document domain in which you want to store the document.

The domains for which you have writing and modification rights are listed in
the drop-down box. You can save to these domains only.

. Select the group to which you want to make the document available.

Available groups are listed in the accompanying listbox.

. Click Yes or No for the option, Overwrite if document exists.

e If you select Yes, this document will replace any other document in the
same document domain with the same name.

o If you select No, INFOVIEW will store this in the document domain with
another document ID, and both documents will be available.

. Choose a refresh option:

* Refreshed manually
The document will be refreshed only when a user refreshes it manually.
* Refreshed when opened
Whenever another user opens the document, INFOVIEW runs the
document’s query again, formats the document, and displays the
document with the most up-to-date data.
* Scheduled Refresh
INFOVIEW will automatically refresh the document at specific times or
intervals, then re-publish it to the repository. For complete information
about this scheduled refresh, and where to go from here, see “Scheduling
Documents with Broadcast Agent” on page 125.

10. Click Publish.

A flashing message confirms that INFOVIEW has successfully published the
document.
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Sending Documents to Other Users

You can send WEBINTELLIGENCE, BUSINESSOBJECTS documents and other files that
have been uploaded to the system, to other users.

When you send a document, you also define how you want the document to be
refreshed. If your supervisor has given you the right, you can schedule
WEBINTELLIGENCE and BUSINESSOBJECTS documents to be automatically
refreshed and re-sent to the recipients you've defined through a BROADCAST
AGENT in your cluster. If you don’t have the right to schedule documents or
access the BROADCAST AGENT, this option is hidden.

To send a document:

1. Do one of the following:

To send a document from any INFOVIEW document list without opening it,

display the list in Expanded mode, then click the Send to users link in the

last line of the document entry.
If the document is already displayed in
Send in the toolbar.

The Send page opens.

the Document Results page, click

Send document to the following user(s)

Enter the document name: IARgg_Q

Enter the document description:

Annual Revenue by Quarter 1999ﬂ

H

Enter the document keyword(s): |Annual

IDDcument 'l

USERD

Select the repository:

Select the destination users:

USERT
USER2 ||
USER3

USER4 hd|

Refresh options: & Refreshed manually
" Refreshed when apened

" Scheduled Refresh

Send I

Biack to Document List

At any point before you actually send the document by clicking the Send
button on this page, you can return to where you were in INFOVIEW by
clicking the Back to Document or Back to Document List button.
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. By default, the document’s current name appears as the document’s name. If

you want to change it, do so in the entry box.

. In the document description box, enter a description if you want. Descriptions

are displayed in the document list when it’s in Expanded mode.

. If you want, enter one or more keywords to serve as search criteria for this

document.

. Select the document domain in which you want to store the document.

The BUSINESSOBJECTS supervisor grants you read and write rights to
document domains in the corporate repository. The document domains for
which you have writing and modification rights are listed in a drop-down
box. You can save to these domains only.

If you have rights to more than one domain, and you don’t know which one
to choose, ask your supervisor.

. Select the user(s) to whom you want to send this document.

. Choose a refresh option for the document:

* Refreshed manually
The document will be refreshed only when a user refreshes it manually.

* Refreshed when opened
Whenever another user opens the document, INFOVIEW automatically runs
the document’s query again, formats the document, and displays the
document with the most up-to-date data.

* Scheduled Refresh
INFOVIEW will automatically refresh the document at specific times or
intervals, then send it to the users in your distribution list.
For complete information about this type of refresh, and where to go from
here, see “Scheduling Documents with Broadcast Agent” on page 125.

. Click Send.
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Scheduling Documents with Broadcast Agent

BROADCAST AGENT is a powerful BUSINESSOBJECTS server product that allows
INFOVIEW and BUSINESSOBJECTS users to refresh then distribute documents via
the repository, an intranet, or the World Wide Web.

With INFOVIEW, you can use BROADCAST AGENT to schedule any BUSINESSOBJECTS
or WEBINTELLIGENCE document to be automatically refreshed at specific times,
dates or intervals, then sent to users of your choice or published to the corporate
repository. To make sure you get the latest updates of mission-critical
information, you can even send yourself the pertinent documents, then schedule
automatic refreshes for them. Each time the documents are refreshed, they will
automatically be sent to you.

You can schedule document refreshes for off-peak times, for example at night,
thereby reducing both daytime network traffic, and the risk that the task might
not go through due to an overloaded network.

BROADCAST AGENT also supports condition-based processing, whereby a new
task begins when and only when a certain condition has been met. This feature is
called the File Watcher. For example, you can specify a file that must be present
before BUSINESSOBJECTS processes the document.

A typical use of this feature is the database administrator who posts a text file to
signal the successful reload of a data warehouse; when the text file is present in
the specified location, BUSINESSOBJECTS refreshes and distributes the
document(s).

For detailed information about File Watcher, see page 131.

You can view the status of any document you have scheduled using BROADCAST
AGENT. See “Monitoring your scheduled documents” on page 133.

To Schedule an automatic refresh for a Document:

1. Do one of the following:
* From the document’s Publish page, in the Refresh Options section, select
the Scheduled Refresh option, then click the Publish button.
e In the Refresh Options section of the Send Page, select the Scheduled
Refresh option, then click the Send button.
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The Scheduling Options page opens.

» Scheduling Options

Refresh Refresh date and time
frequency:
Date (mmiddiyy) [2 =] +[17 =] +[2000
&0
I HEE:y Hour (hh:mn) |4 vl;ISD 3|PM vl
 Daily
C yeekly
" Monthly

 Monthly Interval
' User-Defined

Broadcast Agent:

Update document prompts Wiew prompts |

File Watcher:

Enter file name to watch for:

[ Delete the file each time a refresh starts

The Refresh frequency section contains a series of predefined scheduling
options to the left, including the possibility to define a different, customized
schedule. When you select an option, the entry fields to the right change to fit
the selected option.

For information about these options, see “Refresh scheduling options” below.
Notice that you access the bottom part of the window using the scrollbar to
the right.

. More than one BROADCAST AGENT may be installed in your INFOVIEW cluster.

In the Broadcast Agent field, choose the name of the BROADCAST AGENT you
want to use.

. If the document contains prompts, you can click View Prompts to update

them.

4. In the File Watcher section:

e If you want the document(s) to be refreshed only if a particular file is
present, enter the path and filename of the file you want the File Watcher
to check for.
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e If you want that file to be deleted as soon as the refresh starts, check that
option.

For detailed information about the File Watcher, see page 131.

5. Click OK.

INFOVIEW displays a message confirming that the document has been
successfully published or sent.

If the BROADCAST AGENT with which you scheduled your document is not
running when you publish, the document is published anyway, but the
subsequent refresh-and-republish schedule is not processed until BROADCAST
AGENT is up.

Note: You can make sure you receive regular updates of the documents that are
critical to your work by sending those documents to yourself, and defining
scheduled refreshes for them.

Refresh scheduling options

When you schedule a document for automatic refresh and distribution, you can
choose from among the following scheduling options:

Once

The Once option refreshes the specified document(s) once at a specified date and
time. By default, the current date and time appear in the dialog box. You can enter
anew date and time.

Scheduling Options

Refresh Refresh date and time

frequency:

& Once Date (mmfddfyy) |1 'l f|1 'l f|1998
© Hourly

 Daily Haur (hh:mn) |1 'l B IDD ;IAM 'l
 Weekly

 Monthly

 Monthly Interval

 User Defined
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Hourly

The Hourly option refreshes the specified documents once an hour during the
interval specified.

For example, if you specify 30 in Minutes after the Hour, 5 in From, and 8 in To,
the task is processed three times: at 5:30, 6:30, and 7:30.

Scheduling Options

Refresh Minutes(s) after the hour |1

frequency:
from (hh:mn)|1 vI:IDD :IAM 'l
to  (hhimn) |1 'l i IDD :IAM 'l
¢ Once Start Date:
& Dl (mmfddfyy)h v[f|1 v[f|1998
aily
 Weekly Expiration Date:
 Monthly {mmiddiy) |1 'l f|1 'l f|1999

 Monthly Interval
" User Defined

Daily

The Daily option refreshes the specified document(s) on one or more specified
days of the week at a specified time, at weekly intervals.

Check the days you want to refresh the document(s).

Scheduling Options

Refresh Every: |1 weekis) Day(s) of the week:
frequency: Time: (hh:mn) |1 'l ] IDD : IAM 'l
: Once Start Date:
Haourly
& Daily {mmiddfyy) |1 | f|1 | f|1998
C Weekly Expiration Date:
© Morthly (mmiddiyy) [T =] /[ =] [z000 |

 Monthly Interval
" User Defined
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Weekly

The Weekly option refreshes the document(s) on one day of the week at a
specified time.

Scheduling Options

Refresh Every: |1 wieek(s)
frequency: Which day: [Monday =]
 Once Time: (hh:mn) |1 'l g IDD g IAM 'l
.

- gzﬁ;'ﬁ’ Start Date:

f‘WeekIy [ ddiyy) |1 vl f|1 vl f|1998
 Monthly Expiration Date:

 Monthly Interval (mm/ddfyy) |1 vl f|1 vl f|1998

" User Defined

Monthly

The Monthly option refreshes the document(s) on selected days of the month at
a specified hour.

Check the days you want to process a document.

Note: Depending on the database used by the security domain, you cannot send
a task if you select 1st Day of the month.

Refresh Day(s) in [T =
frequency: the month: (02
03
 Once 04 |
 Hourly Time: (hh:mn)|1 'l :IDD :IAM 'l
€ Daiy Start Date:
:: :ﬂve?::y (amsddiy[T =1/ =] /[raes
L an
r Momh; Interval Expiration Date:
© User Defined (mm'fdd-'fW)h 'lf|1 'lf|1998
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Monthly Interval

The Monthly Interval option refreshes the document(s) at the daily and monthly
intervals you specify.

Refresh Every: |1 month(s)
frequency: Day: |15t =] |Day =l
€ Once Time: (hhemn) [ =] oo | - [am=]
e
(. oty Start Date:
Diaily

 Weekly (onfddiyyy |1 =] i1 =] /[r99s
 Monthly Expiration Date:
& Monthly Interval (mmfdds

w1 =l =] f|roes
 User Defined I = I = I

User Defined

The User defined option refreshes the document(s) at the interval you specify.

Refresh Every: [ [minwes) =
frequency: Start Date:

€ Once Date (mm/ddryy) |1 =] 7|1 =] /[r998

:: gz:;ly Haur (hh:mn) m : W : m
 Weekly Expiration Date:

" Monthly Date (mm/ddiyy) |1 =] 7|1 =] /[r99s

e M;;:P;g;f::;edrval Hour {hh:mn) m : W : m
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File Watcher Essentials

File Watcher is the BROADCAST AGENT feature that permits the processing of tasks
when and only when a specified file is present in its specified location.

A typical use of this feature is the database administrator who posts a text file to
signal the successful reload of a data warehouse; when the text file is present in
the specified location, BROADCAST AGENT refreshes and distributes the
document(s).

The File Watcher feature means that BROADCAST AGENT can interoperate with all
existing systems, even legacy systems anywhere on the network. For example, a
legacy system could create a file that BROADCAST AGENT is watching for.
BROADCAST AGENT would then execute the scheduled task. This would create a
new document that in turn would trigger the creation of another document. This
cascading chain of reactions and documents depending on specific conditions is
called “report chaining.”

What kind of file can you use?

You can use any kind of file.

Where can the file be located?

The file can be located wherever you want--on a server, on the client or on a file
system--as long as the BROADCAST AGENT machine can access the file where it has
been defined.

What kind of access rights are required?

Each BROADCAST AGENT has a component called BusinessObjects Manager. The
Manager is a server-based version of BUSINESSOBJECTS that allows BROADCAST
AGENT to display and refresh BUSINESSOBJECTS documents.

When BROADCAST AGENT detects a document in the repository that is due to be
processed, its BusinessObjects Manager launches a BUSINESSOBJECTS session,
which extracts the document from the repository and processes it.

Each BusinessObjects Manager is configured with the user name and password
of an NT user, and therefore has defined access rights to machines, disks and
directories.

In order to use the File Watcher, the BusinessObjects Manager used for a
particular task must have access rights to the specified file and location.

For example, if you enter x:\Temp \Business Objects\file.txt in the File Watcher
box in the Scheduling Options page, the BusinessObjects Manager associated
with the BROADCAST AGENT you've chosen must have read rights for the server x
and the directory Temp\ Business Objects on that machine.
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How do you indicate where to find the file in the Scheduling Options
dialog box?
You can use either of two name and path conventions:

e A standard local or remote pathname, such as
c:\Program Files\Business Objects\Demo\file.txt, or
x:\Temp \Business Objects\file.txt

e A valid UNC

UNC stands for Universal Naming Convention, PC format for specifying the
location of resources on a local-area network (LAN). UNC uses the following
format:

\\ server-nane\ shar ed- r esour ce- pat hnane

So, for example, to access the file.txt file in the directory examples on the
shared server silo, enter:

\\silo\exanples\file.txt

Note: We highly recommend that you use a UNC. Why? Because BROADCAST
AGENT is distributed, and therefore a scheduled job may run on one of any
number of servers.

If you use a remote path name, the drive used must be properly configured on
the BOManager server if it is to find the file. When you use a UNC, however, the
name of the server or PC on which the file is located is included, thereby ensuring
that the BROADCAST AGENT server can find it.

What happens if Broadcast Agent can’t find the file?

If the BROADCAST AGENT can’t locate the file at task execution time, it simply
doesn’t run the task.

What rights are required to delete the file after task execution?

The Scheduling Options page contains the option Delete the file each time a refresh
starts. If you check it, the BusinessObjects Manager used for the task must have
read and write rights to the specified file and location.

132 InfoView User’s Guide



Scheduling Documents with Broadcast Agent

Monitoring your scheduled documents

You can view the progress of the documents you've sent to BROADCAST AGENT by
running the BROADCAST AGENT Console. You use this Console to:

* See which documents have been successfully processed

e Check information about scheduled documents, such as their status, refresh
schedule and size

* Get information on task failure so that you can fix errors that have occurred
* Delete scheduled tasks if necessary

The BROADCAST AGENT Console lists the documents sent for processing. For each
document, the Console displays information such as document name, status,
refresh frequency, and so forth.

Opening the Broadcast Agent Console in InfoView
To open the Console:

1. Click Scheduled Documents in the INFOVIEW navigation bar. The following
appears.

WEBINTEWIGENCE .
INF*VIEW Refresh  (ADClete oy [EERRETEIRR| sceuedty:

Welcome

Corporate Flease select a Broadcast Agent in the server list above.

Documents

Personal
Documents

Inbox
Documents

Scheduled
Documents

2. In the View listbox in the toolbar, select one of the following lists:

e Pending Jobs to view documents still awaiting refreshing and distribution
Aslong as a document is still scheduled to be refreshed and distributed, it
is in this list.

e All Jobs Log to view the status of all the documents that you have
scheduled

e Failed Jobs Log to view all the jobs that have not been successful, along
with a description of the problem

3. In the Scheduled by listbox in the toolbar, choose the name of the BROADCAST
AGENT on which you scheduled the document refresh(es).

InfoView User’s Guide 133



Chapter 4 Publishing, Sending and Scheduling Documents

e If you haven'’t yet scheduled a document on the selected BROADCAST
AGENT, a message appears.

¢ If you have scheduled at least one document on the selected BROADCAST
AGENT, the Broadcast Agent Console opens, displaying the type of list you
requested in Step 2.

B | Document Name

™ ™ AR_Nw 98

™ ) AnowTrailProducts
™ ¥ Forecast 99_0

I ¥l InvoiceA1637-FDE39

This list was last refreshed: Feb 15 15:27:04 1999 .

Frequency Next Schedule Description

YWaiting Diaily
YWaiting Once
YWaiting User Defined
YWaiting User Defined

For each document, the Console displays information such as its name, status,
refresh frequency, description and size.

Understanding task status

Tasks displayed in different lists have different status values.

¢ Tasks in the Pending Jobs list can have the following status:

Status Description
Waiting Scheduled for later processing.
Suspended Task with Waiting status that is paused.
You cannot suspend a task, but the Supervisor or
system administrator can.
Running Currently processing. Changes status to Successful or

Failed after processing.

Delayed execution

Has reached scheduled processing date and is on
standby to be processed when currently running tasks
are completed.

Retrying

Failed task that is being reprocessed.
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e Tasks in the Failed Jobs list can have the following status:

Status Description

Failure Task processing failed.

e Jobs in the All Jobs Log can have the following status:

Status Description
Expired Task schedule has expired.
Failed Task processing failed.
Successful Task processing was successful.

Deleting a scheduled document

You can delete a scheduled document from the BROADCAST AGENT Console by
checking the box preceding its entry, then clicking Delete in the toolbar.

You can check several documents, then delete them all at once if you want.

Note: You cannot modify a document’s schedule from the Console. If you want
to make a change, you must delete the task in the Console, then return to the
document’s INFOVIEW Send or Publish page and schedule the document again.

Closing the Console

To close the BROADCAST AGENT Console, either click your browser’s Back button
or click any link in the navigation bar to go to another part of INFOVIEW.
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General Advice

In order to log into INFOVIEW, your browser needs to be cookie-enabled. For
instructions, consult your browser’s on-line help.

To prevent any problems using INFOVIEW, run the browser configuration check
by clicking its link in the INFOVIEW Login page.

Try to empty your browser’s memory cache regularly. Having a large part of
your disk allocated to the cache can slow down the operation of your computer
(especially if you have little free disk space already). For instructions, consult
your browser’s on-line help.

You should also set your browser to check for newer versions of the stored page
every time you visit the page. For instructions, consult your browser’s on-line
help.

Common Problems

The following is a list of problems you may encounter when using INFOVIEW over
the Web, as well as possible solutions. If these solutions still don’t resolve your
problem, contact your system administrator for help.

* When you try to log in, an error message appears.
e Problems occur when you try to load a document’s data into a spreadsheet.

* When you try to take an action on a document, the error message
appears: “The document contains no data.”

* You have received the message, “This name already exists, use a
different name or allow overwrite.”

*  You have received the message “The required service is not available.”
* The Send or Publish window is only partially displayed.

* You have received the message, “This script is taking an unusually long time
to finish.”
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When you try to log in, an error message appears.

You have provided your username and ID in the INFOVIEW login page, and you
get an error message instead of INFOVIEW.

What you can do

* Your login information may be incorrect. In this case, you should contact your
INFOVIEW administrator or the BUSINESSOBJECTS supervisor who created your
user profile.

e If you're using Microsoft Internet Explorer 2, you will be unable to login.
INFOVIEW requires a cookie containing login information and a session ID in
order to connect you to the INFOVIEW system.

Problems occur when you try to load a document’s data into
a spreadsheet.

What you can do

When you load data from a document into a spreadsheet, you may need to define
the spreadsheet application you want to use.

Data imported into a spreadsheet is imported as text. This means that your
computer’s number settings affect the way the text is handled.

If the text from the WEBINTELLIGENCE document uses a decimal point as the
decimal separator, your computer must do the same, otherwise the numbers will
not be recognized. You will not be able to format them or make calculations.
Typically, this occurs if your regional settings are for Continental European
countries such as France and Germany, and you are using a decimal symbol used
in a North American country (USA or Canada) or vise versa.

If you're using Windows, you can change the decimal separator in the Window’s
Control Panel’s Regional Settings dialog box.
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When you try to take an action on a document, the error message
appears: “The document contains no data.”

You have tried to edit a document containing query results, or load its data into
a spreadsheet or save it. The action does not take place, and an inappropriate
error message appears indicating that the document contains no data.

What you can do

¢ The BUSINESSOBJECTS supervisor may have changed your access rights during
the current session so that you no longer have access to the current document
domain. In this case, contact the supervisor.

* The HTML page may simply need reloading. Click your browser’s Refresh or
Reload button.

* You may need to log out of INFOVIEW, then log back in again.

You have received the message, “This name already exists, use a
different name or allow overwrite.”

You have just tried to save a document to your personal storage area and a
document with that name already exists.

What you can do

This message is simply prompting you do one of the following:

* Select Yes for the Overwrite if document exists option if you want to overwrite
the existing document of that name, then click Save again.

e If you don’t want this document to overwrite the existing one, change this
document’s name, then click Save again.

You have received the message “The required service is not

available.”

You have taken any kind of action in INFOVIEW, such as opening a document list,
or simply clicking a button in the toolbar or navigation bar, and you receive this
message.

What you can do
Click the Refresh or Reload button in your browser.
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The Send or Publish window is only partially displayed.

You have tried to send a document to another user or publish it to the corporate
repository, but the Send or Publish page isn’t completely displayed.
What you can do

Click the Refresh or Reload button in your browser.

You have received the message, “This script is taking an unusually
long time to finish.”

You are using Windows 95. You tried to download an applet and this error
message appeared.

What you can do

This kind of problem usually occurs with “minimum” configurations, for
example, on machines with little disk space and RAM, and usually when
Microsoft Internet Explorer version 3 is being used.

In this case, empty your cache, close your browser, then relaunch the browser and
INFOVIEW. You may also consider upgrading your browser.

You have received the message, “You cannot export the
document as it is in 4.1 format in the repository.”

You have tried to send or publish a BUSINESSOBJECTS document from INFOVIEW.
A BUSINESSOBJECTS 4.1 document with the same name already exists in the
repository. If you did send or publish the current document, you would
overwrite the one in the repository. Consequently, BUSINESSOBJECTS 4.1 users
would no longer be able to work with the document, because you cannot use
BUSINESSOBJECTS 5.1 documents in BUSINESSOBJECTS 4.1.

What you can do

You can overwrite BUSINESSOBJECTS 4.1 documents in the repository by using the
Send and Publish features in BUSINESSOBJECTS 5.1. You cannot do this from
INFOVIEW.

For information on sending and publishing documents from BUSINESSOBJECTS,
refer to “Sending and Publishing BusinessObjects Documents” on page 211.
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When you try to open a BusinessObjects document, this message
appears, “VBA is not available”.

You do not have the correct version of VBA installed on your computer to view
this document. One of the following situations may apply:

* The document you are trying to open contains one or more macros.

If you click OK, the document opens with the macros disabled. If you click
Cancel, you will receive another error message, “The file could not be
opened.”

* The document you are trying to open contains add-ins.

* The document you are trying to open contains a VBA data provider.

What you can do

If you do not need to edit the document you will be able to view it without any
problems. If you disable the macros, you will not be able to install and use add-
ins, run macros, or refresh or edit the data that uses a VBA data provider.

If your document is built on a universe, you may still be able to refresh and edit
the data with the macros disabled.

If you installed BUSINESSOBJECTS through the INFOVIEW portal, you can obtain the
correct version of VBA by uninstalling BUSINESSOBJECTS from your computer,
and reinstalling it through the portal. The install wizard will ask you if you want
to install the BUSINESSOBJECTS version of VBA. Check the box labelled Download
and Install VBA, and continue with the installation.

If the option to download VBA does not appear, contact your system
administrator for assistance.
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What Is BusinessObjects Reader?

BUSINESSOBJECTS READER provides access to your business information, by
enabling you to view and distribute BUSINESSOBJECTS documents, directly from
your desktop.

Can you create or edit documents in BusinessObjects Reader?

You cannot create new documents or edit existing documents using
BUSINESSOBJECTS READER. By design, READER lets you view, refresh, save, publish
and print documents.

You can create and edit BUSINESSOBJECTS documents using the BUSINESSOBJECTS
REPORTER module. You can perform drill-down analysis by using the
BUSINESSOBJECTS EXPLORER module. These modules are optional; you or your
administrator can install them on top of the BUSINESSOBJECTS READER product.

In summary:

*  Whether you have BUSINESSOBJECTS READER, or REPORTER and /or EXPLORER,
you can view, refresh, publish and print documents.

e To be able to create and edit BUSINESSOBJECTS documents, you have to install
the BUSINESSOBJECTS REPORTER module.

e To be able to perform drill-down analysis, you have to install the
BUSINESSOBJECTS EXPLORER module.

All reporting and analysis features are described in the BusinessObjects User’s
Guide.

What can you do with BusinessObjects Reader?

With BUSINESSOBJECTS READER you can make the most of the information you
have at hand, by working with documents that are created from the data in your
data warehouse, and distributed through the repository, the centralized storage
and distribution mechanism that manages universes, user information and
document exchange.

BUSINESSOBJECTS READER lets you:

e Retrieve and view BUSINESSOBJECTS documents that other users have sent to
you, published to the corporate repository, or scheduled.

* Sort documents in the repository by category, transforming often unwieldy
document lists into pertinent subsets of relevant information.

¢ Send documents to other BUSINESSOBJECTS and INFOVIEW users.
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Publish documents to the corporate repository, where they can be accessed by
whole groups of users, from BUSINESSOBJECTS READER or INFOVIEW over the
Web.

Save copies of retrieved documents.
Refresh documents you've retrieved with the latest data from the database.

Work with BROADCAST AGENT, which lets you automate the communication
of business information throughout your enterprise - or even further -- by
refreshing, printing, and publishing your documents through the
BUSINESSOBJECTS repository, or over the World Wide Web.

Print documents.

Customize BUSINESSOBJECTS READER with VBA macros and add-ins.

What you cannot do
With BUSINESSOBJECTS READER, you cannot:

Format documents
Create new documents, or add data to existing documents.

Retain the formatting of WEBINTELLIGENCE documents. When you open these
in BUSINESSOBJECTS READER, they are automatically formatted with the
standard BUSINESSOBJECTS document template.

Send, publish or schedule WEBINTELLIGENCE documents. Using
BUSINESSOBJECTS READER, you can send, publish and schedule
BUSINESSOBJECTS documents only.

How do InfoView and BusinessObjects Reader work together?

Both INFOVIEW and BUSINESSOBJECTS READER are your entry points to viewing
the business information you need.

When you log into INFOVIEW in your browser, you get instant access to the
document lists that provide an overview of your corporate data capital.

When you log into BUSINESSOBJECTS, you can make sure you're notified when
documents are waiting to be retrieved. Using the Document Exchange toolbar,
you can access the list of documents that have been published to the
repository and made available to you, sent to you by other users, or
distributed to you through BROADCAST AGENT.
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What is Document Distribution?

What are you going to do with the business information contained in your
BUSINESSOBJECTS documents? In most cases, you need to exchange information
with other people in your organization, your business partners, and with the
outside world.

One of the key advantages of BUSINESSOBJECTS is its integrated architecture that
enables you to communicate business information across your enterprise or
organization. BUSINESSOBJECTS lets you publish your information around the
globe using the World Wide Web. You can:

* Publish BUSINESSOBJECTS documents through the repository, so that
BUSINESSOBJECTS and INFOVIEW users can access the information in those
documents.

* View and retrieve documents that other users have published.

e Schedule BUSINESSOBJECTS documents thanks to BROADCAST AGENT, which
automates document processing and distribution.

e Publish documents on the World Wide Web and Microsoft channels.

e Print documents.

What’s new in document distribution?

148

If you're updating from a previous version of BUSINESSOBJECTS, use this section
to find out what’s new in document distribution in this version.

Easier to publish BusinessObjects documents for Web users

BUSINESSOBJECTS repository-based architecture allows you to distribute
information across your enterprise. By publishing a BUSINESSOBJECTS document
on the repository, you let not only BUSINESSOBJECTS, but also INFOVIEW users
view and retrieve the document over the Web. BUSINESSOBJECTS automatically
generates the correct format required to view the document in a Web browser.

In BUSINESSOBJECTS, you can also view documents that WEBINTELLIGENCE users
have created and published. (For information about limitations on working with
WEBINTELLIGENCE documents in BUSINESSOBJECTS, refer to “Restrictions on
Weblntelligence and BusinessQuery documents” on page 170 and “Saving
WeblIntelligence documents” on page 175.)
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INFOVIEW users can view BUSINESSOBJECTS documents either in HTML, or in an
enhanced format that displays and prints documents as if they were open in
BUSINESSOBJECTS (same fonts, page layout etc.) -- and all this over the Web,
corporate intranet or extranet.

Finally, BUSINESSOBJECTS and INFOVIEW users can schedule documents with
BROADCAST AGENT. When BROADCAST AGENT publishes processed documents to
the repository, any BUSINESSOBJECTS or INFOVIEW user with repository access can
view the document.

Sending documents to groups of users

You can now send documents not only to individual users but also to user
groups, which the supervisor sets up. This allows departments or working teams
to share information more easily.

Publishing documents to channels

BUSINESSOBJECTS now supports channels, which let you subscribe to information
published over the World Wide Web. The supervisor sets up a channel for each
group of users. You then publish a document to this channel using the Publish
To>Channels command on the File menu.

You can use this feature if you're using Microsoft Internet Explorer version 4 or
higher.

Document Agent Server is now Broadcast Agent

DOCUMENT AGENT SERVER provided scheduled document processing with
BUSINESSOBJECTS 4.1.

BROADCAST AGENT is the new name for this product, but the name is not all that
has changed. For example, BROADCAST AGENT now lets you perform report
bursting, whereby you can automatically refresh a document according to the
profile of the users who will receive it. For the full list of the new scheduled
processing features, see “What can Broadcast Agent do?” on page 231.

On the server side, BROADCAST AGENT benefits from CORBA’s distributed
deployment, load balancing and fail-over capabilities. For more technical
information about BROADCAST AGENT, see the Deployment Guide and the Broadcast
Agent Administrator’s Guide.
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Categories

A category is a keyword or phrase you can assign to documents when you
publish them to the repository, send them to users or to BROADCAST AGENT.
When retrieving documents, you can then filter your searches to find only those
documents corresponding to selected categories, no categories, or all categories.

For example, when sending documents, you can assign the “Marketing” category
to documents of interest to the Marketing Department. Marketing personnel can
then search the repository using this category, and find relevant documents
quickly.

Categories pertain to a particular repository. Documents in the repository can be
associated with no category, or several, but they have no associated categories if
they aren’t stored in the repository.

Finding and retrieving documents from the repository

Another new BUSINESSOBJECTS feature is the Find command on the File menu,
which allows you to search the repository for documents. This command opens
a dialog box in which you specify search criteria, such as Processed Documents if
you want to see documents from BROADCAST AGENT only. Once you've limited
the number of documents displayed, it’s easier and quicker to pick the ones that
interest you.

Document properties

Document properties are an essential feature of the new document search
capability. All BUSINESSOBJECTS documents have document properties, including
the name of their data provider(s), their specified refresh option, and the date and
time they were last refreshed. You can also add document properties such as
keywords, comments and document author information, using the Properties
command on the File menu.

When you retrieve documents from the repository (Retrieve From commands,
File menu), you can use document properties to browse only the documents you
need. This feature is especially helpful if your organization publishes large
numbers of documents, only some of which are pertinent to you.

Tip: BUSINESSOBJECTS 4.1 documents didn’t have document properties per se.
Thus, if you select Retrieve From>Corporate Documents on the File menu, then
run a search on documents that have document properties, you will view only
those documents that were created in BUSINESSOBJECTS 5.0. For more information
about finding documents, see “Using search criteria to find published
documents” on page 203.
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Document Exchange toolbar

Document publishing with BUSINESSOBJECTS is now even easier, thanks to the
new Document Exchange toolbar. The toolbar provides shortcuts to all the Send
To, Publish To and Retrieve From commands on the File menu.

See page 163 for an illustration and description of the Document Exchange
toolbar.
Characters that you can use in document names

When you save BUSINESSOBJECTS documents, you can use spaces and characters
other than A-Z or 0-9. However, spaces and non-alphanumeric characters are not
supported in documents that you distribute for viewing over the Web. This
restriction applies to documents viewed in HTML, and in the Report Viewer
(metafile format).

So, when you send or publish documents to the repository, use only A-Z and 0-9
(ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456
789). Other characters, including spaces, will be replaced by a percentage sign
(%), followed by the character’s hexadecimal ASCII code, e.g.,

My Document.htm is converted to My%20Document.htm.

This restriction also applies to documents that you update from version 4.1.

Maximum number of characters in report tabs for Web distribution

You can use up to 27 characters in the report tabs of documents that you send or
publish for viewing over the Web, in INFOVIEW.
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Overview

Overview

This chapter explains some of the basics you need to know to work with
BUSINESSOBJECTS READER and then describes the everyday tasks you'll be doing,
such as opening documents and reading the reports in them, refreshing reports
with updated data from the database, running macros, and saving documents in
different formats so that you can use the data in other applications.
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Starting BusinessObjects Reader

The way you start BUSINESSOBJECTS depends on how it has been set up in your
company. You may be able to start BUSINESSOBJECTS from INFOVIEW via an
Internet browser as well as from the Windows Start menu if this has been set up
in your company. Your system administrator will give you all the necessary
information on how you should start your BUSINESSOBJECTS. Using
BUSINESSOBJECTS via INFOVIEW is fully documented in “Viewing BusinessObjects
documents in BusinessObjects” on page 80 of this user’s guide. Starting
BUSINESSOBJECTS from the Windows start menu is explained below.

Starting BusinessObjects from the Windows Start menu

The way you log on to BUSINESSOBJECTS depends on the way BUSINESSOBJECTS
has been set up in your company. When you start BUSINESSOBJECTS, you may
have to enter a user name and password and you may have to choose a security
domain.

If this is the case, the user name, password and security domain are assigned by
your BUSINESSOBJECTS supervisor or system administrator.

To start BUSINESSOBJECTS:
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1. Click the BUSINESSOBJECTS program icon in the BUSINESSOBJECTS group in the
Programs menu.
The User Identification dialog box appears:

User Identification E

— Enter your name and password to login.
User Mame: I j ] |

Password: I Cancel

Security Domain Ia caza j Help |

[ Use in Offine Mode

2. Enter your user name and password and choose your security domain, if
applicable, and click OK.

3. The User Identification box closes and the BUSINESSOBJECTS window opens

Note: In some configurations, the User Identification dialog box does not appear
when you start BUSINESSOBJECTS.

Choosing a security domain

Depending on the way BUSINESSOBJECTS is set up in your company, you may
have a choice of security domains. There are two types of security domain
connection and the features available to you in BUSINESSOBJECTS may change
according to the type of security domain you connect to. Certain menu items may
become unavailable or you may not have access to all types of data provider or
to the same list of universes.

The type of security domain connection is identified by an icon:

* A connection to a repository via a BUSINESSOBJECTS web connection is
identified by a globe icon.

InfoView User’s Guide 157



Chapter 7 BusinessObjects Reader - The Basics

User Identification [ %]
— Enter pour name and password to log in.
User Mame: I j
Password: I Cancel |
. . Security Domain BOMain j Help |
client/server connection 5, EliMain

web connection

Using offline

* A connection to a repository via a BUSINESSOBJECTS client/server connection
is identified by a computer icon:

o cadiz
| casa

mode

Depending on how BUSINESSOBJECTS has been set up, you may have the option of
starting BUSINESSOBJECTS in offline mode. Using BUSINESSOBJECTS in offline mode
means that you are not connected to a repository which in turn means that,
whatever your connection type, you will not be able to retrieve and send
documents using BROADCAST AGENT. However, what you can do once you have
opened BUSINESSOBJECTS in offline mode depends on the type of connection you
chose to use in offline mode.

Client/Server connection

If you are using a BUSINESSOBJECTS client/server connection offline and not
connected to a repository, you can still work with documents and universes
stored locally on your computer and even refresh documents if you have a
connection to the database, and the database connection and security information
is stored on your computer.

Web connection

If you are using a web connection offline, you will not be able to retrieve
documents from, and send documents to, Personal Document folders on the web
server, and will not be able to refresh documents because all the database and
connection information is stored on the web server.

In offline mode, you can view and work with documents stored locally.

If BUSINESSOBJECTS cannot establish the connection you requested with the web
server, it may give you the option of starting BUSINESSOBJECTS in offline mode if
your user rights allow you to work offline.
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No remote connection

You may also choose to start BUSINESSOBJECTS in offline mode because you know
you have no remote connection at all - for example, on a plane - and want to
continue to work on documents you have stored locally.

Note: The right to use BUSINESSOBJECTS offline is given to you by your
BUSINESSOBJECTS supervisor or system administrator. Depending on how
BUSINESSOBJECTS has been set up in your company, you may not even have the
option of logging on to BUSINESSOBJECTS in offline mode.
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What BusinessObjects Reader Looks Like

The BUSINESSOBJECTS READER workspace is illustrated below. BUSINESSOBJECTS
READER has three main parts:

¢ the menus and toolbars
¢ the Report Manager window

* the report window

The document name is

shown in the title bar Menu bar Toolbars Report

jd Business0bjects - Efashion.rep

@ File Edit “iew Toolz Data Window Help

R el su=2s ~Axa | & |k?|P

N >2>3>4>5|
Al AL NS
—ﬁ

@ Product Sales by City

LI

Revenue by Region A0
| Margin Analysis th'\o for year 2001
| Quarterly Yariance
Product Analyzis
----- @ Austin

..... o Chicago margin $424,790.00

----- @ Colorado Springs 3
..... s Dallas Boston sales revenue $887,169_20
----- @ Houston

----- @ Loz Angeles margin $336.574.10

----- @ Miami

----- @ Mewvork F i
..... s Newvok Chlcago sales revenue $1 ,134,035.40
..... * ‘Washington

----- Actual v Budast margin $439,865.00

Austin sales revenue $1,135,479.10

Colorado Springs sales revenue $843,584.20 _

s [l —"_I
LI_’I Fevenue Year 2001 I Fievenue by Fegion I b argin Analysiz I Quarterly Variance

[ [ Last Exec: 2/23/33 01:52PM T 4

Report Manager The name of the report is Status Bar i
displays a list of all the displayed on the report tab and Report window

reports in the document in the Report Manager list
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Menus and toolbars

The menus contain all the commands for the tasks you need to carry out in
BUSINESSOBJECTS READER. Many of these commands also have buttons on one of
the toolbars. You can hide and display the toolbars as needed. To do this:

1. From the View menu, choose Toolbars.
The list of toolbars is displayed as shown below:
Toolbars E

Toolbars

Standard Claze I
[] Dacument Exchange
[ Wisual Basic Help |

¥ Show Shartcut Keys in Tooltips
V' Show Tooltips

2. Check the ones you want to display and uncheck the ones you want to hide.

3. Click Close to close the toolbar window.

Tip: You can also display and hide toolbars by right-clicking on any toolbar. To
display or hide a toolbar, click its name on the menu.

BUSINESSOBJECTS READER has three toolbars:
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The Standard toolbar

Allows you quick access to standard functions such as open, save, print and
refresh:

Standard

EH &R L ER o o mzs o -]k

a b ¢ d e f g h i

a. Open (Ctrl + O)
Displays the Open dialog box.

b. Save (Ctrl +S)
Saves any changes you have made in the document.

c. Print
Prints the selected report or reports in the document.

d. Print Preview
Shows you a preview of how your printed pages will look.

e. Report Manager
Hides or displays the Report Manager window.

f. Refresh Data
Connects to the document’s data providers and retrieves and displays an update of
the data displayed in the document.

9. View Data
Displays the Data Manager dialog box which shows the contents of the data providers
contained in the document.

h. Zoom Control
Allows you to enlarge the document window to make it easier to read or reduce the

display to view an entire report page.

i. Contextual Help
Opens the contextual online Help. Click this button and then click on the menu item,
toolbar button or other part of the BUSINESSOBJECTS workspace you want information on.
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The Document Exchange toolbar

Allows you to find and retrieve documents, publish documents and send
documents to other users by email or via the BUSINESSOBJECTS repository.
Sending, retrieving and publishing documents is dealt with in detail in Chapter
8 "Viewing and Retrieving Published Documents in BusinessObjects" on page
195, Chapter 9 "Sending and Publishing BusinessObjects Documents" on page
211 and Chapter 10 "Scheduling BusinessObjects Documents" on page 229.

Document Exchange

R RN " R < AR R

a b ¢ d e f g h i j k

a. Send to Personal Documents
Retrieves documents from your personal documents folder on the BUSINESSOBJECTS web
server.

b. Retrieve from Personal Documents
Saves documents in your personal documents folder on the BUSINESSOBJECTS web server.

c. Find Documents
Displays the list of published documents, and lets you run a document search based on
criteria that you set.

d. Publish To Corporate Documents
Publishes documents to the repository, where other users can view and retrieve them.

e. Retrieve From Corporate Documents
Retrieves published documents from the repository.

Send to Users
Sends documents to individual users or user groups.

0. Retrieve From Users
Retrieves documents that other users have sent directly to you.

h. Send To Broadcast Agent
Sends the active document to Broadcast Agent for scheduled processing and
distribution.

Retrieve From Broadcast Agent
Retrieves documents that Broadcast Agent has processed and sent to you.

Publish To Channels

Publishes the active document on a channel that the supervisor has set up. Other users
can subscribe o this channel and view up-to-date information over the World Wide
Web.

k. Send to Mail
Sends the active document by e-mail.
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The Visual Basic toolbar

Allows you to assign macros to the five toolbar buttons and then run the macro
simply by clicking on the associated button. See “ Associating a macro to a toolbar
button” on page 191 for an explanation of how to do this.

a. Opens the macros dialog box

Yizual B azic

» | M 32 13 4 K5 b. Butftons 1-5 run the macros that have

been assigned to them

Choosing the way you view documents

This section describes the options you can set to change the way you view your
documents in the report window.
Setting the display size

You can magnify a part of the display in the report window to see it close up, or
reduce the display to see more in the report window.

To change the size of the display:

e (lick the arrow next to the zoom control box on the Standard toolbar and
choose a value from the list.

You can also type a value directly into the zoom control box. You can set values
between 10% and 400%.
Using Page Layout view

In Page Layout view, you can see how elements will be positioned on the printed
page. You can also see the headers, footers and margins of your report.

To switch Page Layout on and off:

* From the View menu, choose Page Layout.

Viewing a document created in BusinessObjects 4.1

BUSINESSOBJECTS 5.1 uses standard Microsoft fonts. BUSINESSOBJECTS 4.1 used
fonts which are slightly different from standard Microsoft fonts.

If you're using documents created in BUSINESSOBJECTS 4.1, you can display and
print data in the fonts used in BUSINESSOBJECTS 4.1 so that your documents retain
the same look.
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To do this:

1. From the Tools menu, choose Options.
The Options dialog box is displayed.

2. Click the General tab.

3. Check the option Print as BusinessObjects 4.1.

Note: When you check or uncheck this option, you may need to minimize and
then maximize the BUSINESSOBJECTS READER document window to see the change
in the display.

Using Outline view

When you have a report in sections with a lot of information in each section, a
convenient way of presenting and viewing the report is to use outline view.
Outline view folds up the sections in the report to display only the high level
information that you've included at the top of each section. You can then open up
the sections you are interested in to get more details. The person who created the
report may have turned on Outline view to make it easier for you to go directly
to the section you are interested in.

To turn outline view on and off:
e From the View menu, choose Outline.

To fold or unfold a section in outline view:
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e (lick the arrow next to the section name.

Ii’ BusinessObjects - Efashion.rep M= 3
@ File Edit “iew Toolz Data Window Help |
BEHISGR[ =R -~ ERa o Sk |

» v >2>3>4>5|
Al AL NS
— ¢ sl
[ Map | i . a
Product Sales by City
Revenue by Region A0 L&
Margin Analysiz th'\o for year 2001
Quartery Variance
=] Product Analysiz Austin sales revenue $1 ,135,479.10
----- @ Austin
..... » Bosh -
..... + Chioags margin $424,790.00
----- @ Colorado Springs
..... s Dallas Boston sales revenue $887,169_20
----- @ Houston
----- @ Loz Angeles margin
..... . $336,574.10
..... @ Mew'York .
_____ o S::Fn:;cisco Chicago sales revenue $1 ,134,085.40
----- * ‘Washington
..... Actual v Budgst margin $439,865.00
Colorado Springs sales revenue $843,584.20 _
TR T _»l_l
LI_’I Fevenue Year 2001 I Fiefrenue by Region I b argin Analysiz I Quarterly Yariance
| Last Evec: 2/23/99 01:53 PM i
Clickheretofold Click the arow The outline bar is
or unfold all to unfold a displayed when you
sections. section. are in Outline view.
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Showing delimiters

Delimiters are non-printing lines as illustrated below. There are four types of
delimiters that you can turn on and off.

iTotal Revenue $3,236,524;—Ce” de.“m”ers diSpbY
section delimiters dispIAY—— — sucsom guarer non-printing dotted lines
a non-|
coction e © - o
Country  Revenue {FY93 197
France 208 565 iFvod 15
s 582 051 | {58 %

To show or hide delimiters:

e From the View menu:

Choose... To show or hide
Cell Delimiters the outline of a cell
Page Margins page margins; you can only turn margin

delimiters on if you are in Page Layout view

Section Delimiters where a section begins and ends

Grid a page grid

InfoView User’s Guide 167



Chapter 7 BusinessObjects Reader - The Basics

Managing Documents

A BUSINESSOBJECTS document contains reports that present your business data, in
tables and charts, for example. A document can contain just one report, or several
reports and a report itself can be broken down into sections.

Navigating through documents

BUSINESSOBJECTS READER has the Report Manager to help you manage and
navigate through the reports in a document. The Report Manager displays a list
of all the reports in the document. When you click on a report in the list, the
selected report is displayed in the Report window. If the report contains sections,
the section names are also displayed and when you click on a section name, the
selected section is displayed in the Report window. This allows you to go quickly
and easily to the part of the document that interests you.

Feport banager

& Data [F] Map |

reports - -
P : Fevenue by region

M argin analysiz

=| Yearly variance
sections — | @ Austin

----- @ Chicago

----- @ Colorado Springs

Ifyou click here, the
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Managing Documents

You can show or hide the Report Manager by clicking the Report Manager button
on the Standard toolbar.

ReportManager  Tjp: When the Report Manager window opens, it is docked on the left-hand side
of your report window. You can undock the Report Manager window and drag
it to any other convenient location on your screen. Hold down the Ctrl key while
moving the Report Manager window to prevent it from docking

You can also switch from one report to another by clicking the tab of the report

2 Margin Analysis I .
— you want to display.

Report Tab
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Opening documents

]

Open

]

Open

In this version of BUSINESSOBJECTS, you can open:
e All documents created in BUSINESSOBJECTS 4.1
e BUSINESSQUERY documents

e  WEBINTELLIGENCE documents.

Restrictions on Weblntelligence and BusinessQuery documents

WEBINTELLIGENCE and BUSINESSQUERY documents that you open in
BUSINESSOBJECTS appear with the standard BUSINESSOBJECTS document template.
Formatting applied in WEBINTELLIGENCE and BUSINESSQUERY is lost.

Opening a document

1. Click the Open button on the Standard toolbar.
The Open dialog box appears.

2. Choose the type of document you want to open from the Files of type list.

3. Locate the document you want to open and click OK.

Tip: BUSINESSOBJECTS keeps track of the last documents opened. These are listed
at the end of the File menu. Just choose the document you want to open from the
list.

Opening several documents at once

Opening several documents at once is useful if you have complex documents that
take a long time to open. You can select all the documents you want to use and
then get on with another task while you are waiting for them all to open.

To do this:

1. Click the Open button on the Standard toolbar.

2. The Open dialog box appears.

3. Choose the type of document you want to open from the Files of type list.

4. Select the documents you want to open using the Shift key to select adjacent
documents and the Ctrl key to select non adjacent documents and click OK.
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Changing default file locations

When you choose Open, the Open Folder dialog box opens by default in the
UserDocs folder in the BUSINESSOBJECTS folder. You can change this setting if you
keep your documents in a different location.

To do this:

1. From the Tools menu, choose Options.
The Options dialog box opens.

2. Click the File Locations tab.

3. Click on the file type in the list and click the Change button.
The Browse for Folder dialog box opens.

4. Locate and open the folder you want to set as the default and click OK.
The new folder and path is displayed in the list.

Options E

Generall Save I Display ~ File Locations | Macrosl

@ *f'ou can select default folders [directories] where pou want to store the files you
@ uze in the application.

| Location |
C:\Program FileghBuziness Objects\BuzinessObjects 5.0Ms...
C:\Program FileghBuziness Objects\BuzinessObjects 5.00 e...

Universes C:\Program Files'Buziness Objects\Bugsinesz0bjects 5.0Vn...
Scripts C:\Program FileghBuziness Objects\BuzinessObjects 5.00c...
Businezstuery Files C:%Program Files\Business Objects\BusinessObjects 5.00s...

LChange... |

QK I Cancel | Help |
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Saving documents

Save

When you have refreshed a document with new, updated data, you need to save
the changes to your document. BUSINESSOBJECTS READER also allows you to save
your document in different formats so that you can use the data in other
applications. This section describes how to do this.

Saving a document

e (lick the Save button on the Standard toolbar, or choose Save from the File
mendu.

Saving a document for all users

If you want to make a document accessible to another user working without a
repository, use the Save As command in the File menu, then check the Save for all
users option in the Save as dialog box.

If you do not do this, users working without a repository will get an error
message saying “You are not authorized to use this document” when they try to
open your document. This is important to bear in mind if you are sending
documents to other users via email, for example.

Saving a document in text or rich text format

When you save a BUSINESSOBJECTS document in text (.txt) or rich text format (.rtf),
only the currently selected report is saved. Graphics are not saved in rich text
format and text documents. To save a document in text or .rtf format:

1. From the File menu, chooses Save As.
The Save As dialog box appears.

2. In the Save as type list box, click:
o “Text file (*.txt)”, or
e “Rich text format (*.rtf)”.

3. Click Save.
BUSINESSOBJECTS makes a copy of the document and saves it in the specified
format. The original document remains on your screen.

Saving a document in HTML format
You can save a BUSINESSOBJECTS READER document in HTML format. To do this:

1. From the File menu, choose Save As HTML.
The Save As dialog box opens.

2. Choose the location where you want to save the file and click Save.
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3. The HTML options dialog box opens where you can specify how you want
your HTML document to be saved. For a full description of the options
available on this dialog box and for advice on preparing HTML documents in
general, see “Setting HTML Options” on page 225.

Saving a document as a BusinessQuery file

BUSINESSQUERY for Excel users build queries on universes in Microsoft Excel. By
saving a document as a BUSINESSQUERY file, you can transfer data obtained in
BUSINESSOBJECTS to BUSINESSQUERY. Then, you can work with the query using the
functionality of both BUSINESSQUERY and Microsoft Excel.

Saving a document as a BUSINESSQUERY file is only possible if all the following
conditions are satisfied:

e The current document contains only one data provider.
* The data provider is a query on a universe.

¢ The query returns only one microcube.
To save a document as a BUSINESSQUERY file:

1. Select the Save As command on the File menu.

2. Move to the folder in which you want to save the document.
Note that the default folder for BUSINESSQUERY files is
C: \ Busi nessObj ect s\ User BQY\ Uni ver seNane, where Uni ver seNane
corresponds to the universe on which the query was built.

3. Select BusinessQuery files (*.bqy) in the Save as type box.

4. If you wish, type a different name in the File name box, then click OK.
Otherwise, simply click OK.

Note: For information on working with the query in BUSINESSQUERY, refer to the
BusinessQuery User’s Guide.

If you have opened a BUSINESSQUERY document in BUSINESSOBJECTS, you can
save it as a BUSINESSQUERY document or as a BUSINESSOBJECTS document.

When you click Save, BUSINESSOBJECTS prompts you to save the document as a
BUSINESSOBJECTS document. To save the document in BUSINESSQUERY format,
refer to “Saving a document as a BusinessQuery file” on page 173.

Whether you save the document in BUSINESSQUERY or BUSINESSOBJECTS format,
you will be able to continue to work with it in both applications.
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Original
BusinessObjects
document

Saving a document in PDF format

BUSINESSOBJECTS 5.1 allows you to save BUSINESSOBJECTS documents in Adobe
Portable Document Format (PDF). All users need to view and print PDF
documents is the free Adobe Acrobat Reader. When you open a BUSINESSOBJECTS
document saved in PDF format, you can view and navigate through different
reports and obtain high quality printed copies. You cannot edit or analyze the
data. To save a BUSINESSOBJECTS document in PDF format:

1. From the File menu, choose Save As.
The Save As dialog box appears.

2. In the Save as type list box, choose Portable Document Format(*.pdf)

3. Click Save.

BUSINESSOBJECTS makes a copy of the document and saves it in PDF format.
The original document remains on your screen. BUSINESSOBJECTS makes a
copy of the document and saves it in PDF format. The original document
remains on your screen. The illustrations below show the same document in
its original BUSINESSOBJECTS format and after saving in PDF format.

R BusinessObjects - Efashion_rep - [janis@casa]

JJ@ File Edit “iew Inset Format Tools Data Analpsiz Window Help

& Data [F] Map |

]

Product Sales by City

----- Revenue Year 2001 S0 S O for jear 2001
=] Revenue by Region <. S'h"-c
=] Margin Analysis
: ) i I
..... Quarterly Variance Austin palen T vae $1,135,479.10
E-[E] Product Analysis f—
----- ® Austin $424.790.00
----- @ Boston
----- @ Chicago
----- @ Colorado Springs
----- @ Dallas ACcessoties 174 $3,919.00 §27 95860
""" @ Houston City Skirts 6 $68E.20 $1,532.30
""" @ Loséngeles City Trousers 25 $120.50 $2,576.00
""" @ Miami Dresses 177 $9,002.20 §25,029.00
""" @ Mew'ork Jackets B §4,252 60 $10,739.00
""" ® SanFrancisco Leather 11 497 50 $1,790.00
----- * ‘Washington 1 - —
. Cuterwear ] -§47.00 F566.00
----- Actual v Budget
Cwercoats 20 28380 §2,567.20
Shirt Waist 211 $13,605.50 §37,394.70
Swwesters 200 §i5,500.20 §28,009.90
Swweat-T-Shitts 957 §70,142.60 $171,019.50
Trousers 29 §1,603.50 §5,247 60
a1 Sum: 1,891 $117,872.20 $314,429.30| +
(KN »
o u% C Uﬁ LI_’I Fevenue Year 2001 I Revenue by Region I I argin Analysiz I Quarterly Yariance

| Last Exec: 2/23/99 01:53 PM

N I 7
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Note how the navigation outline is retained in the pdf document making it easy
to navigate quickly through reports and report sections.

view a report.

Click here to go
to asectionina
report,

Adobe Acrobat - [Efashion_pdf] M= 3
'E File Edit Document Toolz ‘iew ‘window Help = |ﬁ'|1|
Me@HSE K>« O OE 6&REO
ﬁ [ Bookmarks » ﬂ
& [[] Revenue Yearz0m = A ‘ _ o
e E‘D Revenue by Region @ Product Sales by City
T & |
T
E
Vi [[] Margin Analysis
cf/éb D Guarterly Variance ﬁ:kw"m’ _|
4= o[ Product Analysis o e
a| Tomm
%] ...... j Baston 01 |L.’mlarm
wl (] chicago Cherass
T (] Colorado Springs ot okt |
= [ Dallas CRET
&l (] Houstan G e
------ [ Los Angeles
E ------ [ tiami i
------ (] Mew York T
------ (] 5an Francisco - pe— .
------ [ washington -  Exr— S I TR
| Swoabers $37,515.40)
[ Actual v Budget Suvect T80
Trousars
. .|
e MEelelE =

Saving Weblntelligence documents

If you have opened a WEBINTELLIGENCE document in BUSINESSOBJECTS, you
cannot save it as a WEBINTELLIGENCE document. You can only save it as a
BUSINESSOBJECTS document, i.e., a .rep file.

Once you have saved the document, you can send, publish and schedule the
document, but only as a BUSINESSOBJECTS document, not as a WEBINTELLIGENCE
document. If you want to send, publish and schedule the document as a
WEBINTELLIGENCE document, you must use INFOVIEW in your Web browser, as
described in part 1 of this guide.
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Copying and pasting data into another application

You can copy data from a BUSINESSOBJECTS document and paste it into a
Microsoft Office application such as Excel or Word. You can paste data either as
images, for presentation purposes, for example; or as text so that you can work
on the data further in the target application. The table below summarizes how
you can copy and paste different types of report components:

If you copy a report with....

You can...

Tables, crosstabs and cells

Paste the data in them as an image or as text

Charts and images

Paste them as images

Example Copying data from BUsINESSOBJECTS to Microsoft Excel

The following example shows how to copy data from BUSINESSOBJECTS to Excel:

1. From the Edit menu, choose Copy All.
BUSINESSOBJECTS copies the contents of the currently active report to the

clipboard.

2. Open the Microsoft Excel workbook where you want to paste your data.

3. From the Edit menu, choose Paste Special.

4. Choose how you want to paste the data.

Choose... To....

Text Copy the clipboard contents as data that you can then work on
in the target application.

Picture Copy the clipboard contents as a Picture image. For example,
a BUSINESSOBJECTS table is copied as an image and you will not
be able to work on the data in the target application. This is the
recommended format for pasting images.

Bitmap Copy the clipboard contents as a Bitmap image. If you choose
to paste a Bitmap image, bear in mind that this format can take
up a lot of memory and disk space.

The data is pasted into the Excel workbook.
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Using Personal Document folders

Retrieving a

&

Retrieve form
Personal Documents

The Personal Documents folder is reserved storage space on the BUSINESSOBJECTS
web server where you can save documents for your personal use. Only you can
use this folder. You will only have access to Personal Documents if you connect
to BUSINESSOBJECTS via a web connection.

To help you organize and find your documents more easily, you can use
categories. The categories you use here are personal categories and you are the
only person who can create, delete and modify them.

You can view the documents saved in Personal Documents list either from
BUSINESSOBJECTS or from INFOVIEW.

Note: For information on viewing personal document lists in INFOVIEW, see “The
Personal Documents Page” on page 45 of this InfoView User’s Guide.

personal document

If you are connected to a BUSINESSOBJECTS web connection, you can retrieve
documents you have saved in your personal documents folder on the web server.

To retrieve a document saved in your personal documents folder:

1. From the File menu, choose Retrieve From /Personal Documents.
The Retrieve Personal Document dialog box opens.

Retrieve Personal Document E

Only show categories: S =Al Categories= |v|

Mame | Type | Modified | Size | Categories -
@ Efashion.rep Bugin.. 2ABA051723PM 1740 Sales
@ Margin analysi... Busin 2AB/005:28:47 P 830KE  Sales

P
2AB/00 52715 PM
21B/00 5:18:22 PM
21B/00 5:30:27 PM

4E.0KE
57.5KB
174.0..
130.0..

Marketing
Trends
Sales

Trends T
| B

iProduct line.rep
@ Regional rend...
@ Sales analysis....
ey growith...
1

Busin..

Busin...
Busin...

File name: IProduct line.rep DOpen I
Files of type: IBusinessDbiects Documents [*.rep] j Cancel |

™ Open as read-only
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2. Select the file you want to open from the list and click Open.
You can only retrieve one file at a time.
A copy of the document is downloaded to your computer and opened.

Note: When you open a BUSINESSOBJECTS document from Personal Documents,
BUSINESSOBJECTS copies the document locally. If you work on this document, save
itin Personal Documents and then retrieve the same document during a different
work session, BUSINESSOBJECTS displays the following message to tell you that
you already have a document with the same name on your computer:

BuzinessObjects E

@ The file ‘Margin analyziz.rep’ already exists locally. Do you want to retrieve it anpway, and ovenarite your local version 7

Mo | Cancel |

If you know that you saved the latest copy of this document in Personal
Documents, you can quite safely overwrite the local copy.

Using categories to find personal documents

Documents can be assigned to filtering mechanisms called categories. Categories
help you sort and find documents in your personal documents list by filtering the
list to display only documents belonging to the selected category.

To filter the document list by category:

1. Click the arrow to the right of the All Categories button.
The Categories box opens. If you haven’t created any categories, this list has
one entry only, <No Category>.
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2. Select one or more categories from the list.
Use the Shift and Control keys to make multiple selections. If you select <No
Category>, BUSINESSOBJECTS filters the personal document list to display
those documents to which no category has been assigned.

Retrieve Personal Document E

Only show categories: | S Select fitering categories |v

[Nove —— TTwpe .

oo | v— |o0—

@ Efashion.rep Busin o= |v—|a=
Margin analyzi... Busin o Categome!
@ Product line.rep  Busin
@ Regional trend... Busin | ¢ gas
Sales analysiz... Busin | Trends
™Y early growth.... Busin
4

File name: rep

Files of type: I Eusine k. I Cancel

™ Open as read-only

3. Click OK.
The list is filtered to display only the documents assigned to the selected
category or categories.

Retrieve Personal Document E

Only show categories: | 5 Sales j

Mame | Type | Modified | Size | Categories
@ Efashion.rep Bugin.. 2ABA051723PM 1740 Sales
@ Margin analysi.. Busin.. 2/6/00528:47 PM  83.0KE  Sales
@ Sales analysis... Busin.. 2A6/00518:22PM 1740, Sales

< | ¥
File name: I".rep DOpen I
Files of type: IBusinessDbiects Documents [*.rep] j Cancel |

™ Open as read-only
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Saving a document in your Personal Documents folder

You can send a document to your personal documents folder if you are connected
@ to a BUSINESSOBJECTS web connection.

To save a document in your personal documents folder:
Send to Personal

D t .
ocuments 1. From the File menu, choose Send to/Personal Documents.

The Send Personal Document dialog box opens:

Send Personal Document [ %]
Mame | Type | Modified | Size | Categories -

@ Efashion.rep Bugin.. 2ABA051723PM 1740 Sales

@ Margin analysi.. Busin.. 2/6/00528:47 PM  83.0KE  Sales

@ Product line.rep  Busin..  2A6/005:25:18PM  46.0KB  Marketing
@ Regional rend... Busin.. 2A6/005:2718PM  B75KE  Trends
@ Sales analysis... Busin.. 2A6/00518:22PM 1740, Sales
ﬁ?Yearlv growth.... Busin..  2/16/00 5:30:27 PM 130.0... Trendsl _ILI
4 3

File name: IDain pozition.rep I&I
Save as type: IBusinessDbiects Document [*.rep] j Cancel |
Categories: |<Keep existing categories= j Options. .. |

™ Save for all users

2. Type a name for the document in the “File name” box.

3. In the Save as type list box, choose the format. Choices are:
* BusinessObjects Documents (*.rep),
e Portable Document Format (*.pdf),
¢ Rich Text Format (*.rtf),
e Text Files (*.txt),
* BusinessObjects Templates (*.ret),
* BusinessQuery Files (*.bqy).
* BusinessObjects Add-ins (*.rea)

4. Assign a category to the document if you wish.
5. Click Save.

The document is saved in your personal documents folder on the web server.

Deleting documents from your Personal Documents folder

If you want to delete documents from Personal Documents, you have to use the
personal document list in INFOVIEW. For information on viewing the personal
document list in INFOVIEW and deleting documents from it, see “Deleting
Documents” on page 117 of this InfoView User’s Guide.
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Assigning categories to a document

You assign categories to a document when you save it. When you are save a
document to which you’ve already assigned categories, BUSINESSOBJECTS
displays <Keep existing categories> in the Categories box and saves the
document with these categories unless you make any changes. To assign a
category:

1. Click the arrow to the right of the Categories box.
The Categories box opens.

Send Personal Document [ %]
Mame | Type | Modified | Size | Categories -

@ Efashion.rep Bugin.. 2ABA051723PM 1740 Sales

@ Margin analysi.. Busin.. 2/6/00528:47 PM  83.0KE  Sales

@ Product line.rep  Busin..  2A6/005:25:18PM  46.0KB  Marketing
@ Regional rend... Busin.. 2A6/005:2718PM  B75KE  Trends
@ Sales analysis... Busin.. 2A6/00518:22PM 1740, Sales
ﬁ?Yearlv growth.... Busin..  2/16/00 5:30:27 PM 130.0... Trendsl _ILI
4 3

File name: IDain pozition.rep Save |
Save as type: IBusinessDbiects Document [*.rep] j Cancel |

Categories: |Set categories for the document |v Options. .. |

™ Save for allus =|:;: g:l ﬁl@lahll

()8 I Cancel |

2. Check the categories you want to assign to the document and uncheck any
you wish to remove and click OK.
The selected categories are displayed in the Categories box.

3. Click Save to save the document with the assigned categories.

Creating a new personal category

You manage the categories assigned to your personal documents. You can
created, delete and rename categories according to your personal needs. To create
anew category:

1. Click the arrow to the right of the Categories box.
The Categories box opens.
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2. Click the Add Category button.

s

Add Category a Displays only the selected
category
b Check all categories
¢ Uncheck all categories
d Add new category
e Delete the selected category
0K | Cancel | f Rename the selected category
3. Type in the name for the category in the newly created box.
[[] Marketing
[ Sales
[ Trends
o]
| ak. I | Cancel I
Renaming a personal category
Select the category you want to rename.
3h|| 1. Click the Rename button.

Rename Category 5 Type in the modifications.

@l Deleting a personal category
1. Select the category you want to delete.

Delete Category
2. Click the Delete button.
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Refreshing BusinessObjects Documents

A document generated at a given point in time reflects the data as it existed at that
time, but it may be inaccurate now. In BUSINESSOBJECTS, you can update the data
in a document while keeping the same presentation and formatting. When you
update a document, BUSINESSOBJECTS reconnects to the database or file, and
retrieves the updated data. This is called refreshing a document.

Refreshing a document ensures that the data is kept up-to-date with changes in
the database or personal data file.

Different ways of refreshing a document

BUSINESSOBJECTS allows you to refresh documents in the following ways:
* Manually
* Automatically at specific times or intervals

* By sending the document to BROADCAST AGENT, the BUSINESSOBJECTS product
that manages the scheduled processing of documents

e Every time you open a document.

Before refreshing documents

When you refresh a document, you refresh the data provider(s) contained in the
document. The data provider is the data source; this can be a database query or a
personal data file, for example. A document may contain just one data provider,
or many data providers, from the same or from different sources.

Note: For information on linking data providers using the Link To button, see the
BusinessObjects User’s Guide.

The user who created a document can specify whether or not the document's data
provider(s) can be refreshed. Before trying to refresh a data provider, check that
the Refreshable option has been set.
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To do this:

1. From the Data menu, choose View Data.

Make sure this
option is
checked.

The Data Manager dialog box opens.

[rata Providers Fesults  Definition |

— General ™ Automatic Refresh
Marme: " Every & Once
Im IDn Date, at Time VI
I ax Duration: 5]
Mar # Rows: gonpg || Erom Date (m/d/by)

02704799 =
[+ Befreshable Time [hh:mm:ssh &k /P)
Univerze: 02:00:41 PM ﬂ
IEfashion J
Date | Time | # Fows | Du;l
2/23/93 01:53:11 PM 482 BB'J
2/17/93 05:29:46 PM 8374 1
2/17/93 05:25:30 PM 3535 56>
| | »
QK I Cancel | Help |

2. Click the Definition tab.

3. InData Providers box, select the data provider you want to check on and make
sure the Refreshable option is checked.
If this option is not checked, you cannot refresh the selected data provider.
Only the creator of the document or your BUSINESSOBJECTS supervisor can
change this setting.

Before refreshing data providers, you should also check that:

e The most up-to-date data is the data you want.

* Refreshing the data provider will not block the server (database).
* Refreshing the data provider will not block your computer.

Some databases support asynchronous mode, which enables you to refresh a data
provider without blocking your computer. If the database at your site does not
support asynchronous mode, you can avoid blocking your computer by
specifying off-peak times for refreshing data providers.

Your IS department, the universe designer and/or the supervisor should be able
to advise you on these points.
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Manually refreshing a document

= To update the data in a document:
e (lick the Refresh button on the toolbar.

Refresh
BUSINESSOBJECTS refreshes all the data providers in your document.

Refreshing a document with more than one data provider

If your document contains more than one data provider, you can choose which
data provider you want to refresh. For example, you may have a document that
contains data from a database and data from a personal data file and you only
want to refresh the data from the database.

To do this:

1. From the Data menu, choose View Data.
The Data Manager dialog box opens.

2. Click the Results tab.

i Results | Definition
L . D ata Provid e

This is the list of 28 TroveErE l I

data providers

contained in - l - o=

the document. Elt}l. Sales revenue Guantity sald Qj
Austin 279586 174 0
Austin 18323 6 0
Austin 2876 25 0
Austin 28029 177 0
Austin 10739 BE O
Austin 17490 1mQ
Austin 5E6 50
Austin 2867.2 20 04
Austin 373547 211 0
Austin 1710195 967 0
Austin 28009.9 200 0
Austin 52476 23 0
Austin 474354 293 0
[« _>l_I

Optiong... | Befresh | Purge |
QK I Cancel | Help |

3. Select the data provider you want to refresh in the Data Providers list.

4. Click the Refresh button.

InfoView User’s Guide 185



Chapter 7 BusinessObjects Reader - The Basics

Refreshing a document with a prompt

When you refresh a document with a prompt, you are asked to choose which data
you want to display in your document, before the document can be refreshed.
This allows you to focus your analysis on a specified data set, a particular year or
a particular product line, for example. If a document has been set up with a
prompt, BUSINESSOBJECTS shows a dialog box when you click the Refresh button.
The way a prompt dialog looks depends on how the person who created the
document set it up.

In the example below, the custom prompt dialog box asks you to choose a
product line before refreshing the document.

Choose Product E

Choose a Produck Line:
Display |

i Acr
Ciky
City Trousers
Dresses
Jackets
Leather

Cuterwear
Cwercoats
Shirt ' aisk
Sweat-T-Shirts 7|

Automatically refreshing a document

There are a number of options you can set to refresh your documents on a regular
basis or at a set time.

Automatically refresh data providers on opening a document

You can set BUSINESSOBJECTS to automatically refresh all data providers in a
document each time you open it. To do this:

1. Make sure the document is open.

2. From the Tools menu, choose Options.
The Options dialog box opens up.

3. Click the Save tab.
4. Check Refresh Document When Opening, then click OK.
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provider from
this list

Refreshing BusinessObjects Documents

Refresh a data provider once at a set time

If you know the database is to be updated at a certain time on a given date, you
can specify that your data provider(s) be automatically refreshed at this point in
time. To do this:

1. From the Data menu, choose View Data.
The Data Manager dialog box opens.

2. Click the Definition tab.

Fesults  Definition |
— General ™ Automatic Refresh
MHame: ' Exery & Once
Im IDn Date, at Time VI
Max Duration: g Set automatic
Max # Rows: googg || Evom Date m/d/y]) refresh options
02704799 = here
[+ Befreshable Time [hh:mm:ssh &k /P)
Uni : 00- = |
NivErge: 02:00:41 PM
IEfashion J
Date | Time | # Fows | Du;l
2/23/93 01:53:11 PM 482 SB'J
2/17/93 05:29:46 PM 8374 1
2/17/93 05:25:30 PM 3535 56>
| | »
QK I Cancel | Help |

3. In Data Providers box, select the data provider you want to work on.
4. Check Automatic Refresh then Once.

5. Select an option from the list box:
e  On date, at time
Use this option to refresh the data provider at a given time on a given day.
*  On date, from time
Use this option to refresh the data provider after a given time on a set day.

6. Select a date and a time from the respective list boxes, then click OK.

Regularly refresh a data provider

If you know the database is updated every day at a certain time, for example,
midnight, you can specify that your data provider(s) be automatically refreshed
at la.m. every day.
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To do this:

1.

4.

Follow Step 1 to Step 3 in the procedure “Refresh a data provider once at a set
time” on page 187.

Check Automatic Refresh, then Every.

. Set the intervals at which you want to refresh the data provider by entering a

value in the box, and selecting Hour(s) or Minute(s) from the list box.

Select the start date and time in the From Date and Time boxes, then click OK.

Setting options before refreshing a query

If the data provider you want to refresh is a query on a BUSINESSOBJECTS universe,
you can set options that enable you to:

Specify the number of rows of data that you want the query to return. The
Default Value option corresponds to the maximum number of rows that the
universe designer specified for queries on the current universe.

Eliminate duplicate rows of data. This feature is useful if you think that the
query will return many rows containing the same data.

Delete trailing blanks. Trailing blanks are spaces that appear at the end of
rows of data. They can occur, for example, if the database has been set up with
a fixed number of characters per row. This option ensures that trailing blanks
do not appear in the query result.

To set query options, then refresh a document:

1.

From the View menu, choose Data Manager.
The Data Manager dialog box opens.

Click the Results tab.

Select the query you want to refresh in the Data Providers list.
A query on a BUSINESSOBJECTS universe is identified by the query icon in the
Data Providers list.

This icon shows that
the data provider
source is a
BusinessObjects query

[rata Providers
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4. Click the Options button.
The Query Options dialog box appears.

Query Options [ %]
Ro Partial Results
“f'our query can return duplicate rows. % Default Value
Do you want: =
10 Rows
&0 20 Rows
' No Duplicate Rows ' Other

™ Do Not Retrieve Data

™ Delete Trailing Blanks 0k I Cancel | Help |

5. Click No Duplicate Rows if you want to eliminate duplicate rows of data from
the query result.

6. To obtain a partial result, you can:
e C(Click 10 rows or 20 rows.
¢ Enter a number of rows in the Other field. You can use the arrows to raise
or lower the value.

7. Click OK to return to the Data Manager.
8. Click the Refresh button.

Emptying data from a document

You can empty the data from a document to make it smaller so it’s easier to send
to other users, for example. This is called purging. Purging the data provider
keeps its components (the objects, conditions and sorts, for example), but deletes
the data retrieved. You can refresh the data provider at any time when you want
to retrieve the results again.

To purge a data provider:

1. From the View menu, choose Data Manager.
The Data Manager dialog box opens.

2. Click the Results tab.
3. Select the data provider you want to purge.

4. Click the Purge button.
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Using Add-Ins and Macros

Add-ins are programs that add optional commands and features to
BUSINESSOBJECTS. Add-ins have the .rea extension to the file name.

Macros are used to automate tasks that you need to perform frequently. A macro
is a series of commands and functions that are stored in a Visual Basic module
and can be run whenever you need to perform a task. Macros are created and
stored inside BUSINESSOBJECTS documents (.rep files) or BUSINESSOBJECTS add-ins
(.rea files).

You can send and retrieve add-ins (.rea files) in the same way you can send and
retrieve BUSINESSOBJECTS documents.

This section explains how to install and run macros and add-ins.

Note: Depending on how BUSINESSOBJECTS has been set up in your company, you
may not have access to the menus and toolbars described in this section.

Running a macro

You can run macros either from the Macros dialog box or from the Visual Basic
toolbar if macros have been assigned to the macro buttons.

To run a macro from the Macros dialog box:

1. From the Tools menu, choose Macro.
The Macros dialog box opens.

o Macro Mame:
This is the Hun
name ofthe m— = e
macro ApplyBMinerFilter.real ThisDocument &) —
Ste |t |
Exdit |
[Ereate |
The person who [UefEte |
ay inolude neroon | Masesin - [aaasa N o
explanation of what - Description ;
the macro does — | re-uses the zegment filkers
' Help |
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2. From the Macros in: list box, choose the documents where the macros are
stored. You can display the macros available in the active document, all
macros in all open documents, macros in a selected open document or macros
in add-ins.

Active Document j
All Open Documents
|40l Add-ns

Jocument

zales analysis.rep

The macros stored in the selected document(s) are displayed in the Macro
Name list.

3. Select the name of the macro you want to use and click Run.

Associating a macro to a toolbar button

You can also run macros from the Visual Basic toolbar by assigning a macro to a
toolbar button. To associate a macro to a toolbar button:

1. From the Tools menu, choose Options.
The Options dialog box opens.

2. Click the Macro tab.

Options E

Generall Save I Displayl File Locations  Macros |

In this tab, you can select the macrozs pou want to run from the toolbar, and type a .
<§ tacltp for each toolbar button. Click here to
open the

Macros dialog

Macro Mame | Tooltip

W i | L box
rz] ]
ra] ]
C4] ]
rs] ]

QK I Cancel | Help |

3. Click check box 1 to activate the first button on the Visual Basic toolbar.
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4. Click the button to the right of the Macro Name box.
The Macros dialog box opens.

5. Click on the macro you want to use from the list and click the Select button.
The name of the macro is displayed in the Macro Name box.

6. In the Tooltip box, type the tooltip that you want to use for the macro.
The tooltip appears when you rest the cursor over the button on the Visual
Basic toolbar.

7. Click OK.
You can now run the macro by clicking the toolbar button.

Installing an add-in

Before you can use an add-in, you must install it on your computer and then load
it in BUSINESSOBJECTS. Add-ins (*.rea files) are installed by default in the
UserDocs folder in the BUSINESSOBJECTS folder. Loading an add-in makes the
feature available in BUSINESSOBJECTS and adds any associated commands to the
appropriate menus.

Unloading an add-in removes its features and commands from BUSINESSOBJECTS,
but the add-in program remains on your computer so you can easily load it again.

To install an add-in:

1. From the Tools menu, choose Add-Ins.
The Add-Ins dialog box opens.

Add-Ins ]
The check mark shows .
that this add-in has been Adttins avalzble: oK |

installed M ApplyBMinerFilter

[ Joutlook ﬂl
No check mark shows ThoT/
this add-in is on the Help |

computer but not
installed

— outlook:

192 InfoView User’s Guide



Using Add-Ins and Macros

2. Click the Browse button to locate and open the add-ins on your computer.
The Add-Ins Available box displays the list of available add-ins. There are two
types of add-ins that you may see in this dialog box: those that are available
and those that have been installed. You cannot use an add-in until it has been
installed.

3. Click the check box next to the name of the add-in and click OK.
The add-in is installed and can now be used.

Note: When a user installs an add-in, it is only installed for that user. If that user
logs on under a different name, the add-in will not be available.

Running an add-in

You can run an installed add-in from the Macros dialog box, or you can associate
it with a button on the Visual Basic toolbar.

Uninstalling an add-in

1. Click the check box next to the add-in name in the Add-Ins dialog box to
remove the check mark

2. Click OK.
The add-in features and commands are removed from BUSINESSOBJECTS, but
the add-in program remains on your computer so you can easily load it again
if you want to use it.
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Overview

196

BUSINESSOBJECTS and INFOVIEW users share information by publishing and
sending documents. These documents contain the information you need to make
decisions about your business. They are available on the repository, the
BUSINESSOBJECTS central information storage mechanism.

You gain access to this information by viewing and retrieving the documents that
other users have sent or published. You view the list of documents on the
repository by using the Retrieve From commands in BUSINESSOBJECTS (File
menu), then open and/or save the documents that you need. So, retrieving
documents means copying them from the repository to your computer.

The same workflow applies for BROADCAST AGENT: when other users publish
information by scheduling documents with BROADCAST AGENT, you access that
information by retrieving the documents from the repository.

Once you have retrieved documents, you can refresh, print and save them in
BUSINESSOBJECTS. If you have installed BUSINESSOBJECTS REPORTER on your
computer, you can also reformat documents to make the information they
contain as immediate accessible to you as possible.

You can also retrieve:

e  WEBINTELLIGENCE documents

* BUSINESSOBJECTS templates

e BUSINESSQUERY files

e BUSINESSOBJECTS add-ins

e Scripts (.sbx and .spt files) from BUSINESSOBJECTS 4.1
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Retrieving Published Documents

Retrieving documents in BUSINESSOBJECTS is simple. Start by clicking the
Toolbars command on the View menu to display the Document Exchange
toolbar:

Document Exchange

R RN " R < AR R

a b c d

a. Find Documents

Displays the list of published documents, and lefs you run a document search based on criteria that
you set.

b. Retrieve From Corporate Documents

Retrieves published documents from the repository.

C. Retrieve From Users

Retrieves documents that other users have sent to you.

d. Retrieve From Broadcast Agent

Retrieves documents that Broadcast Agent has processed and sent to you.

Which toolbar button should you use?

2
Retrieve from
Broadcast Agent

If you've received notification that you have documents to retrieve from
BROADCAST AGENT, click the Retrieve from Broadcast Agent button. If you want
to check for published corporate documents, click Retrieve from Corporate
Documents, and so on.

If you get the following message when you click one of the Retrieve from toolbar
buttons, you have no documents of the type you chose to retrieve.

Information E

@ “r'ou have no documents ta retrieve.

For example, if you click the Retrieve from Broadcast Agent button but have
received no documents from BROADCAST AGENT, this message appears. This
doesn’t necessarily mean that you have no other documents from other users, or
published corporate documents to retrieve.
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How do you know when you have documents to retrieve?

198

You can set an option that displays a notification message when you start
BUSINESSOBJECTS:

Motification E

E_EI: ‘ou have received 1 document(s) from users).

Help |

To set BUSINESSOBJECTS to display a notification message on start-up:

1. Select the Options command on the Tools menu.
The Options dialog box appears.

2. Click the General tab.
3. Check Notify Document Reception:

St

[+ Motify Document Reception

™ Beopen Last Open Documents %

4. Click OK.

From now on, if you have documents to retrieve when you start BUSINESSOBJECTS,
the Notification dialog box appears.

Note: This notification message does not appear when you connect to
BUSINESSOBJECTS using a web connection.

Note: The Notification dialog box specifies whether you've received documents
from users or from BROADCAST AGENT.

BUSINESSOBJECTS does not notify you, however, when users have published
documents to the repository using the Publish To>Corporate Documents
command.
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Not sure where to start? Try the Find button

The Find button on the Document Exchange toolbar lets you choose the type of
@ document that you want to retrieve. You can also narrow down your search with
parameters such as data source. For more information, see “Using search criteria

Find Documents  to find published documents” on page 203.

To retrieve documents

Here’s how to retrieve documents from the repository:

1. On the Document Exchange toolbar, click the button corresponding to the
type of document you want to retrieve:

ERREEEE

‘ Retrieve from Broadcast Agent
Retrieve from Users

Retrieve from Corporate Document

J

The Retrieve dialog box appears. A list of documents appears in the Name

column:
“r'ou use thiz dialog box to retieve documents that other users have sent you. Right-click on document(s] for additional
== commands
I Show anly this categary of documents: |<N0 Categony: j
The list of Mame | Categories | Owner | Submizzion D... | Size | Type | Damain |
documents that ﬁ. Annual.rep Jack 9416/98 09:3.. 122368 User document Document
you can retrieve 7P Bamdemo.rep Jack 9/16/980%:3.. 51712 Uszer document Document
appears here Jack 9/16/33 033, 70043 User docurnent Documnert
7P Mdetail rep Jack 9/16/98 09:3... 43520 Uszer document Document
T Revenue.iep Jack 9/16/98 0%:3... 79360 Uszer document Document
¥ Open on Fetrisval Properties... | Retrieve I Delete... Mores» LClose Help

Tip: To filter the list of documents, select a category in the list box next to Show only
this category of documents.
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200

Example

2. Toretrieve a single document, double-click its name in the list. To retrieve
several documents, hold down the Ctrl key on your keyboard, then click each
document you want to retrieve.

3. Click Retrieve.
* BUSINESSOBJECTS imports the documents from the repository to the
UserDocs folder on your computer.
*  When the documents have been successfully retrieved, BUSINESSOBJECTS
displays the following confirmation message:

Import results E

@ Import was successful.

Wetaess |

* The retrieval of documents sent directly by users removes them from the
repository. This is not the case for published documents, which only the
BUSINESSOBJECTS supervisor can remove.

Can you view and retrieve documents that arrive as you work?

Yes and no. Whether you can view and retrieve documents that arrive as you
work depends on your user profile, set by your BUSINESSOBJECTS supervisor.
Here is an example that illustrates this point.

Viewing a document as soon as it arrives in the repository

At 9 a.m., you launch BUSINESSOBJECTS and enter your user name and password.
This means that you are connected to the repository.

At 9.15 a.m., one of your colleagues then sends you a document using Send
To>Users (or Publish To>Corporate Documents). In the Retrieve dialog box, you
may or may not be able to access this document right away:

* The document appears in the Retrieve dialog box, provided that the
BUSINESSOBJECTS supervisor declared you as a “real-time” user.

e If you are not a real-time user, you have to log in to BUSINESSOBJECTS again to
view the document. To do this:

1. Select Login As on the Tools menu.

2. Enter your user name and password, then click OK.
BUSINESSOBJECTS updates the information in the repository.
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3. Select Retrieve From>Users (or Retrieve From>Corporate Documents,
depending on the command used to send the document).
The document that was sent since the first time you logged on is now visible.

4. Follow “To retrieve documents” on page 199 to retrieve the document.

Ask your supervisor to change your user profile to real-time if you need to view
documents as they arrive in the repository.

Note: If you are connected to BUSINESSOBJECTS using a web connection, you will
not be notified that new documents have arrived even if you are a real-time user.

What else can you do when retrieving documents?

The Retrieve dialog box lets you do more than just retrieve documents. What if
you want to view only one category of documents, such as Sales? Display the list
of documents by submission date, or check a document’s data source? Here’s

what you can do:

To...

Do this...

Filter documents
by category

Click Show only this category of documents, then select the
category from the list box.

Sort the list of
documents

Click a column heading. For example, to view documents
in the order in which they were sent, click the Submission
Date column heading.

Set the orderin 1. Right-click any document.
which categories
appear 2. Select Sort Categories on the pop-up menu.
3. Define the order of the categories in the dialog box that
appears.
Delete 1. Hold down the Ctrl key and click each document you
documents want to delete.
2. Click the Delete button.

If the Delete button is grayed, the supervisor hasn’t
granted you the right to delete documents from the
repository.
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To...

Do this...

View document
properties

Click a document, then click Properties. In the Document
Properties dialog box that appears, you can view the
information such as the last time the document was
refreshed.

All the properties that you can view are listed below. Note
that this information is read-only; you cannot change it in
any way.

In the Data Provider tab, you can find out:

e The document’s owner and size

* The date it was last published or printed

e The categories assigned to the document

* How many data providers the document contains

e The document’s data sources

e The date and time the owner created the document

e The number of rows of data returned the last time the
document was refreshed

*  Whether or not a partial result was returned

* How long the last refresh took.

In the Document tab, you can find out the document’s
title, subject, keywords and comments.

The person who created the document has to enter this
information by using the Properties command on the File
menu. So, the Document tab may be blank.

Retrieve
documentsintoa
folder other than
UserDocs

1. Hold down the Ctrl key and click each document.
2. Press the right-mouse button, then select the Retrieve
Into command on the pop-up menu:
Retrieve
Delete. .

Froperties...

Sort Categories

3. Specify the path to the folder in the dialog box that
appears, then click OK.
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To... Do this...

Use search 1. Click the More>> button.

criteria to find

documents 2. Use the options described on page 205 to define your
search criteria.

Retrieve then 1. Check Open on Retrieval.

open documents

in BUSINESSOBJECTS | 2. Select your documents, then click Retrieve.

BUSINESSOBJECTS imports the documents from the
repository to your computer (UserDocs folder), and

displays them.

Using search criteria to find published documents

In organizations that deal with hundreds or even thousands of documents, you
can spend a lot of time finding the documents you need. You may want to find
documents containing data from a specific data source, but how do you know

which documents these are?

BUSINESSOBJECTS provides a Find feature which lets you search for documents by:

¢ Type,i.e., documents that other users have sent, that other users have
published, or that BROADCAST AGENT has processed and distributed via the

repository.

* Other information, such as creation date, data source, size, and category.

Tip: At any point during a search, you can click New Search to start over.

InfoView User’s Guide 203



Chapter 8 Viewing and Retrieving Published Documents in BusinessObjects

To use search criteria to find documents in the repository:

N
J 1. Click the Find Documents button on the Document Exchange toolbar.
Find Documents The Find Documents dialog box appears, empty for now.

Find documents E

*r'ou use this dialog box to search for documents. Right-click on document(z] for additional commands

= | Shawanly s cateqan of decumetts: |<N0 Categony: j
Mame | Categories | Clwrier | Submission D| Size | Type | [omain |

~ Find documents

Look far:

in I <&l Domaing: j

Where: | <Mo propertys j I j I _I'
Find Mow I Mew Search

I | SperiornFetisya Stiritites. | Hefieyve | [ielete.. | Less<< | LClose | Help |
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2. Inthe Look for list box, select the type of document you want to find. Available
types are described in the following table:

Select...

To display...

<All documents>

Documents that other users have sent or published, or
that BROADCAST AGENT has processed, plus:

ReportScript scripts from BUSINESSOBJECTS 4.1
(.spt and .sbx files)

VBA macros

Queries from BUSINESSQUERY that you can open in
BUSINESSOBJECTS

WEBINTELLIGENCE documents that you can open
in BUSINESSOBJECTS

BUSINESSOBJECTS templates (extension .ret).

Corporate Documents that users have published to the

documents repository using the Publish To>Corporate
Documents command.

Processed Documents that BROADCAST AGENT has successfully

documents processed and distributed through the repository.

User documents

Documents that users have sent using the Send
To>Users command.

3. Select an option in the Domains list box:
e All domains displays documents in all domains.
* A specific domain displays documents in that domain only.
Only the domains that your user profile lets you access appear in the list.
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4. In the Where list box, select a property to narrow down your search. The
properties that you can use are described in the table below. If you are using
properties to find WEBINTELLIGENCE documents, refer now to “Which
properties can you use to find Weblntelligence documents?” on page 209.

Select... To find documents...

Categories that either belong or do not belong to categories that you

select. When you use this property:

* Select contains or does not contain.

* Click ... then select categories in the dialog box that
appears.

Comments whose comments include a character string that you specify.
You assign comments to a document using the Properties
command (File menu) in BUSINESSOBJECTS. When you use
this property:

* Select contains or does not contain.

¢ Type a character string in the text box.

Data containing a data provider whose name includes a character
provider string that you specify. When you use this property:
name * Select contains or does not contain.

e Type a character string in the text box.

Document which either have or do not have document properties.
When you use this property, select has properties or has no
properties.

This option is especially useful for finding BUSINESSOBJECTS
4.x documents: document properties are a feature of
BUSINESSOBJECTS 5.0, so if you select Document then has no
properties, you will find only 4.x documents.
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Select... To find documents...

Keywords whose keywords include a character string that you specify.
You assign keywords to a document using the Properties
command (File menu) in BUSINESSOBJECTS. When you use
this property:

* Select contains or does not contain.

¢ Type a character string in the text box.

Name whose file name contains a character string that you specify.
When you use this property:

* Select contains or does not contain.

e Type a character string in the text box.

Size of a particular size. When you use this property:
o Select is equal to, is less than or is more than.
* Enter a value in Kilobytes in the text box.

Source containing data from a source that you specify. For example,
this condition lets you search for all documents containing
queries on a given universe such as eFASHION. The data
source name is displayed in the Definition tab of the Data
Manager (View Data command, Data menu) in
BUSINESSOBJECTS.

When you use this property:

* Select contains or does not contain.

* Type a data source name in the text box.

Subject whose subject includes a character string that you specify.
You assign a subject to a document by using the Properties
command (File menu) in BUSINESSOBJECTS. When you use
this property:

* Select contains or does not contain.

e Type a character string in the text box.

Submission that were submitted before or after a date and time that you
Date specify. When you use this property:

* Select before or after.

* Click ... to the right of the text box to enter a date and time.
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Select... To find documents...

Title whose title includes a character string that you specify. You
assign a title to a document using the Properties command
(File menu) in BUSINESSOBJECTS. When you use this property:
* Select contains or does not contain.

¢ Type a character string in the text box.

Total # of that belong to a given number of categories. When you use
categories this property:

o Select is equal to, is less than or is more than.

e Type a number in the text box.

Total # of by the number of rows of data that the documents contain.
rows When you use this property:

o Select is equal to, is less than or is more than.

¢ Type a number in the text box.

Total by the length of time that the documents last took to refresh.
duration When you use this property:

o Select is equal to, is less than or is more than.

* Type the total number of seconds in the text box.

5. Click Find Now.
BUSINESSOBJECTS displays the documents corresponding to the search criteria
you set. The number of documents found is displayed in the bottom left corner
of the dialog box.

Tip: All the Find options described above are also available in the Retrieve dialog
box (illustrated on page 199).

Just click the More>> button. The Retrieve dialog box expands to make the Find
options available.
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Which properties can you use to find Weblintelligence documents?

The only properties that you can use to find WEBINTELLIGENCE documents are as
follows:

Name

Size

Submission Date
Categories

Keywords.

This means that if you use any other property in your search, you will not find
WEBINTELLIGENCE documents.

Viewing retrieved documents in BusinessObjects

Once you've retrieved published documents, open them in BUSINESSOBJECTS
using the File/Open command.

Tip: The Open on Retrieval option in the Retrieve dialog box automatically opens
all documents that you retrieve. If you activate Open on Retrieval then double-click
a document name in the Retrieve dialog box, the document appears immediately
in BUSINESSOBJECTS.
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Overview

You can distribute documents with BUSINESSOBJECTS thanks to the repository,
which the BUSINESSOBJECTS supervisor sets up. Part of this repository, called the
document domain, stores the documents that users send or publish. It also stores
information about the documents, such as the names of the users who sent them,
who can retrieve them, and the date and time they were sent.

Easy to publish BusinessObjects documents for Web users

BUSINESSOBJECTS repository-based architecture allows you to distribute
information across your enterprise. By publishing a BUSINESSOBJECTS document
on the repository, you let not only BUSINESSOBJECTS, but also INFOVIEW users
view and retrieve the document over the Web. BUSINESSOBJECTS automatically
generates the HTML required to view the document in a Web browser.

In BUSINESSOBJECTS, you can also view documents that WEBINTELLIGENCE users
have created and published.

INFOVIEW users can also view BUSINESSOBJECTS documents in an enhanced
format that displays and prints documents as if they were open in
BUSINESSOBJECTS (same fonts, page layout etc.) -- and all this over the Web,
corporate intranet or extranet.

What's the difference between sending and publishing?

Sending documents to other users and publishing documents are both ways of
sharing BUSINESSOBJECTS documents. Their common denominator is the
repository, which stores sent and published documents, and permits other users
to retrieve them.

The differences are as follows:

* Documents that you send do not remain in the repository when other users
retrieve them.
Sending documents is thus the ideal method for communicating information
to individual people rather than to groups of users.

* Documents that you publish remain in the repository until the
BUSINESSOBJECTS supervisor removes them.

This method is similar to publishing documents on a forum or server. It is
ideal for communicating information across an organization or enterprise.
Documents that you publish are called corporate documents.
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What kinds of documents can you send and publish?

You can send and publish not only BUSINESSOBJECTS documents (.rep files) but
also add-ins and BUSINESSOBJECTS templates.

Who can retrieve the documents you send or publish?

When you send or publish documents, you specify which users or groups of
users will be able to retrieve the documents from the repository. Any
BUSINESSOBJECTS or INFOVIEW users with access to the repository will also be able
to view the documents.

BUSINESSOBJECTS supervisors are responsible for setting up users and groups. A
group of users typically consists of people working in the same department or on
shared projects. You can belong to one or several groups, and have access to one
or more of the repository’s document domains.

The users you can select vary depending on whether you're sending or
publishing documents:

*  When you send documents, you can select individual users and/or groups of
users.

*  When you publish documents, you can only select groups of users.

How do categories help you manage documents?

(A

Send to Users

')

Publish to
Corporate Documents

When you send or publish documents, you can select categories, which enable
people in your organization to filter the list of documents as they view them on
the repository. Selecting categories is described under “Sending documents to
other users” on page 216 and “Publishing Corporate Documents” on page 221.
Viewing documents by category is described under “What else can you do when
retrieving documents?” on page 201.

You can select categories for documents whether you send or publish them.
However, INFOVIEW users can only view corporate document lists by category in
their Web browser. In other words, categories are not available in INFOVIEW for
documents that you send using the Send To>Users command or toolbar button.
In INFOVIEW, documents that you send in this way appear in the INFOVIEW inbox.

So, if you want INFOVIEW users to use categories to filter document lists in their
Web browser, you must publish the documents using the Publish To>Corporate
Documents command or toolbar button.

Categories are available in BUSINESSOBJECTS objects for all types of documents.
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Creating, renaming and deleting categories

In BUSINESSOBJECTS, you can create, rename and delete categories. (The
supervisor will probably not let all users perform these tasks.) To create, rename
or delete categories:

1. Select the Send To>Users or Publish To>Corporate Documents command on
the File menu.
The Send dialog box appears.

2. Click Categories.
The Select Categories dialog box appears.

3. Click Manage.

Note: If the Manage button is grayed out, it means that the supervisor has not
granted you the right to create, rename or delete categories. You can only select
categories when you send or publish documents.

Ask you supervisor to create, rename or delete the categories, or to change your
user profile so that you can do it yourself. Alternatively, use the Login As
command, then enter the user name and password of a user who does have the
right to create, rename and delete categories.

The Categories dialog box appears:

These are the categories you can assign to a document. You are
== | logged as USER.
—Awvailable categorie
Mame | Clwrier | Created |
Business USER 23A12/9810:29:49
IT B_'watson  23412/9810:3216
Marketing J_Smith 2312/9810:30:48
MIS T_Jones 2312/9810:3317
[P T_lones 2312/9810:32:49
Sales USER 2312/9810:31:56
sdd || D |
Mew name: Mew projects Apply I
Ok Lancel | Help |
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4. The next step depends on what you want to do:

To...

Proceed as follows...

Create a category

Click Add.

Type a name for the category in the New Name
box.

Click Apply.

Rename a category

Click the category.
Type the new name in the New name box.
Click Apply.

Delete a category

Click the category in the list, then click Delete.

5. Click OK in the Categories dialog box, then OK again in the Select Categories

dialog box.

You return to the Send dialog box.

6. Continue to work with the dialog box if you are sending or publishing
documents; otherwise, click Cancel.

E-mail distribution

You can send documents by electronic mail, thanks to an interface between
BUSINESSOBJECTS and Microsoft Outlook/Exchange. To benefit from this feature,
you must have Microsoft Outlook for Windows installed on your computer.
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Sending Documents to Other Users

Sending documents is the ideal method for communicating information to both
individual users and groups of users. When you send documents, you select

users and/ or groups of users who will be able access the documents. You can also
associate documents with categories, which will make it easier for other users to

find the documents they’re interested in.

Sending documents to other users

(A

Send to Users

The name of the
active document
appears here.

To send documents to other users:

1. Click the Send To Users button on the Document Exchange toolbar.
The Send dialog box appears. It displays the default document domain and

the name of the active document:

Send

*f'ou use this dialog box to send documents to other uzers.
=

Domair:

—Sendto

|
— Document(z] to Send
Browse... |
Hemove
HTML Dptlons
Schedule
Eategouc

Document Categories: Keep exizting categories

Lategories. .. |

g |

Cancel | Help

To select a different domain, click the Domain list box.

This is the default
document domain.

Document domains are set up by the BUSINESSOBJECTS supervisor. If more
than one domain is available and you don’t know which one to select, contact

your supervisor.
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3. Click To.
The Select Users and Groups dialog box appears:

Select Users and Groups

Select the uger(s] you want to send your document to.

Document R ecipients:
Folders represent

groups of users.

Thisiconrepresents

asingle user. g Ladd > |
g Ehris:ine < Remove |
anel
& M artin
@ Paul
(@] Marketing
8 Mick

™ Wiew users in my groups anly

o]

Cancel Help

4. Select a viewing option:

Click... To view... This view is useful when...

List All users and You just want the list of groups and
groups as one flat users in alphabetical order, which
list. enables you to find users by name.

Groups Users in the groups | You want to see which groups other
in which they users and groups belong to.
belong. The supervisor may not have given

you the right to use this view, in
which case the Groups button is
grayed.

View Only the users that | Youdon’t want to send documents to

users in belong to the same | anyone in other groups.

my group(s) as you.

groups

only
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5. Hold down the Ctrl key, click the users and groups you want to send
documents to, then click OK.

You return to the Send dialog box. The icons of the users and groups you have
selected appear in the Send to box.

6. To select the documents you want to send:

Click this button... To select documents that...
Add Are open in BUSINESSOBJECTS
Browse Are not open in BUSINESSOBJECTS.

Reminder: You can send and publish not only BUSINESSOBJECTS documents but
also other types of files such as Add-ins to other users.

7. To allow recipients to view the documents by category, click Categories. This
is useful in organizations dealing with large numbers of documents.
The Select Categories dialog box appears:

Select categories E

Select the categories to azsign to your document.

—Awvailable categorie

™ Budget

™ Mew categary
™ Results

Mo category selected Ianage.. |
QK I Cancel | Help |

8. Check each category you want, then click OK. Refer to “How do categories
help you manage documents?” on page 213 for more information.
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Tip: BUSINESSOBJECTS users can view all types of documents by category on the

= repository. INFOVIEW users, who view documents in the Web browser, can only
view corporate documents by category. Therefore, if you want INFOVIEW users to
Publish to benefit from categories, you must publish your documents using Publish

Corporate Documents T Corporate Documents.

9. Click OK in the Send dialog box.
BUSINESSOBJECTS displays a message to show that you successfully sent the
documents to other users:

Results E

@ Export was successful

Wetaess |

Sending documents by e-mail

You can send documents by electronic mail thanks to an interface between
BUSINESSOBJECTS and Microsoft Exchange. In order to use this feature, you must
have Microsoft Exchange or Microsoft Outlook installed on your computer.

To send a document by e-mail:
1. Open the document in BUSINESSOBJECTS.

2. Select the Send To>Mail command on the File menu.
A new e-mail message opens in your e-mail application.
The document is automatically attached.
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Tip: Are you sure that the person you e-mailed the document to will be able to
open it in BUSINESSOBJECTS? If you launched BUSINESSOBJECTS online, i.e., did not
select Work in offline mode in the User Identification dialog box, that means you're
working with a connection to the repository. The e-mail recipients will only be
able to open the document if they too are working online. If they are working
offline, the error message You are not authorized to use this document will appear.

To avoid this problem:

1. Select the Save As command on the File menu, or press F12.

2. Inthe Save As dialog box that appears, select Save for all users:

Save As

Save jn: Ia UszerDocs

EEEE

|1 Beach
|20 eF ashion
20 Evakit

@Annual.rep

1

) Fepository 01

@ Bsmdemo.rep

E demo.rep

@ Guest.rep

@ Lease.rep

@ Mdetail rep

P MULTI beau fix.rep

@ qprompt.rep

|

File name:

Save as ype: IBusinessDbiects Documents [*.rep] j Cancel |

ISaIes analyziz.rep

Save I

Options... |

3. Click Save.
Any BUSINESSOBJECTS user who receives this document by e-mail will be able

to open it.

220 InfoView User’s Guide



Publishing Corporate Documents

Publishing Corporate Documents

Publishing documents allows groups of people across an organization or
enterprise to have access to information they need. The BUSINESSOBJECTS
repository enables you to publish your documents, which other users can then
view and retrieve.

When you publish documents to the repository, you select groups of users who
will be able to access the documents. You can also associate documents with
categories, which makes it easier for other users to find the documents they need.

Reminder: When you publish a BUSINESSOBJECTS document, you automatically
share it with INFOVIEW users who have access to the repository. BUSINESSOBJECTS
generates the HTML version of the document behind the scenes, but you can
control the HTML document by setting options. For more information, refer to
“Setting HTML Options” on page 225.
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To publish corporate documents

')

Publish to

Corporate Documents

If you belong to just
one user group, the
icon for that group
appears here

e
Because you cannot I

select other groups,
the To button is
grayed.

The name of the
active document
appears here.

1. Click the Publish to Corporate Documents button on the Document Exchange

toolbar.
The Send dialog box appears.

* If you belong to just one user group, the icon for that group is already

selected.

e The default document domain and the name of the active document are

displayed:

Send

*f'ou use this dialog box to zend documents to the repository.
=

Domair:

—Sendto

(#&] Development

— Document(z] to Send

Browse... |

Hemove
H THMLO ptlons

Schedule

Eategouc

Document Categories: Keep exizting categories

Lategories. .. | ‘

ok |

Cancel | Help |

2. To select a different domain, click the Domain list box.

This is the default
document domain.

Document domains are set up by the BUSINESSOBJECTS supervisor. If more
than one domain is available and you don’t know which one to select, contact

your supervisor.
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3. To select groups of recipients, click To.
The Select Groups dialog box appears:

Select Groups E

= “r'ou use this dialog box to zelect the group(s]
T you want to send documents to.

& List

L]
7 B .
Document recipients:

When you publish a
document, the Select
Groups dialog box
shows only groups of
users, not individual

users. In this view, you Add - |
cannot see the users

within each group. <-HiEmaye |
That’'swhy the Groups
button is grayed.

QK I Cancel | Help |

4. Hold down the Ctrl key and select the groups you want from the left pane.

5. Click Add then click OK.
You return to the Send dialog box.

6. To select the documents you want to send:

Click this button... To select documents that...
Add Are open in BUSINESSOBJECTS
Browse Are not open in BUSINESSOBJECTS.

Reminder: You can send and publish not only BUSINESSOBJECTS documents but
other types of files such as Add-ins to other users.
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7. To allow the recipients to view the documents by category, click Categories.
This is useful in organizations dealing with large numbers of documents.
The Select Categories dialog box appears:

Select categories E

Select the categories to azsign to your document.

—Awvailable categorie

™ Budget

™ Mew categary
™ Results

Mo category selected Ianage.. |
QK I Cancel | Help |

8. Check each category you want, then click OK. Refer to “How do categories
help you manage documents?” on page 213 for more information.

9. Click OK in the Send dialog box.
BUSINESSOBJECTS displays a message to show that you have successfully
published the documents to the repository:

Results E

@ Export was successful

Wetaess |
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Setting HTML Options

When you send a BUSINESSOBJECTS document to other users or publish it to the
repository, BUSINESSOBJECTS automatically generates the HTML required to view
the document in INFOVIEW. Thus, you can automatically distribute your business
information to INFOVIEW users who have access to the repository.

BUSINESSOBJECTS lets you set options for the HTML version of the document. For
example, you can decide to display the charts in your document as .gif files, or
whether or not to use frames.

To set HTML options when sending or publishing a document:

1. Select the Send To>Users command or Publish To>Corporate Documents
command on the File menu.

2. In the Send or Publish dialog box, click HTML Options:
Send E

F *f'ou use this dialog box to zend documents to the repository.

Domair: [locument

—Sendto
To.. | I

(#&] Development

— Document(z] to Send
Add...

Browse. .. |
Bemove |

HTHML Options. 215
Schedule... |

Categorie:
’7 Document Categories: Keep exizting categories Lategories. .. | ‘
QK I Cancel | Help |

Tip: You can set HTML options for several documents at the same time. Just hold
down the Ctrl key, click each document in the Send dialog box, then click the
HTML Options button. The options that you set will be applied to all the selected
documents.
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The HTML Options dialog box appears:

HTML Dptions E

HIML Irv thiz dialog box, you set options for the HTML version of the document.

For ‘weblnteligence
File M ame I ’7|_ Store generated HTML in document

—Save — Format:
) Curent Hepars ¥ Display Charts and Fictures
% | Al Feports imDesument V' Use Frame

) Selent Bepors: [+ Borders
V' Background Calors

V' Teut Colors

V' Eorts

V' Free-fom Layout

I Automatic Reload Every Wﬂ minutes

Generate HTML
’7 * Allin one page = Section by section " Both ‘
QK I Cancel | Help |

3. If you're sending the document to INFOVIEW users, check Store HTML in

document.
* This option stores the HTML required to display the document in a

browser before the document is sent.

e If you don’t check this option, the HTML will be generated on the server
when WEBINTELLIGENCE (INFOVIEW) users view the document. This can
take up a lot of server memory allocation.

. In the Save group box, check BusinessObjects Document to allow other users to

download the document.
Note that the options Current Report, All Reports in Document and Select Reports
are grayed. This is normal when you are sending or publishing a document.

5. Select formatting options in the Format box.
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6. Select an option in the Generate HTML group box.
These options determine the way users can navigate through the document in

their Web browser:
This option... Publishes each And enables users to...
document...
All'in One Page | As one HTML page. Print or search whole
documents.
Section Per With a browser which Jump from section to

Section contains a link to each section, especially useful
document section. in large documents.
Each section generates
one HTML file.

Both Displays the browser as | Switch between the one-

with the Section Per
Section option, but also
lets users view the
document in one page.

page view and the per-
section view.

7. Click OK in the HTML Options dialog box.
You return to the Send or Publish dialog box, where you can set other options
such as categories before sending or publishing the document.

For information on how WEBINTELLIGENCE users view BUSINESSOBJECTS
documents, see “The Open on Retrieval option in the Retrieve dialog box
automatically opens all documents that you retrieve. If you activate Open on
Retrieval then double-click a document name in the Retrieve dialog box, the
document appears immediately in BUSINESSOBJECTS.” on page 209.
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Overview

Overview

BROADCAST AGENT lets you automate the communication of business
information across your company or organization, and over the Web.

Using BROADCAST AGENT to distribute and publish documents means
automatically processing your documents at specified times or intervals. For
example, BROADCAST AGENT can send a refreshed copy of a document to a list of
recipients at the same time every evening. This type of distribution is also
referred to as scheduled processing, or batch processing.

What can Broadcast Agent do?

BROADCAST AGENT offers a rich functionality set, enabling you not only to
automate tasks such as refreshing and printing, but also to control processing
with conditions, and to publish your documents via the BUSINESSOBJECTS
repository or the World Wide Web. The following table gives an at-a-glance
overview of what BROADCAST AGENT can do, and indicates which features are

new:
BROADCAST AGENT At A Glance New?
BROADCAST AGE | » Refresh and print
NT can do all
this to your e Use a printer that you select, not just the O
document... default
* Report bursting, i.e., refresh the document Il
with each recipient’s user profile
* Save as .rtf, .txt or .pdf
* Perform custom tasks with VBA macros
e Publish on channels
* Begin processing only if a condition such as
increased revenue is met.
Basedona * Atregular times or intervals, for example
schedule... every Friday at midnight.
* Atstart and stop dates that you set.
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BROADCAST AGENT At A Glance New?
And/orwhen | ¢ Process your document only when another O
another file is file is present.
present...
Then * To individual users via the repository
distributes the
processed * As corporate documents, to groups of users 0
document...

e Over the World Wide Web (or intranets and
extranets)

* On the server file system

e Or on all of the above.

What’s in this chapter, and where you can get more information

232

This chapter describes how to distribute BUSINESSOBJECTS documents by sending
them BROADCAST AGENT for scheduled processing. It covers all basic scheduling
features, and provides a Frequently Asked Questions section.

For more information on BROADCAST AGENT, refer to:

Chapter 4 "Publishing, Sending and Scheduling Documents” on page 119,
which explains how to schedule WEBINTELLIGENCE documents in INFOVIEW.

Chapter 11 "Advanced Document Scheduling and Troubleshooting" on
page 263, which brings you the best in tips and tricks for scheduling
BUSINESSOBJECTS documents, information on customized document
processing with VBA macros, plus advanced calculation features,
troubleshooting and enhancements.

The Deployment Guide and the Broadcast Agent Administrator’s Guide, which
provide information about setting up, managing and troubleshooting
BROADCAST AGENT on the server side.

The Installation Guide for information on setting up BROADCAST AGENT.

The Error Message Guide to find out how to fix errors returned by
BROADCAST AGENT.
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Frequently Asked Questions

This section provides answers to some frequently asked questions about
document scheduling. The information here is particularly relevant if you are
updating from BUSINESSOBJECTS 4.1 to BUSINESSOBJECTS 5.X, and from DOCUMENT
AGENT SERVER to BROADCAST AGENT.

Can you send a 4.1 document to Broadcast Agent?

When your company or organization is in the process of updating to
BUSINESSOBJECTS 5.x, you may find yourself in a situation where you are still
using BUSINESSOBJECTS 4.1 but your administrator has installed

BROADCAST AGENT. With BUSINESSOBJECTS 4.1, you automated document
processing with DOCUMENT AGENT SERVER.

No problem - BROADCAST AGENT can process BUSINESSOBJECTS 4.1 documents
and send them back to you and other users as 4.1 documents.

Note: If a 4.1 user sends a document to BROADCAST AGENT and chooses to
distribute the processed document on the repository, all users with access to that
repository can view and retrieve the document. If a 5.x user retrieves, refreshes
or in any way alters the 4.1 document, then publishes it on the repository once
more, 4.1 users will not be able to open it.

In summary: BUSINESSOBJECTS 5.x documents are not supported in
BUSINESSOBJECTS 4.x.

Will custom scripts work in this version?

DOCUMENT AGENT SERVER 4.1 could process custom scripts that users attach to
documents. A script performs a non-standard task such as informing recipients
by e-mail that DOCUMENT AGENT SERVER successfully refreshed a document.

DOCUMENT AGENT SERVER has now been replaced by BROADCAST AGENT, which
also supports custom actions via scripting. In version 4.1, scripts were written in
ReportScript, but in version 5.x, Microsoft Visual Basic for Applications (VBA) is
the supported language.
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BROADCAST AGENT automatically converts ReportScript scripts to VBA macros
when processing your documents. However, you can convert your scripts before
sending them to BROADCAST AGENT by using the Convert from ReportScript
command in BUSINESSOBJECTS (Tools menu, Macro submenu).

Note: The ReportScript to VBA conversion works well, but some ReportScript
code will require minor tweaking when converted to VBA. An appendix in the
BusinessObjects SDK Reference Guide describes cases where you have to tweak the
VBA result.

Updating scripts that send e-mail via Microsoft Outlook

Using scripts in 4.1, you could use DOCUMENT AGENT SERVER to send e-mail via
Outlook, for example to inform recipients that DOCUMENT AGENT SERVER had
successfully processed a document. When you update from BUSINESSOBJECTS 4.1
to the current version, you can continue to customize document processing with
e-mail by attaching VBA macros to documents that you send.

If your organization has updated to BROADCAST AGENT but you are still working
with BUSINESSOBJECTS 4.1, you can continue to send your 4.1 documents
containing scripts that send e-mail. There is one exception, however: if your
administrator previously used DOCUMENT AGENT SERVER not as an NT service,
scripts that generate e-mail will not work when you update to

BROADCAST AGENT.

Recommendation

If your organization has updated from DOCUMENT AGENT SERVER to
BROADCAST AGENT, and you need to continue processing your document with
the script that sends e-mail, we recommend that you:

1. Update from BUSINESSOBJECTS 4.1 to the current version.
The Installation Guide contains information on how to do this.

2. Inthe updated version of BUSINESSOBJECTS, convert the script toa VBA macro,
using the Convert From command (Tools menu).

3. Send the document to BROADCAST AGENT, referring to “What do you want
Broadcast Agent to do to your document?” on page 239 for full information.
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Can you schedule BusinessObjects documents from your Web
browser, using InfoView?

Yes. INFOVIEW users can view, refresh, print, publish, save, and schedule
BUSINESSOBJECTS documents over the Web.

Can you schedule Weblntelligence documents in
BusinessObjects?

Strictly speaking no, because although you can open WEBINTELLIGENCE
documents in BUSINESSOBJECTS, you cannot save them as WEBINTELLIGENCE
documents. You can only save them as BUSINESSOBJECTS documents.

However, if you retrieve a WEBINTELLIGENCE document from the repository
(Retrieve From>Corporate Documents, or Retrieve From>Users commands),
then open that document in BUSINESSOBJECTS, you can schedule it as a
BUSINESSOBJECTS document. Behind the scenes, BUSINESSOBJECTS saves the
document as BUSINESSOBJECTS document (.rep file).

We advise you to schedule BUSINESSOBJECTS documents only using
BUSINESSOBJECTS. If you need to schedule WEBINTELLIGENCE documents, use
INFOVIEW, as described in Chapter 4 "Publishing, Sending and Scheduling
Documents" on page 119.

Can you schedule BusinessQuery documents?

No. BUSINESSQUERY users can publish BUSINESSQUERY documents (queries) to the
repository, but cannot schedule them - not in BUSINESSQUERY, BUSINESSOBJECTS
or INFOVIEW.
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Can Broadcast Agent process documents containing
user objects?

Yes, but the user objects will be ignored, meaning that any data you need from
these objects will not appear in the document.

Refer to “Does the document contain user objects?” on page 295 for further
information.

Can Broadcast Agent process documents containing prompts?

Yes. BUSINESSOBJECTS displays the prompt when you send the document;
BROADCAST AGENT then uses the values you entered when processing the
document.
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Scheduling a Document

You schedule a document by sending it to BROADCAST AGENT. This section gives
a short, simple description of how BROADCAST AGENT processes your document.

Note: For more detailed information on how BROADCAST AGENT works on the
server side, refer to the Broadcast Agent Administrator’s Guide.

BROADCAST AGENT is installed on a server machine, not on the computer that you
use to work with BUSINESSOBJECTS. The BROADCAST AGENT administrator is
responsible for setting up the software on the server.

Your BUSINESSOBJECTS supervisor gives you and the other people in your user
group with access to BROADCAST AGENT.

When you send a document to BROADCAST AGENT, you:
* Select general options such as document priority.
* Specify the actions that you want BROADCAST AGENT to perform.

For example, you can have BROADCAST AGENT refresh and print the
document. BROADCAST AGENT can also publish the document on channels,
save it in rtf or text format, and run VBA macros when processing the
document. Finally, you can set up condition-based processing, whereby
BROADCAST AGENT only processes the document if a condition such as
increased revenue is met.

* Select categories that you want the document to belong to.
e Set times or intervals at which BROADCAST AGENT will process the document.
You can also set a schedule based on the existence of a file.

* Select options for publishing the document - on the repository, the World
Wide Web or the file system.

Each of these stages is described in more detail below.

The document you send is stored in the document domain of the repository until
BROADCAST AGENT is set to process it. For example, if you send a document at
10a.m. and request that BROADCAST AGENT process it at midnight, the document
remains in the repository until midnight. At that point, BROADCAST AGENT:

* Opens the document in BUSINESSOBJECTS on the server

e Performs the actions that you specified when you sent the document
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First steps

4

Send To
Broadcast Agent

e Saves and closes the document

e Publishes the document on the repository, a Web server or the file system
(depending on the options that you set when you sent the document).

This process is invisible to you because it takes place on the server.

You can send a document to BROADCAST AGENT if:

e The BUSINESSOBJECTS supervisor has granted you access to
BROADCAST AGENT.

* You're working online.
To send a document to BROADCAST AGENT:
1. Open the document in BUSINESSOBJECTS.

2. Click the Send to Broadcast Agent button on the Document Exchange toolbar.
The Send Document to Broadcast Agent dialog box appears with the General
tab active:

Send Document to Broadcast Agent E

General |Acti0ns| Eategoriesl Schedulingl Distributionl

Servern il Enterprise Priarity: INormaI 'l

Deszciription

] I Cancel Help
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3. To select a different BROADCAST AGENT than the one shown, click the Server
list box.

Note: You will probably only have access to one BROADCAST AGENT.

4. To change the task priority to Low or High, click the Priority list box.

5. If you like, write a description of the document in the Description box. This
text can help other people identify the document after BROADCAST AGENT has
processed and published it.

You are now ready to specify the actions, categories, scheduling and distribution
options for the document.

What do you want Broadcast Agent to do to your document?

When you schedule a document, you have to define the actions such as refreshing
or printing that you want BROADCAST AGENT to perform. Here’s how to do it:

1. Follow “First steps” on page 238, then click the Actions tab:

Send Document to Broadcast Agent E

General Actions | Eategoriesl Schedulingl Distributionl

) Fefrestwith the Frofile of Each Hecimient

—{* Standard Actions
Available actions: Selected actions:

ove llp |
e[ |
[ve Do |

Save as if << Hemave | :
Save as fed LI Broperties. . |

— Condition

Select a condition ta be evaluated .
each time the document is processed: I Editar... |

] Cancel | Help |

InfoView User’s Guide 239



Chapter 10 Scheduling BusinessObjects Documents

2. You can now:

Click... To have BROADCAST AGENT...

Refresh with the Refresh the document according to the profile of the
Profile of Each users who will receive it. This is also called report
Recipient bursting.

The advantage of this option is that recipients do
not see information that is private, or available to
users with different profiles. For example, your user
profile (set up by the supervisor) might enable you
to retrieve 1000 rows of data from the database.
Other users might only be able to retrieve 500 rows,
for security reasons. This option ensures that
parameters such as these are respected; users who
open the refreshed document do not receive
information they should not see.

e This option disables all other available actions,
and allows you to distribute the document via
the repository only.

e If you're using this option, go to step 5.

Standard Actions Select actions such as Print Document in the
Awvailable Actions list.

3. Specify the actions that you want BROADCAST AGENT to perform by using the
following options in the Standard Actions box:

Double-click... To have BROADCAST AGENT...

Refresh Refresh the document. Note that this option:

* Refreshes all the data providers in the document.

* Refreshes the document in your name, i.e., with
your user profile.

Print Print the document on your default printer.

Use custom macros | Run a VBA macro when processing the document.
This option opens the Macros dialog box, where
you select or create a macro to attach to your
document.

Channel Publish the document on a Web channel that the
BUSINESSOBJECTS supervisor previously set up.
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Double-click...

To have BROADCAST AGENT...

Save as RTF

Save the document in rich text format.

Note that using BROADCAST AGENT to generate RTF
versions of BUSINESSOBJECTS documents can result
in very large files. For example, an 800-page
BUSINESSOBJECTS document results in a 50Mb RTF
document.

Save as text

Save the document in text format.

Save as PDF

Save the document in Adobe Acrobat Portable
Document Format (PDF).

4. Click an action in the Selected Actions box, then click Move Up or Move Down
to change its position in the actions list.
Note that BROADCAST AGENT performs the actions in the order in which they
appear. Do you want to print the document before or after refreshing it?

Tip: You can use the Properties button to change the setting of the following

selected actions:

Print

Use custom
macros

Channel

Save as RTF/text/
PDF

Select a printer other than your default printer.

Edit the VBA macro that you already selected, or select
or create a different one.

Set properties such as HTML options. Authorized users
can also create their own channels.

Select the folder for the output .rtf, .txt, or .pdf files.

To use this feature, first click the action in the Selected Actions box, the click

Properties.
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5. Click the Editor button in the Conditions box if you want to define a formula
to use as a condition that is evaluated every time BROADCAST AGENT processes
the document.

The Formula Editor appears:

Formula Editor E
Farmula |
Faormulas
[—
H
Wariables Functions Operators

- @ Quarter D All functions & aggregat. |=
@ Resort D Aggregates

@ Year Eh-(23) Mumeric functions

- @ Number of guests D Character functions
@ Fevenus [H(23) Date functions

D Logical functions
D Document functions
D [rata provider functions
B2 Misc functions

KN i

Eumetion bels |

[k | Cancel | Help |

6. Define the formula in the Formula box, then click OK.
You return to the Actions tab, where the formula you defined now appears in
the Condition field:

LCondition
Select a condition ta be evaluated .
lreach time the document is processed: |=<Number of guestss <125 Editar... |

Also, Condition Evaluation appears in the Selected Actions list box. Make sure
the condition is in the right place in the list of actions, for example before Print
to print the document only if the condition is true.

7. When you have finished defining the actions you want BROADCAST AGENT to
perform, click OK to send the document, or click a different tab to select more
options.
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Which categories does the document belong to?

Categories enable users to sort and find published documents on the repository.
For example, if sales consultants select the Sales category when they send
documents to BROADCAST AGENT, other sales consultants will be able to find the
processed documents quickly and easily on the repository.

To select categories for the document you're scheduling:
1. Follow “First steps” on page 238, then click the Categories tab.
The categories you can use are listed:

Send Document to Broadcast Agent E
Generall Actions  Categories | Schedulingl Distributionl

“f'ou can select categories for the document.

—Awailable Categorie:

™ &l Product Teams

™ whw Marketing

Mo category selected [ &tiame.. |

] | Cancel | Help |

2. Click the categories you want the document to belong to.

3. To create new categories, or to rename or delete existing ones, click Manage.
The Manage Categories dialog box appears.

4. To add a category, click Add.
The new category appears in the list of categories in the dialog box.

5. Torename a category:
e Click the name of the category
e Type the new name in the New name box
e Click Apply.

6. To delete a category, click its name then click Delete.
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7. Click OK to close the Categories dialog box.
You return to the Send Document to Broadcast Agent dialog box.

8. Select any new categories you want to assign the document to, then click OK
to send the document, or click a different tab to select more options.

When will Broadcast Agent process the document?

BROADCAST AGENT processes documents at times or intervals that you specify.
All you have to do is set up these times in the Scheduling tab.

You can also have BROADCAST AGENT process a document based on the existence
of another file. This feature is called File Watcher. Here’s an example.

Example Processing a document when your database back-up is complete

System administrators may want to be certain that the database has been backed
up before BROADCAST AGENT processes any documents. If BROADCAST AGENT
attempts to process a document during back-up, the task will fail systematically.
However, you can use a feature called File Watcher to avoid this problem.

Configure your system so that a text file is sent to a given location when the back-
up process is complete. Then:

1. In the Scheduling tab, click File Watcher.

2. Specify the path to the file in the File to watch for field.
BROADCAST AGENT will only process the document when the file is present in
the specified location.

For more information on File Watcher

* You can find another, more detailed example of the File Watcher feature
under “Starting a new task when another task ends” on page 272.

* For answers to questions such as where you can post the file to watch for, and
what happens when BROADCAST AGENT cannot find the file, refer to “File
Watcher Essentials” on page 131.
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To set the schedule

1. Follow “First steps” on page 238, then click the Scheduling tab.
The current schedule is shown in the Time Schedule box:

Send Document to Broadcast Agent E

Generall Actionsl Categoriss  Scheduling | Distributionl

— ¥ Time Schedule
Once on 2/16/99 at 08:06 A

Give the start and expiration date

Stat date: 02/16/99 = 08:06 AM =
Expiration date: 02/16/00 = 08:06 AM =
For your information, the first occurrence scheduled iz lm
— File Watcher

File to watch for: Brawse.. |

¥ | [elete the file each ime theitask starts

] | Cancel | Help |

2. Click Change to change the current schedule.
The Change Schedule dialog box appears:

Change Schedule [ %]

p:q Thiz window allows you to zet the date or the frequency with which
.- ] you want the tasks to be executed.

—Run — Stark At
& Once D ate: [dfmdpypy): Hour (hk:rrn):

= : =
Jos/04/1397 5 [11:50 aM =

" Hourly

" Daily
 Weekly

' Monthly

' Monthly interval
© User defined

QK I Cancel Help
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3. Click an option in the Run box, then change the settings in the Start At box.
Note that the options in the Start At box change according to the Run option
you select. For example, if you click Monthly in the Run box, the Start At
options let you select the day(s) of the month on which you want
BROADCAST AGENT to process the document:

= Stark At
[ray(z] of the month: Hour [hh:mm]:
T st ii [11:40 am =
M 2nd
M 3d
T 4th
C 5th

L=y LI

4. Click OK to return to the Scheduling tab.

5. Specify the date and time you want BROADCAST AGENT to start processing the
document by entering values in the Start date and Expiration date fields.

6. Check File Watcher if you want BROADCAST AGENT to process the document
based on the existence of another file.

* Click Browse to locate the file.

e Use the name of the server machine where the file will be located, not the
absolute path. In other words, if you enter “c:\my documents”, you are
pointing to c: drive of the machine you are working on, not the c: drive of
the server.

e Check Delete the file each time the task starts if you want BROADCAST AGENT
to watch for the file every time it processes the document. Using this option
enables “report chaining”, whereby the file that triggers processing has to
be present every time the document is due.

Tip: You can combine the Time Schedule and File Watcher options.

For answers to questions such as where you can post the file to watch for, and
what happens when BROADCAST AGENT cannot find the file, refer to “File
Watcher Essentials” on page 131.

7. Click OK to send the document, or click a different tab to select more options.
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How do you want to distribute the document?

Another advantage of BROADCAST AGENT is that it can distribute processed
documents via the repository, the World Wide Web or the server file system.

Repository distribution

Distribution via the BUSINESSOBJECTS repository offers maximum security. You
determine the list of users and groups of users who will receive the processed
document.

When you choose to distribute a document via the repository, BROADCAST AGENT
automatically generates an HTML version. This enables INFOVIEW users with
access to the repository to view the document in a Web browser. INFOVIEW users
can view the documents you send in HTML (the native language of Web
browsers) and enhanced document format, which provides excellent navigation
and print capabilities.

World Wide Web distribution

With World Wide Web distribution, BROADCAST AGENT processes your
document then saves it in HTML format on a Web server that you specify. This
method enables you to publish up-to-date information internally on your
intranet, or to the outside world via the Internet.

Server file system distribution

BROADCAST AGENT can post your document to a folder on your server that you
specify.
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To set up the way Broadcast Agent will distribute the document

1. Follow the instructions in “First steps” on page 238, then click the Distribution
tab:

Send Document to Broadcast Agent E

Generall Actionsl Eategoriesl Scheduling  Distribution |

I Distribute via the BusinessObjects Repository
dio.. | I

I | el iy riemne i Ehie st
¥ | Wienurite Made

HL Dptians... |

I Distribute via ‘Web Server

I Brawse.. | [Ehons. .

— I Distribute via the Server File System

I Brawsze,.. |

] | Cancel | Help

2. Select an option for distributing the document:

Select... To...

Distribute via the Publish the processed document on the
BusinessObjects Repository | repository.

To Select the users or groups of users who will
receive the processed document.

Add my name to the list Send a copy of the document to yourself.

Overwrite mode Overwrite the previous version of the
document with the newly-processed version
every time BROADCAST AGENT distributes the
document.

HTML Options Set options for the HTML version of the
document (borders, frames, etc.). Remember
that INFOVIEW users with access to the
repository will be able to view the HTML
version of the document.
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Select...

To...

Distribute via Web Server

Save the document in HTML format and

publish it on the World Wide Web.

* The field below this option indicates the
path to Web server and the folder that will
receive the published document. Specify a
folder by clicking Browse, or by typing a
path, e.g.,\ \ Host Nane\ Fol der Nare.

* See “Files and folders created with HTML
documents” on page 316 for information
on how BROADCAST AGENT manages the
HTML file.

HTML Options

Set options for the HTML version of the
document (borders, frames, etc.).

Distribute via the server file
system

Send the document using your company’s file
system.

The field below this option indicates the path
to the folder that will receive the published
document.

Specify a folder by clicking Browse, or by
typing a path, e.g.,

\'\ Host Narre\ Fol der Nane.

3. Click OK to send the document to BROADCAST AGENT.
The following confirmation message appears on your screen:

Send Document to Broadcast Agent

@ Document sent to Broadcast Agent.
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What to do if the Enter or Select Values dialog box appears

250

When you click OK to send your document to BROADCAST AGENT, the Enter or
Select Values dialog box might appear:

Enter or Select Yalues E

;€ |

Select a nationality Cancel |

Help |
Walues... |

This occurs because:

* BROADCAST AGENT has to refresh the document because you selected the
Refresh option in the Actions tab.

e The document contains prompts, which ask you to select values for the
document when you refresh it.

For example, sales managers can select cities or product lines that they want
to find out about. The prompt enables the managers to filter out information
that they don’t need, thereby reducing the time it takes to refresh the
document, and the volume of data returned from the database. This type of
document is also referred to as an interactive document.

e If you didn’t enter the values that you want to focus on when you send the
document, BROADCAST AGENT would not be able to refresh it at the scheduled
time. Prompts require that you manually enter values. Because
BROADCAST AGENT refreshes the document on a server machine, when you
are not there, you cannot enter the values at refresh time.

In conclusion, BUSINESSOBJECTS prompts you to enter the values you want when
you send the document, not when BROADCAST AGENT refreshes the document.
So, when the Enter or Select Values dialog box appears when you send a
document to BROADCAST AGENT:

1. Click Values.

2. In the dialog box that appears, select the values you want and click OK.
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3. Click OK in the Enter or Select Values dialog box.

Note: This feature was not available in BUSINESSOBJECTS 4.1. For information on
enhancements such as these, refer to “Enhancements Over Document Agent
Server” on page 299.

What to do if the OLAP User Identification dialog box appears

If the document that you are scheduling contains OLAP data providers, the
OLAP User Identification dialog box appears when you click OK in the Send
Documents to Broadcast Agent dialog box.

The OLAP User Identification dialog box prompts you to enter your OLAP
security information. The fields that you have to fill in depend on the server.
Here’s an example of the dialog box, where the data provider is built on Oracle

Express:
OLAP User Identification [ %]
To connect to xademo database on Horta Express server, enter pour
passwords.
ok I
User Mame || 'l
Cancel |
Server pazsword I
Databaze pazsword I Help |

Complete all the fields, in this case the user name, server password and database
password. These are the same user name and passwords that you enter in the
wizard when you build OLAP data providers in BUSINESSOBJECTS.

When BROADCAST AGENT processes your document, it uses the user name and
passwords that you entered in the OLAP User Identification dialog box, to
connect to your corporate database, and bring back the data you need. For
information about limitations on scheduling documents containing OLAP data
providers, refer to “Does the document contain OLAP data providers?” on
page 292.
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What if Broadcast Agent is offline or unable to process
BusinessObjects documents?

252

When you click OK in the Send Document to Broadcast Agent dialog box, a
message entitled Broadcast Agent Offline may appear on your screen. There are
two cases:

e BROADCAST AGENT is not online

* BROADCAST AGENT is online but is unable to process BUSINESSOBJECTS
documents.

Broadcast Agent is not online
This message indicates that BROADCAST AGENT is not running on the server:

Broadcast Agent Dffline E

Broadcast Agent Enterprize’ iz not Online
Do you gtill want to gend the document?

This is not a problem. BROADCAST AGENT is automatically launched when
documents are due for processing. If you want to find out how this works, refer
to the Broadcast Agent Administrator’s Guide.

Broadcast Agent is online but is unable to process BusinessObjects
documents

This message indicates that the BROADCAST AGENT you selected can only process
WEBINTELLIGENCE documents:

Broadcast Agent Offline E

Do wou till want to send the document?

& Broadcast Agent 'BCA' iz online but iz unable to process Businesz0Objects documents [.rep).

To enable processing of BUSINESSOBJECTS documents, your BROADCAST AGENT
administrator has to switch on the BusinessObjects documents parameter in the
Administration Tool.

You can still send the document, provided that the administrator changes the
parameter before the first scheduled processing time that you set. If this is not
possible, have the administrator change the parameter, then send the document
again.
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For information on setting BROADCAST AGENT parameters on the server side,
refer to the Broadcast Agent Administrator’s Guide.

Can you change the options for a document you have sent?

Imagine you sent a document to BROADCAST AGENT, chose to distribute it via the
BUSINESSOBJECTS repository, then realized that you forgot to add your boss to the
list of document recipients. Or what if you want to change the schedule, for
example to have BROADCAST AGENT process the document right away?

You don’t have to send the document again. You can change the scheduling and
distribution options for a document that you have already sent to

BROADCAST AGENT, thanks to the Broadcast Agent Console. You can also change
the description of the document. Here’s how to do it:

1. In BUSINESSOBJECTS, select the Console command on the Tools menu.
The Broadcast Agent Console appears:

Conszole E

Thiz window allows pou ta show or define tazk information.

" View processed tasks

Document Mame I Statuz |

Efazhion.rep W aiting

Revenue.rep W aiting

Revenue.rep W aiting

Properties... Delete | Besalve |

— General

Broadcast Agent Mame: & Enterprize =~ Options... | Refresh |

Lloze I Help |
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2. Click the document that you want to modify, then click Properties.
The Task Properties dialog box appears:

Task Properties E

General |Acti0ns| Eategoriesl Schedulingl Distributionl

Server I Marketing j Priority: I Mormal ¥ l

Deszciription

QK I Cancel | Help |

¢ The Properties dialog box contains the same tabs as the Send Document to
Broadcast Agent dialog box (illustrated on page 238): General, Actions,
Categories, Scheduling and Distribution.

* You can view the options that you selected in each tab, but you can only
change the document description (General tab), categories, scheduling and
distribution options. You cannot change the actions set in the Actions tab.
If you do want to change the actions for a document, you have to schedule
it again using the Send To>Broadcast Agent command.

3. Toadd or change comments about the document, write in the Description box
(General tab).

4. To change the document’s scheduling options, click the Scheduling tab.
* You can use all the scheduling options (Time Scheduler, File Watcher etc.)
in the Properties dialog box.
* Refer to “When will Broadcast Agent process the document?” on page 244
for information on how to use these.
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5. To change the distribution options, click the Distribution tab. You can:
* To change the list of document recipients, click the To button under
Distribute via the BusinessObjects Repository.
e To distribute the document on the server, click Distribute via the Server File
System, then click Browse to select a folder.
* You cannot use the Distribute via Web Server option from the Properties
dialog box.

6. Click OK to return to the Console.

Tip: For information on using the Console to monitor the documents you have
sent to BROADCAST AGENT, refer to “Monitoring Your Documents” on page 277.
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Scheduling Corporate Documents

You can schedule documents that you want to publish across your enterprise or
organization, via the BUSINESSOBJECTS repository. These are corporate documents.

Who gets the corporate documents that you schedule?

You select the groups of users that will be able to view and download the
documents. With scheduled corporate documents, you can select only groups of
users, not individual users.

What scheduling features are available for corporate documents?

When you schedule corporate documents, you benefit from many of the
document scheduling features described in “BROADCAST AGENT At A Glance” on
page 231. Here is the list of features that are not available for corporate
documents:

* Report bursting
* Condition evaluation
e Distribution via the server’s file system

* Distribution via a Web server that you specify. (You can distribute corporate
scheduled documents via the Web, for INFOVIEW users).
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To schedule corporate documents

1. Follow the procedure for “Publishing Corporate Documents” on page 221.
2. In the Send dialog box, click Schedule:

Send E
*f'ou use this dialog box to zend documents to the repository.
=

Domair:

—Sendto
To.. | I

[

— Document(z] to Send

Browse... |

Hemove
H THMLO ptlons

Schedule

Eategouc
Document Categories: Keep exizting categories Lategories. .. | ‘

QK | Cancel | Help |

The Schedule Corporate Documents dialog box appears:

Schedule Corporate Documents E

General | Actions I Scheduling I

Servern il Enterprise Priarity: INormaI 'l

Deszciription

] Cancel Help
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3. In the General tab, select the server and the document’s priority. Write a
description of the document to help people understand its content, if you

wish.

4. In the Actions tab, select the tasks that you want BROADCAST AGENT to

perform on your document.

For more information on using the Actions tab, refer to “What do you want

Broadcast Agent to do to your document?” on page 239.

5. Still in the Actions tab, select Faster Document Viewing Over The Web to make
it faster for INFOVIEW users to view the document in their Web browser: :

Schedule Corporate Documents

Gerneral Actiong | Scl’edulingl

| Befres 1 with the prafile of each recipient

— O Standard Actions

Awvailable actions:

ielels |
<< Hemayve |

Custom macros
Chanrel

Save as ATF
Save as et T

Selected actions:

ovellp |
Fmwve e |
Erop=rties... |

™ Faster Document Yiewing Dver The web

Options... |

o

Cancel | Hep

Click Options to select the document format you need for web users. The three

categories are:

e Enhanced Document Format speeds up document viewing in the

BUSINESSOBJECTS report viewer.

e Standard HTML Format speeds up document viewing in native HTML.
e Optimize for PDF Viewing speeds up document viewing in PDF format.
Refer to “Viewing BusinessObjects documents in InfoView” on page 74 for
more information on the different ways of viewing BUSINESSOBJECTS

documents in INFOVIEW.

6. In the Scheduling tab, set the times and/or intervals at which you want

BROADCAST AGENT to process your document.

For more information on using the Scheduling tab, refer to “When will

Broadcast Agent process the document?” on page 244.
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7. Click OK.
You return to the Send dialog box, where you click OK to send the document

to BROADCAST AGENT.

To change or unschedule a scheduled corporate document

This is the icon for
scheduled
documents.

You may wish to change the schedule of a corporate document, or remove the
scheduling options that you set. For example, if BROADCAST AGENT processes a
document every Monday, you can choose a different day of the week, or change
the frequency to hourly or monthly. You can also activate or switch off the File
Watcher feature, which triggers processing only when another file is present on
the server.

When you change the schedule of a corporate document, you can use options to
speed up document viewing in INFOVIEW, over the Web.

To change or unschedule a scheduled corporate document:

1. Select the Retrieve From>Corporate Documents command on the File menu.
The Retrieve dialog box appears. The icon for scheduled documents is shown

here:

“r'ou use this dialog box ta retrieve documents from the repositary. Right-click on document(s] for additional commands.
I~ Show only this category of documents: |<N0 Categony: j
Mame | Categories | Clwrier | Schedule I Submission D... | Size | Type | 8]
ﬁ Efazhion.rep Alex Yes 03/29/9911.... 187304 Corporate docu... D
m |zzues. bay Alex Mo 0244/9902... 13312 Corporate Bugin.,, D
m Orders.bay Alex Mo 0244/9902... 13312 Corporate Bugin.,, D
| | i
¥ Mpen on Fetieyal Eroperties... | Hetieye | Weleter. | Morez» | Lloze | Help |

. On the pop-up menu that appears, select:
* Change Schedule to have BROADCAST AGENT process the document at

different times or intervals. Go to step 4.

document was sent to BROADCAST AGENT.
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In this case, the document remains as a corporate document on the
repository, but will not be processed by BROADCAST AGENT from now on.
If you change your mind and want to schedule the document again, you
have to start over by resending it to BROADCAST AGENT.

4. If you clicked Change Schedule, the Task Properties dialog box appears:

Taszk Properties E

General | Actions I Scheduling I

Server I Development j Priority: I Mormal ¥ l

Deszciription [

QK I Cancel Help

5. Click the Actions tab:

Taszk Properties [ %]
General Actions | Schedulingl
) Fiefrest with the Frofile of Each B ecimient

%) Standard Sctiohs
Selected actions:

Fiefrezh Faster Document Wiewing Over the 'Web
™ Enhanced Document Fomat —‘

™ Standard HTML format

QK I Cancel Help
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6. Use the options in the Actions tab to speed up document viewing over the
Web, for INFOVIEW users:
* Enhanced Document Format is for the BUSINESSOBJECTS report viewer.
e Standard HTML Format is for native HTML.
Refer to “Viewing BusinessObjects documents in InfoView” on page 74 for
more information on the different ways of viewing BUSINESSOBJECTS
documents in INFOVIEW.

7. Use the options in the Scheduling tab to set the new schedule.
e For information on the options in this tab, refer to “When will Broadcast
Agent process the document?” on page 244.
*  When you click OK, you return to the Retrieve dialog box.

8. Click Close.
BROADCAST AGENT will now process the document at the new times or
intervals that you set.
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Finding Processed Documents on the Repository

Using the Find Documents feature you can search for documents according to
criteria that you set. One of the options is Processed documents, i.e., documents that
BROADCAST AGENT has successfully processed and distributed to you via the
repository.

To find processed documents:

@ 1. Click the Find Documents button on the File menu.

The Find Documents dialog box appears.
Find Documents

2. In the Find Documents box, set the Look for option to Processed documents, like

this:
Find documents
(R0 AT Processed documents =| in |<AIIDOmains> j
Where: | <Mo propertys j I j I __I
’Tﬂowl Mew Search

3. Click Find Now.
Only the documents that BROADCAST AGENT has successfully processed and
distributed to you are now listed in the dialog box.

4. Select the document(s) that you want to retrieve, then click Retrieve.

Note: For detailed information on using the Find Documents feature, refer to
“Using search criteria to find published documents” on page 203.
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Overview

This chapter will help you get the most out of working with BROADCAST AGENT
and BUSINESSOBJECTS. It includes:

Useful suggestions, including report bursting
Information about customized processing with VBA macros
How to monitor your documents with the Broadcast Agent Console

Everything you need to know about condition evaluation and document
processing

A Troubleshooting section

For the basics of automated document processing with BROADCAST AGENT, see
Chapter 10 "Scheduling BusinessObjects Documents" on page 229.

Troubleshooting information in this chapter

This chapter describes the problems you may encounter when sending
documents from BUSINESSOBJECTS to BROADCAST AGENT. It provides the
following information:

How to process a document when you’ve used your login password for the
connection to the corporate database, but the password for the database
connection has changed.

Report bursting limitations.
Avoiding problems before sending your document.

Error handling, including using VBA macros to define your own error
messages.

BROADCAST AGENT features that fix problems that occurred with DOCUMENT
AGENT SERVER.

Where you can get more information

You can find information on troubleshooting BROADCAST AGENT on the server
side in the Broadcast Agent Administrator’s Guide. Also, all error messages returned
by BROADCAST AGENT are described in the Error Message Guide.
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Document Scheduling Tips and Tricks

266

BROADCAST AGENT is packed with features that you can combine to optimize the
way you process and distribute documents. This section covers:

* Report bursting -- sending one document which BROADCAST AGENT then
distributes according to the profile of each recipient. This ensures that
recipients see only the data that their user profile allows.

* Printing a processed document on different printers in different locations.

* Personal document processing: using BROADCAST AGENT to process
documents that you send back to yourself only.

e Posting versions of a processed document in different file formats on different
file servers.

* Using a condition to trigger processing, then publishing the document over
the Web.

* Report chaining: automatically starting one process when another one ends.
* Automated channel publishing.
* Protecting processed documents with passwords.

e Handling errors by using custom macros.
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Report bursting

Example

4

Send To
Broadcast Agent

If you're a power user with rights to all types of documents and database
connections, you may not want all the people on the distribution list for a
document you're sending to see the same information as you.

Report bursting lets you automatically generate a version of a document based
on the profile of each person who will receive it.

BUSINESSOBJECTS supervisors set up user profiles. Profiles are the sum of access
rights a user has, such as how many rows of data each user can view, which
database connections are available to which users, which universes, and so on.

By setting one simple option in the Send Document to Broadcast Agent dialog
box, you ensure that the document you're sending will be sent with each
recipient’s user profile, not with your profile.

Here’s an example of report bursting that shows how you can distribute different
information to different people from just one document.

Report bursting

Supervisors can place restrictions on the universes that BUSINESSOBJECTS users
work with. In this example, the supervisor has set up a group of users, where:

* Maria and Tom can use universes but only retrieve 500 rows.
¢ Janis and Frank can use universes but retrieve up to 1000 rows.

You belong to the same user group, but you are a power user with the right to
retrieve as many rows as queries return. You can create a document with a query
on a universe, then, thanks to report bursting with BROADCAST AGENT, send the
document once but distribute different versions of it to the other members of your
user group.

To create and send a document according to each recipient’s user’s profile:
1. Create a new document and build a query on a universe.

2. Save the document, then click the Send to Broadcast Agent button on the
Document Exchange toolbar.

3. In the Actions tab, select Refresh with the Profile of Each Recipient.

4. Inthe Distribution tab, click To, then select your user group in the Select Users
and Groups dialog box.
Note that, when you use report bursting, the only way you can distribute the
document is via the repository.
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5. Set the scheduling parameters in the Scheduling tab, then click OK.

BROADCAST AGENT:

* Makes a copy of the document for each recipient.

* At the specified time, refreshes each copy with the profile of each recipient.
Maria and Tom’s document contains up to 500 rows, while Janis and
Frank’s document contains up to 1000 rows. Your copy of the document
contains the full query result.

Can you use Overwrite Mode with report bursting?

Report bursting can generate large number of documents very quickly. A
separate copy of the document you send is made for each recipient. So, if you
“report-burst” a document to 50 people once a day, that’s 250 copies of the
document generated per week.

With report bursting, you cannot use the Overwrite mode option in the
Distribution tab in the Send Document to Broadcast Agent dialog box. Therefore,
if you use report bursting in your organization, your BROADCAST AGENT
administrator should allocate server space accordingly.

Printing a document on different printers

4

Send To
Broadcast Agent

One of the best BROADCAST AGENT features is printing. When you set your
document to refresh and print at night, there’s a copy waiting for you in your
office in the morning.

BROADCAST AGENT is not restricted to the default printer -- it lets you select the
printer you want to use. So, if you set two print actions for the same document,
you can print the document twice but in different locations, in different branches
of your company, for example.

The printers that you use with BROADCAST AGENT must be installed for your
computer, and for the server machine where your administrator has installed
BROADCAST AGENT.

To print a document on different printers with BROADCAST AGENT:

1. Click the Send to Broadcast Agent button on the Document Exchange toolbar.

2. In the Actions tab, click Standard Actions.

3. In the Available Actions list, click Print, then click Add.

268 InfoView User’s Guide



Document Scheduling Tips and Tricks

4. Repeat the previous step.
The Print action is now listed twice in the Selected actions box:

' Standard Actions
Available actions:

Fefresh D ocument -

Two Print actions in the
Selected actions box.

Selected actions:

ove llp |
e Do |
Eraperties... |

You can now specify which printer to use for each print job.

:Print
Custom macros M
SavedsAlf e

SavedsT et LI

5. Click the first Print item in the Selected actions box, then click Properties.
The Select printer dialog box appears:

Select printer E
*t'ou have decided to print the document.
" Select the printer: I\\Amman\hp_2iber j

& {{Ise the default printer of the machine that will process the task

6. Click Select the printer, then select the printer you want in the drop-down list.
Click OK to close the dialog box.

7. Repeat the previous step for the second print job.
e The default printer of the BROADCAST AGENT machine will be used if you
do not follow this step.

*  When you send the document, BROADCAST AGENT server will print it on
the printers you specified.

Personal document processing

A lot of attention in this guide is paid to enterprise-wide information publishing
with BROADCAST AGENT. Did you know that BROADCAST AGENT can also
automatically process documents just for you? Here’s how:

El 1. Click the Send to Broadcast Agent button on the Document Exchange toolbar.

Send To S .
Broadcast Agent 2. In the Distribution tab:

e Switch on Distribute via the Repository
e Switch on Add my name to the list.

3. Set the other options you want in the different tabs, then click OK.
BROADCAST AGENT will send the processed document only to you.
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Publishing a document in rif, text, and pdf formats on different
servers

BROADCAST AGENT can save documents in text, rtf, and pdf formats (as well as
HTML and BUSINESSOBJECTS .rep formats, of course.)

When you choose the Save as text, Save as rtf, or Save as pdf actions for a
document, you can also select the folder where BROADCAST AGENT will publish

the processed document. This means that you can publish a document in
different formats on different servers. Here’s the procedure:

El 1. Click the Send to Broadcast Agent button on the Document Exchange toolbar.

SendT . .
Broadir;s, :gem 2. In the Standard Actions box of the Actions tab:

e Double-click Save As RTF.
e Double-click Save As Text.
e Double-click Save As PDF.
These actions now appear in the Selected Actions box.

3. In the Selected Actions box, click Save As RTF, then click Properties.
The Select Folder dialog box appears:

Select Folder E
1 Select the folder on your server to which pou want Broadcast Agent to
publizh the rich texst files.

One itf file will be generated per repaort sheet contained in the document.

Folder name: I Browse... |

Cancel |

4. Specify the folder where you want the rich text file to be posted, then click OK.
5. Repeat steps 3 and 4 for the Save As Text and Save As PDF action.

6. Set the other options you want in the different tabs, then click OK.
BROADCAST AGENT will publish rtf and text versions of your BUSINESSOBJECTS
document in the folders you specified.

Reminder: Using BROADCAST AGENT to generate RTF versions of BUSINESSOBJECTS
documents can result in very large files. For example, an 800-page
BUSINESSOBJECTS document results in a 50Mb RTF document.
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Condition-based publishing over the World Wide Web

Example

The most dynamic way of publishing information today is over your corporate
intranet, extranet, or the World Wide Web. When you combine this technology
with condition-based processing, where information is only published if the data
fits criteria that you set, the possibilities are endless.

For example, you want to use BROADCAST AGENT to publish a document over the
Web. BROADCAST AGENT takes care of the scheduling (i.e., when the document is
refreshed), the conversion to HTML, and lets you specify the location of your
Web server. Add to that the condition that BROADCAST AGENT will only refresh
the published information if the numbers change in a way that you decide, and
you have a totally automated process. Here’s an example.

I only want to refresh my Web page if revenue falls below $100 000

Your project is to find out why revenue drops below $100 000 in some cities in
some time periods. So, you only want to see documents where revenue is low.

You can have BROADCAST AGENT send you the document if the condition
Revenue<$100 000

is met. If Revenue is above the amount specified in the condition, BROADCAST
AGENT will not send you the document.

To do this:

1. Send the document to BROADCAST AGENT by following “First steps” on
page 238.

2. Click the Actions tab.
3. In the Standard Actions box, double-click Refresh.

4. Click the Editor button in the Conditions group box.
The Formula Editor appears.

5. Define the formula as illustrated here:

=<Revenue:>100000

=
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6. Click OK in the Formula Editor.
In the Send Document to Broadcast Agent dialog box, the following actions
are now set:

' Standard Actions
Available actions: Selected actions:

Refresh Document

Print
Custom macros ﬂl
<< Remove |

Fefresh D ocument
:Condition evalustion

Move Up |
e Do |
_>| Eraperties... |

The order of the actions means that BROADCAST AGENT will first refresh the
document, but will not continue processing it if revenue has not fallen below

$100 000.

7. Set the scheduling and distribution options, then click OK.

What happens if the condition isn’t met?

If a condition isn’t met, BROADCAST AGENT stops processing the document. The
error message Condition not met appears in the Broadcast Agent Console. For
information on using the Console to trace errors, see “Viewing errors in the
Broadcast Agent Console” on page 297.

Starting a new task when another task ends

272

BROADCAST AGENT supports event-based processing, whereby a new task begins
when and only when a previous task has been successfully processed. You
benefit from this feature by using the File Watcher check box in the Scheduling tab,
where you specify a file that must be present before BROADCAST AGENT can
process the document you are sending.

A typical example of using this feature is the DBA who posts a text file to signal
the successful reload of a data warehouse; when the text file is present,
BROADCAST AGENT processes your document.

Regular business users can also gain from using the File Watcher. Let’s imagine
you want BROADCAST AGENT to process and distribute one document only if a
previous document has been successfully refreshed. You can do this by
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combining the File Watcher feature with the text and rtf formats that BROADCAST
AGENT now supports. The result is report chaining, which enables you to process
your reports in an unbreakable sequence.

Testing a database connection before processing a large document

You've been experiencing database connection problems when sending
documents to BROADCAST AGENT. What’s more, the documents you send are
large, which means that you don’t want processing to start unless you're sure that
the connections are working OK.

You can combine the File Watcher and save as text features to test the connection
before processing a large document. You send a “dummy” document which uses
the same database connections as your real documents, i.e., it contains a simple
query on the same universe but takes much less time to refresh. When
BROADCAST AGENT has successfully refreshed the dummy document, it can save
it as a text file, which then triggers the processing of a large document.
BUSINESSOBJECTS deletes the text file every time the main task starts.

Sending the dummy document to test the connection

First, you test the connection like this:

1. Send the dummy document to BROADCAST AGENT (Send To>Broadcast Agent
command, File menu).

2. In the Actions tab, click Standard Actions.

3. Double-click Refresh, then double-click Save As Text.
These two actions now appear in the Selected Actions box. Make sure that
Refresh appears above Save As Text: the actions are performed in the order in
which they appear.

4. In the Selected Actions box, click Save As Text, then click Properties.
The Select Folder dialog box appears.

5. Specify the folder where the text file will be stored, and make a note of it
(you’ll need it when you set up the File Watcher feature later).

6. In the Scheduling tab
e Switch on Time Schedule.
e Switch off File Watcher.
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7.

Set up the time scheduling parameters that you want for the real document,
then click OK.

At the time or intervals you specified, BROADCAST AGENT will refresh the
dummy document, then place the text file in the folder you specified. If the
database connection fails, BROADCAST AGENT will not refresh the document,
and therefore will not save the document as a text file. Thus, the real task will
not start unless the connection is working.

Setting up the File Watcher for the real document

Here’s how to set up your real document so that BROADCAST AGENT refreshes
then publishes it once the database connection has been tested:

1.

Send the document to BROADCAST AGENT (Send To>Broadcast Agent
command, File menu).

In the Scheduling tab:
e Switch off Time Schedule.
e Switch on File Watcher.

In the File to watch for field, specify the path to the server folder that will
contain the dummy text file, and include the file name, e.g.,

\\taipei\My Docunents\nyreport.txt.
where taipei is the name of the server, My Documents is the folder, and
myreport.txt the name of the file to watch for. For information on the syntax

of the path you specify, refer to “How do you indicate where to find the file in
the Scheduling Options dialog box?” on page 132.

Switch on Delete the file each time the task starts.
The File Watcher group box now looks like this:

v File ‘W atcher
File to watch for: I\\taipei\MyDocuments\myreport.txt Browse. .. |

[+ Delete the file each time the task starts

. In the Distribution tab, set the way you want to publish the document, then

click OK.

BROADCAST AGENT will only refresh and publish your large document if the
dummy file has been successfully processed. Also, because the text file will be
deleted every time BROADCAST AGENT processes the large document, you can
set up regular processing knowing that the task will not start unless the
database connection is working.
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Automatic channel publishing

A "channel" is a Web site designed to deliver content from the Internet to your
computer. You subscribe to a channel using Microsoft Internet Explorer, and can
choose to have the information on the channel brought to you every time it
changes.

Scheduled processing and channel publishing make a powerful combination:

* You use BROADCAST AGENT to process your documents and publish them on
a channel.

*  With Microsoft Internet Explorer, Web users subscribe to that channel.

e The information that BROADCAST AGENT generates is automatically
communicated over the Web to the channel subscribers.

To automate channel publishing:

1. Send the document to BROADCAST AGENT by following “First steps” on
page 238.

2. Click the Actions tab.

3. In the Standard Actions box, double-click Channel.
The Publish to Channels dialog box appears.

4. Select the channel, then click OK.

5. Click OK in the Send Document to Broadcast Agent dialog box.

Protecting processed documents with passwords

You can protect all your BUSINESSOBJECTS documents with passwords, even
when you work with BROADCAST AGENT.

When BROADCAST AGENT launches BUSINESSOBJECTS on the server to process the
document, you are not around to enter your password. At that point, the
document’s password is ignored so that BROADCAST AGENT can successfully
process the document. However, users cannot retrieve a password-protected
document from the repository without entering the password.
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To set up password protection for a document that you want to process with
BROADCAST AGENT:

1. Open the document then select the Options command on the Tools menu.

2. Click the Save tab, then type the password in the Protection Password box:

Options E

General Save |Display| Covill I File Locationsl Mew Documentl Macrosl

g *f'ou can customize the way you save documents,

—&pplication Option:

™ Prompt for Document Properties

I~ Automatic Save Eveny: |5_jl Iifutes

r— Options for Current Document
™ Refresh Document When Opening

Fratection Pazsword: wiite Reservation Pazsword:

QK I Cancel | Help |

3. Click OK then confirm the password in the dialog box that appears.

4. Save the document then send it to BROADCAST AGENT.

When BROADCAST AGENT has processed the document, users who retrieve it have
to type their password in the Access Password dialog box:

Access Password E
Enter Pazzword for file gprompt.rep:
I xxxxx T Cancel |
Help |

If the password is wrong, BUSINESSOBJECTS denies access to the document:

BusinessObjects [ <]

& Irwalid password. Please try again.
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Monitoring Your Documents

In BUSINESSOBJECTS, you can view the progress of the documents you have sent
to BROADCAST AGENT by running the BROADCAST AGENT Console. You can also
use the Console to:

See which documents have been successfully processed.

Check information about the documents in process, such as their start and
expiration dates.

Get information on task failure so that you can fix errors that have occurred.

Change task properties and delete tasks.

Note: When you run the Console in BUSINESSOBJECTS, you monitor only the
documents that you have sent to BROADCAST AGENT. If you run the Console as an
application on the server, you can view and manage all the documents that
BROADCAST AGENT is handling.

For more information on working with the Console on the server, see the
Broadcast Agent Administrator’s Guide.
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Opening the Broadcast Agent Console

To open the Console:

¢ Select the Console command on the Tools menu.

Conszole E

Thiz window allows pou ta show or define tazk information.
T )

" View processed tasks Choose to view

The list of documents ——pocument Mame || Status

I processed or non-
and their status Revenue.rep W aiting processed tasks
Properties... Delete | Besalve |
The Broadcast Agent [=ene _ i
you're working with Broadcast Agent Mame: &  Enterpise = Dptions... | Refresh RefreSheIS Thel .
information displayed in
the Console

Lloze I Help

Changing the Console’s display settings

The Console provides information about documents that you have sent to
BROADCAST AGENT. This information is displayed in columns in the Console, and
by default, the only columns you see are Document Name and Status. However,
BUSINESSOBJECTS lets you view a lot more information about waiting or processed
documents.
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To view this information, you add columns to the Console display. You can also
determine how often the information that appears in the Console is refreshed.
Here’s the procedure:

1. Open the Console, then click the Options button.
The Broadcast Agent Options dialog box appears:

Broadcast Agent Options E

’7 Fiefrezh Every: |5_ﬂ minutes ‘

Available columns: Show theze columns:

ove llp |
[ve Do |

Categories
Condition
Crozs-Platform
Delete File ‘W atcher
Description

pesel Ldd > |
oc

Document ype < Bemnaye
Ended at _—I
Error

Expiration D ate

File Syztem Folder

File: ' atcher

First Begin Dat

First Begin Date LI

QK I Cancel | Help |

The Available Columns box lists all the columns of information that you can
displaying the Console.
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Many of the columns display information about the settings you chose when
you sent the document to BROADCAST AGENT. Unless specified otherwise, the
tabs referred to in the following table are in the Send Document to Broadcast

Agent dialog box:

Use this column...

To display this information in the Console...

Batchld

An identifying number that BROADCAST
AGENT assigns to a task.

Categories

The categories assigned to a document.

Condition

The formula the user set when sending the
document by using the Condition option in
the Actions tab.

Cross-Platform

Whether or not the BUSINESSOBJECTS
supervisor chose to process documents on a
Windows-only BROADCAST AGENT (No), or on
any platform (Yes).

Delete File Watcher

Whether or not the user set the Delete the file
each time the task starts option (Scheduling
tab).

Description

The description of the document that the user
entered in the General tab.

Docld

An identification number that BROADCAST
AGENT assigns to a document. One document
may have many Batchlds and Processlds.

Document Type

Indicates whether the document is from
BUSINESSOBJECTS or WEBINTELLIGENCE.

Ended At

The date and time at which BROADCAST
AGENT last finished processing the document.

Error

An error message that the server returns if the
task fails.

Expiration Date

The expiration date that the user set in the
Scheduling tab.

File System Folder

The folder specified for distributing the
document via the server’s file system.
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Use this column...

To display this information in the Console...

File Watcher The path to the file specified in the File
Watcher option (Scheduling tab).

First Begin Date The starting date that the user set in the
Scheduling tab.

Frequency The intervals at which BROADCAST AGENT will
process the document - hourly, monthly, etc.

Host Name The name of the machine on which
BROADCAST AGENT will process or has
processed the document.

HTML Folder The folder specified for distributing the
document via the World Wide Web.

Macro Info Description of VBA macros attached to a
document.

Next Schedule The date and time at which BROADCAST

AGENT will next process the document

Overwrite Mode

Whether or not the newly processed
document will overwrite the previous
version. Corresponds to the Overwrite Mode
option in the Distribution tab.

Owner The name of the user who sent the document.

Priority The priority the user set (Normal, High, Low).

Processld An identification number that the server’s
operating system assigns to a task. Useful if
you want to manage tasks at the server level.

Size Document size in kilobytes.

Started At The date and time at which BROADCAST

AGENT last started processing the document.

Submission Date

The date the document was sent.
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2. Toadd columns to the Console, hold down the Ctrl key, click the columns that
you want, then click Add.

3. Use the Move Up and Move Down keys to determine the order in which the
information appears in the Console.

4. Toremove information from the Console, hold down the Ctrl key, make your
selection in the Show These Columns box, then click Remove.

5. Enter a value in the Refresh Every box, to determine how often information in
the Console is refreshed.

6. Click OK to return to the Console.

Tip: Click a column heading to sort the information displayed. For example, to
sort tasks by Processld, click the Processld column heading.

What does the Resolve button do?

The Resolve button in the Broadcast Agent Console enables you to resubmit a
task that has failed due to a database connection error. For more information, see
“Resolving Database Connection Failure” on page 288.
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Broadcast Agent and Condition Evaluation

Condition evaluation is a BROADCAST AGENT feature that allows you to process a
BUSINESSOBJECTS document based on the result of a calculation in
BUSINESSOBJECTS. A typical scenario is:

* You want to distribute a document to a group of users only when a significant
event occurs, such as a drop in revenue.

* You manage this distribution automatically with BROADCAST AGENT by
requesting that the document be refreshed if a condition is true, for example
that revenue drops below a given sum. In concrete terms you use the Condition
Evaluation feature in the Actions tab of the Send Document to Broadcast Agent
dialog box, using a formula such as

=<Revenue><100000

* BROADCAST AGENT refreshes the document according to the schedule that you
set. In the refreshed document, BUSINESSOBJECTS updates the results of your
formula. What happens next depends on the result:

If the result of the formula is...

Then...

True, i.e., Revenue actually
does drop below $100,000

BROADCAST AGENT distributes the
refreshed document.

False

* BUSINESSOBJECTS closes the document
without saving it.

* BROADCAST AGENT does not distribute
the document, but waits till it is next
due for processing.

* The Condition not met error message
appears in the Console.

Refer to “Condition-based publishing over the World Wide Web” on page 271 for

an example of condition evaluation.

Guidelines for condition evaluation

The guidelines in this section are designed to help you benefit fully from
condition evaluation with BROADCAST AGENT. They cover:

*  Where to place the condition evaluation in the list of actions you want

BROADCAST AGENT to perform

e The types of formulas you can use
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* Advanced calculation information about contexts, and how to get value-
specific results using the WHERE operator.

Refreshing the document before evaluating the condition

Condition evaluation lets you automatically distribute information based on
changes in your business data. The trick is to ensure that BROADCAST AGENT
refreshes your document first. If you set up the document so that the condition
evaluation takes place before the document is refreshed, you're unlikely to get the
results you want.

In the Actions tab in the Send to Broadcast Agent dialog box, set the Refresh
action before you define the formula for the condition evaluation. To do this:

1. In the Standard Actions dialog box, click Refresh.
Refresh is listed twice in the Selected actions box.

2. In the Condition box, click Editor.

3. Define your condition in the Formula Editor, then click OK.
Condition Evaluation appears below Refresh in the Selected Actions box:

' Standard Actions
Available actions: Selected actions:

= Hefre_s_h _ Ffove L |
Print fdd 5> | Condition evaluation
Custom macros = ovaDon |
Save as if < Hemove | :
Save as text LI Eraperties... |

What types of formula can you use for condition evaluation?

* The first variable in your formula must be a measure, such as Revenue.
If the formula is based on a dimension, for example

=<Cust omer >="Ar ai "
you will get an error.

¢ If you want to use a variable as the condition to be evaluated, it too must be a
measure.

e The result of the formula must be Boolean, i.e., either true or false. For
example,

=Revenue>100000
works because the result is either true (over 100,000) or false (below 100,000).
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Calculation contexts and condition evaluation

Example

By default, formulas that you define as conditions when sending a document to
BROADCAST AGENT are calculated at the report level. In other words, even if you
use the keywords Block and Body in BUSINESSOBJECTS extended calculation
syntax, BROADCAST AGENT evaluates the formula is calculated as if the Report
keyword were used.

The result is a value based on the entire report, not a particular dimension or set
of dimensions. (For detailed information on using keywords in formulas, see the
BusinessObjects User’s Guide.) Here’s an example.

Broadcast Agent condition evaluation at the report level

You use the following formula as the condition for a document you are sending
to BROADCAST AGENT:

=Sum <Revenue>) |n Body

where the only dimension in Body is City. However, the document also contains
the Region dimension, which is displayed at the section level.

Thus, the result of the calculation evaluated when BROADCAST AGENT processes
the document will be the grand total revenue for all cities and all regions. The
Body keyword is totally ignored.

Testing the formula before sending the document

Before sending a document to BROADCAST AGENT, you can test the formula in a
cell inserted in the general section of the report. Formulas inserted in the general
section are evaluated with the respect to the whole report, which is exactly what
will happen when you send your document to BROADCAST AGENT.

The idea is to check whether the formula returns the result that you want. If it
does, you can use the formula when you send the document to BROADCAST
AGENT.

Note: You need BUSINESSOBJECTS REPORTER to perform this task.

Here’s the procedure:
1. Open the document that you want to send to BROADCAST AGENT.

2. Make sure that the Formula Bar is displayed. If it isn’t, select the Formula Bar
command on the View menu.
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3. At the very top of the report on which the calculation will be made, insert a

cell:
¢ Select the Cell command on the Insert menu.
e With your mouse, draw the cell area at the top of the report.

4. Click inside the new cell, then click inside the Formula Bar.
5. Type = then type the formula.

6. Press Enter.
The result of the formula appears in the cell.

Getting value-specific results for condition evaluation

Example

Despite the fact that BROADCAST AGENT evaluates formulas at the report level,
you can create value-specific formulas using the WHERE operator. Here’s an
example:

Publishing a document when you hit your sales volume targets

Using the WHERE operator, you can define a formula such as
=<Quantity Sol d> Were (<Product Col or>="BIl ue")>5000

BROADCAST AGENT will only publish the document if the number of blue
products sold goes over 5000.

Restrictions on value-specific formulas
When you type your formula for the condition evaluation, and you can specify
values from different variables using AND, like this:

=<Revenue> Were ((<Year>="FY95") AND (<Resort>="Hawaii an
Cl ub"))>100000

However, AND is the only operator that you can use. If you try to use OR, <> or
NOT, for example

=<Revenue> Were ((<Year>="FY95") OR (<Resort>="Hawaii an
Cl ub"))>100000

the following error message appears:

Syntax Error [DMBD0OOY) E

@ Syntax Error [DMBO0OT)
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How to get around this problem

Create a variable from your formula before you send the document to
BROADCAST AGENT. Then, all you have to do is use the variable in the condition
formula. Here’s how to do it:

1. In BUSINESSOBJECTS, make sure the Formula Bar is displayed. If it is not, select
the Formula bar command on the View menu.

2. Insert or click inside a blank cell in the report.

3. Type the formula that you want to use as the condition, then press Enter.
A1 appears in the cell in the condition is true, 0 if it is false.

4. Select the Define as Variable command on the Data menu.
The Define as Variable dialog box appears:

Define the variable E

Mame: ||

Ealuation of the farmula
Do you want to:
= Evaluate the formula in its context

{* Keep the farmula generic

=Sum[<Revenue: ] Where [<vear>="Fr'35"> 100000

=
[<]

[k | Cancel | Help |

5. Type a name for the variable in the Name box.

6. Use the option Keep the formula generic, then click OK.

When you send the document to BROADCAST AGENT:

1. Click the Editor button in the Actions tab of the Send Document to Broadcast
Agent dialog box.

2. In the Formula Editor that appears, double-click the name of the variable that
you created.

3. Complete the formula, then click OK.
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Resolving Database Connection Failure

In BUSINESSOBJECTS, you need a user name and password to launch an
application, and to connect to the database where your business data is stored.

BUSINESSOBJECTS enables you to work with a single set of user names and
passwords thanks to the BOUSER and BOPASS variables. BOUSER and BOPASS
store the user name and password you enter when you launch a BUSINESSOBJECTS
application, and pass these to the database connection you need to interact with
your database. The universe designer can specify that the connection to the
database is managed by these variables, so that when you launch
BUSINESSOBJECTS, the user name and password you enter are reused for the
database connection.

Simplified security and guaranteed processing

BOUSER/BOPASS security clearly simplifies the work of the person who sets up
BUSINESSOBJECTS at your site. In addition, the BUSINESSOBJECTS supervisor can
switch on a No Password Checking feature so that the password you enter when
you launch any BUSINESSOBJECTS application is systematically ignored.

What happens if the BUSINESSOBJECTS supervisor switches on No Password
Checking, and uses BOUSER/BOPASS? How can BROADCAST AGENT process a
document without the password required to access the corporate database?

BROADCAST AGENT can process documents in configurations where No Password
Checking and BOUSER/BOPASS are used, thanks to the repository. When you
send a document to BROADCAST AGENT, the password you used to launch
BUSINESSOBJECTS is passed to the repository’s security domain. The password is
stored (and encrypted) in the JOB_DATA column of the DS_PENDING_]JOB
table of the security domain.

So even though BUSINESSOBJECTS ignored your password when you launched the
application (because the supervisor used the No Password Checking feature), your
password is recorded in the repository, and can be reused by BROADCAST AGENT.
The database connection required to refresh your document now works, because
it “knows” the password.
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What if the database connection password changes?

Between the time you send the document to BROADCAST AGENT and the time
BROADCAST AGENT will start processing the document, the database connection
password can be changed, for example by your Database Administrator (DBA).
In this case, BROADCAST AGENT fails to process the document because the
database connection password is wrong.

No problem: with BROADCAST AGENT you can reset your password so that the
database connection can work. Here’s how to do it:

1. Get the new database connection password from your DBA.

2. Relaunch BUSINESSOBJECTS and enter the new password in the Password field
of the User Identification dialog box.

3. Select the Console command on the Tools menu.
The Console appears.

4. Make sure that View non-processed tasks is selected, as shown here:

Conszole E

Thiz window allows pou ta show or define tazk information.

" View processed tasks

Document Mame I Statuz |

Efazhion.rep W aiting

Efazhion.rep W aiting

Eroperties... Welete | FEesalie |

— General

Broadcast Agent Mame: & Development =~ Options... | Refresh |

Lloze I Help |
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5. Click the failed task in the document list.
* Note that the task’s status is Waiting, not Failed.
e Ifyou are not sure which document to select, select all Waiting documents.

6. Click Resolve.
BUSINESSOBJECTS resets your password in the JOB_DATA column on the
security domain of the repository. This password is then used in the database
connection required to refresh the document.

Note: The Resolve button is only available in the Console that you use in
BUSINESSOBJECTS. It is not available when you run the Console on the BROADCAST
AGENT machine.
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Avoiding Problems Before You Begin

You should be aware of the following known limitations before sending your
documents to BROADCAST AGENT.

Can you use BOUSER/BOPASS security with report bursting?

Report bursting is the BROADCAST AGENT feature that distributes a copy of a
processed document based on user profiles. You activate report bursting by
selecting Refresh with the Profile of Each Recipient in the Actions tab of the Send to
Broadcast Agent dialog box. For more information about this feature, refer to the
example entitled “Report bursting” on page 267.

If your supervisor has switched on the No Password Checking feature in
SUPERVISOR, and has set up BOUSER/BOPASS security, report bursting does not
work. Here’s why not.

When BROADCAST AGENT “report bursts” a document, it processes one copy of
the document for each user, according to the user’s profile set by the supervisor.
So, for each user, BROADCAST AGENT:

* Opens one copy of the document in BUSINESSOBJECTS on the server.

* Refreshes each copy of the document using the security information for each
user.

With BOUSER/BOPASS security, the user name and password the user entered
when launching BUSINESSOBJECTS is used to gain access to the corporate database.
But the user who launched BUSINESSOBJECTS and scheduled a document using
report bursting does not have the user name/password combination as that of
each recipient of the document. BROADCAST AGENT launches BUSINESSOBJECTS on
the server with the profile of each recipient, so fails to connect to the corporate
database, precisely because the user name and password for the recipient are
different from those entered by the person who scheduled the document in the
first place.

The way round this problem is to avoid using BOUSER/BOPASS security if you
intend to use report bursting.
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Does the document contain OLAP data providers?

292

In BUSINESSOBJECTS, you can retrieve data from OLAP servers such as Hyperion
Essbase and Oracle Express, provided that you have installed the
BUSINESSOBJECTS Access Pack for these products. This section covers what you
can and can’t do when you schedule documents containing OLAP data
providers.

Scheduling documents containing Microsoft OLAP Services data
providers

You can schedule documents containing data providers built on a Microsoft
OLAP Services database, but in limited circumstances only.

Microsoft OLAP Services authenticates users with Windows NT security
information. In other words, it’s your Windows NT login, not your
BUSINESSOBJECTS login, that gives you access to the data in your Microsoft OLAP
Services database. When you manually refresh a BUSINESSOBJECTS document
containing a Microsoft OLAP Services data provider, the database retrieves your
NT user name and password from your NT system; if these are the same as the
user name and password defined for you by your NT administrator on the
Microsoft OLAP Services side, you gain access to your data, and successfully
refresh your document.

So how do you refresh your document using BROADCAST AGENT? The
BROADCAST AGENT workflow to process a document containing Microsoft OLAP
Services data providers is as follows:

* Ahead of time, your BROADCAST AGENT administrator defines an NT user
name and password to start BUSINESSOBJECTS on the server.

e At the scheduled time, BROADCAST AGENT launches BUSINESSOBJECTS on the
server, using the user name and password defined by the BROADCAST AGENT
administrator.

e To allow BUSINESSOBJECTS to retrieve data from the database, Microsoft OLAP
Services checks the NT user name and password defined on the server
machine where BUSINESSOBJECTS is active.

e If the NT user name and password on the server machine running
BUSINESSOBJECTS are the same as those defined on the Microsoft OLAP
Services side, BUSINESSOBJECTS gains access to the data, and refreshes the
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document. If the user names and passwords are different, BUSINESSOBJECTS
cannot refresh the document, and BROADCAST AGENT returns a failed task.

In summary: the administrator can enable you to schedule documents
containing Microsoft OLAP Services data providers by defining a database
account with the user name and password also defined for BROADCAST AGENT.
Be aware that BROADCAST AGENT will refresh the scheduled document with
the rights of the NT administrator.

Report bursting documents with OLAP data providers

Report bursting is the BROADCAST AGENT feature that distributes a copy of a
processed document based on user profiles. You activate report bursting by
selecting Refresh with the Profile of Each Recipient in the Actions tab of the Send to
Broadcast Agent dialog box. For more information about this feature, refer to the
example entitled “Report bursting” on page 267.

You can report burst documents containing OLAP data providers built on
Essbase or IBM DB2 for OLAP servers. You cannot, however, report burst
documents built on the other OLAP data providers available with
BUSINESSOBJECTS, namely, Express, MetaCube, SAP Business Intelligence
Warehouse (BW), and Microsoft OLAP Services. Here’s why not.

When you build an OLAP data provider in BUSINESSOBJECTS, you have to enter
the user name and password that lets you access the OLAP database itself. When
you schedule a document containing an OLAP data provider, BUSINESSOBJECTS
prompts you to enter that same user name and password, stores that information
in the document, and lets BROADCAST AGENT reuse it when BROADCAST AGENT
processes the document.

The advantage of report bursting is that BROADCAST AGENT refreshes the
document based on the profile of each recipient. Each user’s profile is determined
by a user name and password, which in the case of documents with OLAP data
providers, is entered by users when they schedule documents. (To see how this
works, refer to “What to do if the OLAP User Identification dialog box appears”
on page 251). Therefore, BROADCAST AGENT processes the document once for
each recipient, but in each case with the same profile, in other words, the same
user name and password that the user entered when scheduling the document.

Why report bursting does work with Essbase and IBM DB2 for OLAP data providers

The reason that report bursting does work with Essbase and IBM DB2 for OLAP
is as follows: users can connect to these OLAP servers by typing
@variable(“BOUSER”) and @variable(“"BOPASS”) instead of entering their full
user name and password. These are the variables described under “Resolving
Database Connection Failure” on page 288. Using these variables means that
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BROADCAST AGENT can retrieve the user name and password for each recipient
when processing the document, and can use that information to generate a
version of the document per recipient.

The restriction on No Password Checking, described under “Can you use
BOUSER/BOPASS security with report bursting?” on page 291, also applies
here. You can only use report bursting as described above if the supervisor has
switched on Full Password Checking.

What to do if the password to the OLAP server changes
Imagine the following scenario:

* You have scheduled a document containing an Oracle Express data provider,
and have chosen Refresh With The Profile of Each Recipient, i.e., report bursting.

* BROADCAST AGENT successfully “bursts” your document, thanks to the
implementation of BOUSER/BOPASS security, as described above.

* Your server administrator changes the password to the Express server.
Therefore, your password is no longer the same as the one required to access
your data. BROADCAST AGENT cannot process your document without that
information.

In this case, you have to make your password the same as the one of the OLAP
server. Your BUSINESSOBJECTS supervisor can do this for you, or you can do it
yourself in BUSINESSOBJECTS (Change Password command, Tools menu). If you
do it yourself in BUSINESSOBJECTS, make sure you are connected to the repository,
i.e., not working in offline mode.

Does the document return a Cartesian product?

294

If you schedule a document that contains a Cartesian product, document
processing may fail if the universe designer has prevented you from executing
queries that return Cartesian products.

Note that the designer may have granted you the right to create a document with
a Cartesian product, then later removed this right.
What you can do

Either change the condition in the document to avoid a Cartesian product or ask
the designer to change the universe parameters to allow Cartesian products.

For more information about Cartesian products, see the Designer’s Guide.
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Does the document use the @variable function?

If you start BUSINESSOBJECTS with a command line such as
busobj . exe -vars nyvar.txt

and send a document containing variables, for example
@ari abl e(' MYVAR' )

this document is refreshed locally on the client machine. Therefore, if you send a
document to a BROADCAST AGENT located on another machine, and the variables
are not defined on the server machine, all the tasks (documents) needing the
variable definition will fail.

What you can do

Share the file containing the variable definitions or copy it onto the server
machine.

The file specified contains the variable definitions, and will be used by all the
tasks that need them.

Does the document contain user objects?

BUSINESSOBJECTS REPORTER users can create their own objects, called user objects,
when the objects in their universes do not give them the data they need. (Working
with user objects is described in the BusinessObjects User’s Guide.)

BROADCAST AGENT can process documents containing user objects, but the user
objects will be ignored. This means that you will not obtain the data from these
objects; the corresponding data simply won’t be in your document. BROADCAST
AGENT returns an error message to the Console (Sorme obsolete objects have been
removed).

Note: This error is not specific to user objects. It also appears when, between the
time you sent your document and the time BROADCAST AGENT processes it, the
universe designer has removed objects that you use in your document, and
exported the universe to the repository.
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What you can do

The best solution to this problem is to avoid sending documents containing user
objects to BROADCAST AGENT. User objects are designed for individual use; if you
need them for general use across your company or organization, you should have
the universe designer turn the user objects into regular universe objects.

Using BUSINESSOBJECTS REPORTER, you then must:

1.
2.
3.
4.
5.

Import the updated universe from the repository.
Remove the user object from the query.

Add the new object created by your universe designer.
Run the query.

Send the document to BROADCAST AGENT again.

For information on importing universes and editing queries, see the
BusinessObjects User’s Guide.
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Understanding and Fixing Errors

BROADCAST AGENT can fail to process your documents for many different
reasons. To help you to fix each type of processing error, BROADCAST AGENT
returns a error message which you can display in the Broadcast Agent Console.

Viewing errors in the Broadcast Agent Console
To view errors in the Console:
1. Select the Console command on the Tools menu in BUSINESSOBJECTS.

2. Click the Options button.
The Broadcast Agent Options dialog box appears.

3. In the Available Columns box, double-click Error, then click OK.
The Broadcast Agent Options dialog box closes, and the Error column is now
visible in the Console:

Document Mame | Status | Error |

All the errors that BROADCAST AGENT returns are described in the Error Message
Guide. You can consult the guide on-screen by selecting the Error Messages
Explained command on the Help menu.
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Using macros to define custom error messages

You can create your own BROADCAST AGENT error messages using a custom VBA
macro. BUSINESSOBJECTS user defined error message numbers start at 3000. You
can create a description that indicates the reason for failure. Note that once an
error is raised, the macro will exit.

Here is some sample code to get you started.

Example Custom error message for Broadcast Agent

Sub GenCustonError ()
On Error GoTo ErrorHandler ' Enable error-handling

routine....

Exit Sub
Err or Handl er: " Error-handling routine.
Err. Rai se 3100, , "Error Text Here."

End Sub

Sub RefreshCust onError()
On Error GoTo ErrorHandl er ' Enabl e error-handling routine

Di m Doc as Docunent
Set Doc = Application. Docunents.|tem(1)

Doc. Refresh
Exit Sub

ErrorHandl er: 'Error-handling routine
Err. Rai se 3200,,"Error Text Here."
endi f
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Enhancements Over Document Agent Server

This section describes the enhancements that BROADCAST AGENT delivers to fix
problems that required troubleshooting with DOCUMENT AGENT SERVER.

Improved error management

DOCUMENT AGENT SERVER handled two types of error messages:
e Four-digit codes such as 3002.

* Long text messages which were only available on the secondary DOCUMENT
AGENT SERVER machine.

BROADCAST AGENT returns long text messages which you can display in the
BROADCAST AGENT Console, in BUSINESSOBJECTS (Console command, Tools
menu), in your Web browser using INFOVIEW, and on the BROADCAST AGENT
machine.

For information on displaying information in the Console, see “Changing the
Console’s display settings” on page 278.

Documents with query prompts

Query prompts incite you to select values when you create or refresh a document
in BUSINESSOBJECTS. The values you select filter the data that BUSINESSOBJECTS
subsequently returns to the document. Prompts can be defined in the query itself,
or in the universe, by the universe designer.

When you send a document to BROADCAST AGENT, if you have requested to
refresh the document, and if the document contains prompts, BUSINESSOBJECTS
displays the Enter or Select Values dialog box:

Enter or Select Yalues E

[h |

Select a nationality Cancel |
Help |

Walues... |

You enter the values that will filter the document, then click OK. BROADCAST
AGENT will use these values when processing your document.
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DOCUMENT AGENT SERVER 4.1 also supported documents with prompts.
However, DOCUMENT AGENT SERVER failed to process documents containing
prompts if the universe on which the document was built was modified in any
way between submission and processing time.

BROADCAST AGENT can process documents with prompts even if the universe
changes between submission and processing time.

Documents with contexis

A context lets users select one of two paths between database tables when
running a query on a universe.

In 4.1, tasks sent to DOCUMENT AGENT SERVER failed if:

e The document contained a query that prompted the user to select a context,
and

¢ The universe designer had exported a modified version of the universe to the
repository since the last time the document was refreshed.

BROADCAST AGENT now successfully processes documents which require
contexts, even if the universe designer has modified the universe.

For more information about contexts, see the Designer’s Guide.

No Password Checking with BOUSER/BOPASS

300

DOCUMENT AGENT SERVER was unable to process documents where:

e The supervisor set up your BUSINESSOBJECTS user name and password and
activated the No Password Checking option, and

* Theuniverse designer set up the connection to the corporate database with the
BOUSER and BOPASS variables.

Thanks to changes made to the repository, this is no longer the case with
BROADCAST AGENT. see “Resolving Database Connection Failure” on page 288 for
more information.
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What Is Web Publishing?

Example

Example

“Web publishing” is the communication of information by making documents
available on the World Wide Web. This involves:

e Converting documents into Hypertext Markup Language (HTML), the format
that is recognized by Web browsers.

* Placing documents on a Web server, so that people browsing the Web or
working on an intranet can access them.

Note: In this chapter, the term “documents” refers to BUSINESSOBJECTS .rep files.
A document can contain one or many reports. Each report has its own tab inside
the document.

The Web is quite simply the best way to tell the world about your business. It
allows online users to view and download up-to-the-minute information.

You can publish documents both externally, on the Internet, or internally, on
your corporate intranet. The following examples show how useful each can be:

Publishing on the Internet

On your corporate Web site, you want to illustrate the company’s exponential
growth over the last financial year. You create a BUSINESSOBJECTS document
which displays the growth curve in a column chart.

You save the document in HTML format, then post it in your Web site.

You use BUSINESSOBJECTS internally to report on weekly sales performance. By
publishing your documents on your intranet, the sales force can get the
information they need using their Web browser.
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Publishing to Microsoft Channels

BUSINESSOBJECTS lets you publish documents to channels, Web sites designed to
deliver content from the Internet to your computer. You subscribe to a channel

using Microsoft Internet Explorer, and can choose to have the information on the
channel brought to you every time it changes.

People who use your Web site or Intranet can thus subscribe to documents: every
time you refresh the documents, you automatically deliver the information to
your subscribers.

For more information, see “Publishing Documents to Channels” on page 320.

How is this different than sharing documents with InfoView users?

When you Web publish a BusinessObjects document, you use BUSINESSOBJECTS to
create your documents, you publish them in HTML format, then you post those
HTML versions on a corporate intranet, extranet, or the World Wide Web.

On the other hand, BUSINESSOBJECTS users can share documents seamlessly with
INFOVIEW users via the repository. The first time an INFOVIEW user asks to view
a BUSINESSOBJECTS document in HTML format, the server converts the document
into HTML format at that time, then displays it in the user’'s Web browser.

A copy of that file remains in the browser’s cache until the end of the INFOVIEW
session. That way, the document can be displayed more quickly should the user
want to view the document again.

For more information, see Tip: "The Open on Retrieval option in the Retrieve
dialog box automatically opens all documents that you retrieve. If you activate
Open on Retrieval then double-click a document name in the Retrieve dialog box,
the document appears immediately in BUSINESSOBJECTS." on page 209. For more
information on INFOVIEW, see the INFOVIEW documentation in the first part of
this manual.

The Web publishing process
This section describes the steps involved in the BUSINESSOBJECTS Web publishing

process. It also contains an illustration of a published document, which highlights
features such as navigation, graphics conversion and frame support.

304 InfoView User’s Guide



What Is Web Publishing?

Step 1: Generating an HTML document

The first step in Web publishing is to generate an HTML version of your
document. Afterward, you can do either of the following:

e Save the document by using the Save As command on the File menu.
* Send the document to BROADCAST AGENT.

BROADCAST AGENT handles scheduled processing. It is described in full in
Chapter 10 "Scheduling BusinessObjects Documents" on page 229.

Tip: You can add your own HTML to documents. For example, you can include a
jump to a Web page. For more information, see “Writing HTML in Documents”
on page 309.

Step 2: Placing the HTML document on a Web server

The second step in Web publishing is to place the document on a Web server. The
following table shows how the way you do this depends on the way you
completed the previous step:

If you... Then You...

Used the Save As command Must place the document on the
server by moving it through the file
system.

Sent the document to BROADCAST Can have BROADCAST AGENT
AGENT automatically place the document
on a server you specify.

Note: You cannot protect a BUSINESSOBJECTS document with a password if you
are publishing it on the web.
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Frequently asked questions

The following table provides answers to some frequently asked questions about
Web publishing with BUSINESSOBJECTS.

Questions

Answers

Documents with many reports

If my document contains several
reports, can I specify the ones [ want
in the .htm document?

You can include all, some or only
one report in the .htm document.
Each report you include has a

corresponding tab in the browser.

Downloading documents
Can I let other users download the
document to BUSINESSOBJECTS?

Yes, but you can also choose not to
let other users download the
document.

Graphics resolution
How do graphics come out?

BUSINESSOBJECTS converts all charts
and pictures to .gif format.

Frames
Are frames supported?

Yes.

Formats
What about formatting (fonts,
borders, background colors, etc.)?

Formats appear in the .htm
document as they do in
BUSINESSOBJECTS. Font sizes,
however, are approximate.

Report layout
Does report layout stay the same?

Yes.

Automatic reload

Can I automatically load the
published .htm file at regular
intervals?

Yes. You can specify the interval at
which you want the document to be
reloaded. Any changes in the
document in BUSINESSOBJECTS will
be mapped to the published file.

Navigation
Is there a way of including jumps to
report sections?

Yes. With BUSINESSOBJECTS, you can
publish a report in one HTML page,
Or on a one-page-per section basis.
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HTML objects

Example

Web publishing involves not only BUSINESSOBJECTS but also DESIGNER. This
section briefly describes how the universe designer can create HTML objects in
BUSINESSOBJECTS universes.

An HTML object maps to columns in a relational database, just like any other
object. Its added feature is an HTML “wrapper” that enables users to drill down
in published documents. Here is an example:

Definition of an HTML object

The universe designer creates an object named City. When included in a query,
City returns a list of city names. When the user publishes the document
containing data returned by City, anyone viewing the published document can
click on a city name and drill to a map showing the city’s exact location.

The object definition contains the SQL required to retrieve the data from the
database, plus HTML that provides a dynamic link to the image files:

‘<a href="web/&City.city_name’.gif”"> Gty.city_name’ </a>

Data retrieved by HTML objects is underlined in published documents, which
indicates that you can click a value to drill down.
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A published document

The following illustration shows a published document and points out:

* How you can navigate between reports, report sections, and view all sections
as one page.

e How to download the document.

Bahamas Beach
French era
Hawaiian Club

iew full report

Annual Report

Bahamas Beach

Year Mumber of gu

|

d Download

a. BUSINESSOBJECTS can publish reports section by section. The user viewing the report
clicks a section name in the frame, and the section appears in the browser. The user
can also click View full report to display the report in one page.

b. Pictures are converted to .gif files.
The layout of blocks, cells and pictures is respected in the published document.

d. In a BusINESSOBJECTS document, each report is identified by a tab. This is also the case
in published documents. The user clicks a tab to switch to a different report.

e. The Download option allows users to download the document, then continue to work
on it with BUSINESSOBJECTS on their desktop.

Figure: A document published on the Web
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Writing HTML in Documents

This section explains how you can add your own HTML to documents. It
concerns you if you understand HTML and want to use your knowledge to
customize your documents before publishing them on the Web. If you just want
to find out about saving documents in HTML format, see “Saving Documents in
HTML Format” on page 311.

You can easily add hyperlinks such as email addresses and web site addresses to
your reports. BUSINESSOBJECTS automatically recognizes certain keywords or
symbols included in the address, adds any extra syntax behind the scenes and
formats the address as a hyperlink. Hyperlinks you add to a BUSINESSOBJECTS
report are retained when you save the report in PDF or in HTML format.

BUSINESSOBJECTS automatically recognizes the keywords, syntax and symbols in
the table below and turns them into hyperlinks:

Keyword or syntax Automatically recognized and formatted as....
HTTP or www HyperText Transfer Protocol

MAILTO or @ Electronic Mail

FILE Host-specific Files

<a href specified in the HTML code

FTP File Transfer Protocol

NEWS Usenet news

TELNET Telnet Protocol for Interactive Sessions
GOPHER Gopher and Gopher+ Protocols

WAIS Wide Area Information Servers Protocol
PROSPERO Prospero Directory Service

NNTP Usenet news using NNTP access
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Example

How are hyperlinks formatted?

If you have Microsoft Internet Explorer installed, hyperlinks in BUSINESSOBJECTS
reports are formatted according to the settings you have made in Internet
Explorer. If Internet Explorer is not installed on your computer, unused
hyperlinks are formatted in blue and underlined.

Note: You can only write HTML in documents if you are working with the
BUSINESSOBJECTS REPORTER or EXPLORER module.

Before saving a document in HTML format, you can customize it by adding your
own HTML coding. When you publish the document on the Web, the HTML you
added is embedded inside it. Here is an example:

Providing a link to another Web site from a published document

Your company works in partnership with other companies. Your corporate Web
site contains BUSINESSOBJECTS documents that show the combined performance
of your organization and that of your partners. In each document, you provide a
link to the partner’s Web site by inserting the required HTML in a document cell,
ie.,

<A HREF="ht tp://wmw. part nersi t e. cont >Click here to go to our partner’s
Web sitel</ A>

To write HTML in a document:
1. Click inside a part of the document where you want to insert HTML.
2. Insert a new, free-standing cell.

3. Click inside the cell, write your HTML and press the Enter key or click out of
the cell.
BUSINESSOBJECTS automatically detects the hyperlink and formats
accordingly.

Note: Selecting and resizing cells containing hyperlinks can be a little tricky
because every time you click on the cell, the hyperlink is activated. Make the cell
containing the hyperlink longer than the actual text inside it so that you can select
the cell after the address without activating the hyperlink.
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Saving Documents in HTML Format

When you save a document in HTML format, you can allow other users to
download the document. The advantages of this feature are twofold:

* Quick and easy distribution, especially on an Intranet. You publish a
document once, and all your users can download it.

e BUSINESSOBJECTS downloads all the data in the document, which means that
users can continue to work on the document on their own computer. For
example, they can perform analysis to view the results they want.

Users can also refresh the data, provided they have the right to use the
connections required.

BUSINESSOBJECTS also provides formatting options to ensure that the formats you
have applied to your document appear in the HTML version. Finally, navigation
options make it easy for users to find the information they want when viewing
published documents on the Web.

This section provides information on character support, and describes how to:
* Save a document in HTML format

* Allow other users to download the published document

* Select formatting options

* Set up navigation to provide links to report sections.

What happens to special characters in HTML?

If you're planning to distribute information over the World Wide Web or your
corporate Intranet by saving BUSINESSOBJECTS documents in HTML format, you
should be aware of the following limitations in characters that you use in your
document data, document names and report tab names.

Characters supported in document data

Your documents may contain data that may appear in Euros, or other “special”
characters. These special characters are supported in HTML if the browser used
also supports them. If the browser does not support special characters, they are
displayed as Unicode symbols.
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Characters supported in document names and report tab names

The characters that you can use in the names of documents that you save as
HTML files depend on your operating system. If the operating system supports
a character, then you can use it in the name of your HTML document.

Characters not supported by your operating system will be replaced by an
underscore (_). For example, if the space character is not supported, My
Document.rep becomes My_Document.htm.

Any characters other than A-Z and 0-9
(ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456
789) that you use in report tab names will be replaced by an underscore in the
HTML document. So, if your document contains a tab which you renamed to
Sales%, this will appear as Sales_ in the HTML document, where the underscore
(L) replaces the % sign.

Note: Your company or organization may be planning a BUSINESSOBJECTS
deployment on different operating systems. What one operating system
supports, another may not. For information on operating system support, refer to
the Deployment Guide.
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Saving a document in HTML format

To save a document in HTML format:
1. Make sure the document is open in BUSINESSOBJECTS.

2. Select the Save As HTML command on the File menu.
The Save As dialog box appears. The HTML format (*.htm) option is already
selected in the Save as type box:

Save As HE
Save jn: IaUserDocs j gl lg =

Annual
Beach
Evvalkit

@ Annual htm

File name:

Guest Save I
Save as yper [HTML format (= him) =l Cancal |
I~ Save for all users Options... |

3. Move to the folder in which you want to save the document, type its name in
the File name box.
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4. Click Save.
The HTML Options dialog box appears:

Save Options E
HTH

L
@ Irv thiz dialog box, you can select options for zaving the document in HT L
farmat.

File Mame IAnnuaI

=5

— Format:

¥ Display Charts and Pictures

&l Reports in Document IV Use Frame

" Select Reports: V' Barders

V' Background Calors

V' Teut Colors

V' Eorts

V' Free-fom Layout

I Automatic Reload Every Wﬂ minutes

™ BusinessObjects Document

Generate HTML
’7 * Allin one page = Section by section " Both ‘
QK I Cancel | Help |

5. In the Save group box, select an option to specify which reports from the
document you want to save in HTML format:
e Current Report saves only the report that is displayed on your screen.
e All Reports in Document saves all the reports in the document.
e Select Reports lets you select just the reports you want.

6. Check BusinessObjects Document to allow other users to download the
document.

7. Select formatting options in the Format box.
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8. Select an option in the Generate HTML group box.
These options affect the way users can navigate through the document in their
Web browser, and are described in the following table:

This option... Publishes each report... And enables users to...
All'in One Page | As one HTML page. Print or search whole
reports.
Section Per With a browser which Jump from section to
Section contains a link to each section, especially useful
report section. in large reports.
Each section generates
one HTML file.
Both Displays the browser as | Switch between the one-
with the Section Per page view and the per-
Section option, but also section view.
lets users view the report
in one page.

9. To save the HTML document with the options you selected, click OK.
* BUSINESSOBJECTS makes a copy of the document and saves it in HTML
format.
¢ The original document remains on your screen.

For information on viewing, navigating and downloading Web-published
documents, see “A published document” on page 308.
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Files and folders created with HTML documents

When you save a document in HTML format, BUSINESSOBJECTS creates a number
of files and folders. These files and folders manage graphics, navigation,
downloading, frames and multiple reports in the same document. They are all
located in the UserDocs folder, and are described in the following table.

Note: The table lists all the files that can be created. This is the case when you
select the Both option in the Save Options dialog box. For information on this and
the other options available, see “Saving a document in HTML format” on

page 313.

Folders Files

Name Name Purpose

Same as the document | Docl i nks. ht m A navigation frame on
you saved. the left of the
published document.

Downl oad. ht m A link to download the
document.

*.rep The BUSINESSOBJECTS
document to
download.

Same as the report(s) *.gif One image per chart
in the document. and picture in the
report.

n. ht m One link per section.

reportname. ht m A link for users to view
the report as one page.

seclinks. htm A link to view one
page per section.
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Web Publishing with Broadcast Agent

BROADCAST AGENT provides scheduled (or batch) processing of documents.
BROADCAST AGENT can refresh, print and distribute documents at specified times
or intervals. It can also save documents in HTML format and publish them on a

Web server.

This section describes how you, the end user, can have BROADCAST AGENT
publish your documents on a Web server. More information on BROADCAST

AGENT is also available:

Information on...

Is available in...

How the BROADCAST AGENT
administrator sets up and manages
the server

The BusinessObjects Deployment Guide
and the Broadcast Agent
Administrator’s Guide

How BROADCAST AGENT works

“What can Broadcast Agent do?” on
page 231.

Having BROADCAST AGENT perform
other tasks (printing, refreshing etc.)

“Scheduling a Document” on
page 237.

Advantages of Web publishing with Broadcast Agent

BROADCAST AGENT provides powerful and reliable Web publishing. It can:

e Save documents in HTML format.

e Publish these on a Web server that you specify.

* Refresh the documents at set intervals, so that the data published on the Web

is always up-to-date.
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The following illustration shows the advantages of Web publishing with
BROADCAST AGENT:

e Send Document to Broadcast Agent =] 2

— P Geneial | actions | Categaries | Seheduiing | Distibution | —P ﬂ | <:>
Ia oy el

N

Server 5 Enieipiise Eiorty Normal - Broadcast Agent

Description

T
Hawaiian Club

View full report

Annual Report

Bahamas Beach

HNumber of gut
e

S |

Download

a. You send a document to BROADCAST AGENT by clicking the Send To Broadcast Agent
button on the Document Exchange toolbar in BUSINESSOBJECTS.

b. You specify the Web server on which BROADCAST AGENT will publish the document, and
specify refresh intervals (e.g., every day at midnight). You also set HTML options to control
the display of the published document (e.g., in frames, with or without download, etc.).

C. BROADCAST AGENT converts the document o HTML format, publishes it on the Web server,
and refreshes it at the intervals you specified. At each refresh, BROADCAST AGENT brings up-
to-the-minute data from the database to the published document.
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To Web publish a document with Broadcast Agent

A

Send to
Broadcast Agent

You can only publish a document with BROADCAST AGENT if the following
conditions are met:

Your supervisor has granted you access to BROADCAST AGENT.
You are working online.
The document is open in BUSINESSOBJECTS.

You can submit only one document at a time, so if several documents are
open, only the active document is sent.

Here are the steps:

1.

Click the Send to Broadcast Agent button on the Document Exchange toolbar.
The Send Document to Broadcast Agent dialog box appears.

In the General tab, select the server and the document’s priority, and write a
description of the document if you like.

In the Distribution tab, check Distribute via Web Server.

The field below the checkbox indicates the path to the folder that will receive
the published document. Specify a folder by clicking Browse, or by typing a
path, e.g., \ \ Host Nane\ Fol der Nane.

Set options for the HTML version of the document by clicking the HTML
Options button.
The options in the dialog box that appears are described on page 314.

In the Actions tab, specify the actions you want BROADCAST AGENT to
perform.

Click the Scheduling tab and specify the time or intervals at which you want
BROADCAST AGENT to process the document.

Click OK.

Tip: For more information on publishing and distributing documents with
BROADCAST AGENT, see Chapter 10 "Scheduling BusinessObjects Documents" on
page 229.
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Publishing Documents to Channels

A channel is a Web site designed to deliver content from the Internet to your
computer. You subscribe to a channel using Microsoft Internet Explorer version
4.01 or higher, and can choose to have the information on the channel brought to
you every time it changes.

BUSINESSOBJECTS lets you can publish documents to channels. People who use
your Web site or Intranet can thus subscribe to BUSINESSOBJECTS documents:
every time you refresh the documents, you automatically deliver the information
to your subscribers.

Who sets up and manages channels in BusinessObjects?

Your BUSINESSOBJECTS supervisor is responsible for setting up and managing the
channels. You can only publish to channels if you have access to BROADCAST
AGENT. The BUSINESSOBJECTS supervisor sets up channels for each user group
with BROADCAST AGENT access.

Privileged users can also set up and manage channels in BUSINESSOBJECTS. For
more information, see “Setting up and managing channels in BusinessObjects”
on page 322.

How do you subscribe to a channel in Internet Explorer?

First, you have to be using Microsoft Internet Explorer (IE) 4.01 or higher.
Browsers from other vendors, and previous versions of IE do not support
channels.

To subscribe to a channel in IE:
1. On the toolbar, click the Channels button.

2. In the Explorer bar, click Channel Guide, and then follow the instructions on
your screen.

For more information on channels and IE, refer to the IE online help.
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To publish a document to a channel in BusinessObjects

E 1. Open the document, then click the Publish To Channels button on the
Document Exchange toolbar.

Publish fo Channel
veTen T Fhanne’s The Publish dialog box appears:

Publizh thiz document E
*r'ou have decided to publish this document with Microzoft channels.
— Diocument
Server. I& Retail BCS j

Document name: IHevenue

Document abstract: I

Icon caption
r— Chaninel
Mame | Comment |
Marketing channel this is the marketing channel, reserved to the users b...
Ianage.. |
Ok | Lancel | Help |
The dialog box shows:

* The name of the server for the user group you belong to.
* The name of the document.
* The channels you can choose from.

2. To select a different server, click the Server list box.
The following illustration shows that the user has three servers to choose

from:
Document
Server. I& Retail BCS j
5 o F AdminBLS
ocument name: Marketing BCS

Document abstract:

Html options... |

The supervisor sets up one server per user group, so you only have a choice
of servers if you belong to more than one user group.
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3. In the Document abstract field, enter the tooltip for the channel.
This information will appear over the channel icon in the user’s Web browser.

4. Click HTML Options to set the HTML formats for the document you are
publishing.
For information on the options in the dialog box appears, click the Help button
in the dialog box, or see “Saving a document in HTML format” on page 313.

5. In the Channels list, click the channel you want, then click OK.

What happens next?

* The HTML version of the document is posted on the Web channel you
selected.

* Microsoft Internet Explorer delivers the information to the channel
subscribers.

Setting up and managing channels in BusinessObjects

The supervisor sets up and manages channels, but privileged users can also do
this in BUSINESSOBJECTS.

To create, modify or delete a channel:

1. Open a document, then select the Publish To>Channels command on the File
menu.

2. In the dialog box that appears, click Manage.
The Channels Available dialog box appears.

3. The next step depends on what you want to do:

To... Click... Then...

Add a channel Add Go to the next step.
Modify a channel, e.g., The channel name | ¢ Click Modify.
point to a different URL * Go to the next step.
Remove a channel The channel name e Click Remove.

e Click Yes in the
message box that

appears.
e (Click Close.
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4. If you clicked Add or Modify, the Add a new channel or Modify a channel
dialog box appears:

Add a new channel

Business Objects Channel

C:h\38 I
hittp: 4 A businessobjects. com

Thiz iz an example

5. Specify channel info options.

6. Select a template.
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7. Specify the icons you want to use in the channel.
BUSINESSOBJECTS provides icons for you, and if you want to use these, select
Use default icons. To select custom bitmaps, click Select custom icons, then the
Icons button.
The Icons customization dialog box appears:

Icons customization E

*f'ou can select the bitmaps that will be shown in the browser.

— Bitmap:
Document icon: IE:\Program Filez4Business ObjectsyBus0bj 5.0
RBeport sheet icon: IE:\Program Filez4Business ObjectsyBus0bj 5.0
Section icon: IE:\Program Filez4Business ObjectsyBus0bj 5.0
Small channel icon: IE:\Program Filez4Business ObjectsyBus0bj 5.0
Medium channel icon: IE:\Program Filez4Business ObjectsyBus0bj 5.0
Large channel icon: IE:\Program Filez4Business ObjectsyBus0bj 5.0

Ok | Lancel |

8. To specify a different icon, type the path to a .gif file or click ... to find the file
using a browser.

Tip: Click OK to close the Icons customization dialog box, then close the other
dialog boxes to return to your document.
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Overview

Overview

A BUSINESSOBJECTS document can contain several individual reports within the
document. You can set the page orientation, paper size, and margins best adapted
to the contents of each report. For example, a report with a summary table and
chart may need a landscape page, while another report might have a long detail
table that works best on a portrait page. Before printing, you can check your page
layout in print preview.

You can choose to print the whole document, one report, or selected reports at
one time. You can print all the reports in one document on one printer, or you
can select different printers for different reports. For example, you might want to
send a report containing detailed figures to a printer located in your finance office
and send an overview of annual sales results to a printer in your marketing office.

Note: For more information about printing WEBINTELLIGENCE documents, please
see Part I of the INFOVIEW User’s Guide.
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Preparing Reports for Printing

When you're ready to print, go to the Page Setup dialog box. You can set and
check all printing options from this dialog box and then verify your settings in the

print preview window.

The settings you make for a report in the Page Setup dialog box will apply to the
report(s) you have selected. A report is selected if the title on the report tab
appears in bold. The settings you specify are saved with the report.

Setting up pages for printing

You can define and apply different page formatting to one report or to several

reports in your document.

1.

To set up pages for one report, make sure the report tab of the report you want
to format appears in bold. To set up pages for multiple reports, select the
report tab of one of the reports you want to print and then hold down the Ctrl

key to select the other reports.

2.

From the File menu, choose Page Setup.

The Page Setup dialog box opens.

Page Setup HE
r— Orientation =
i Marging... |
o F'  Landscape
FPage Mumber. .. |
=P
L Frinter... |
Sige: |44 210 % 287 om =l
Source: IAuto Select j
— Fit ta Print
@& adustto: |100 = % namal size
 Fit o |1 page(z] tall by |1 wide
Frint | Frint Prewview | QK I Cancel
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Setting page orientation

Choose the orientation for the printed page. The orientation you choose depends
on how your report has been set up. By changing the page orientation you can
sometimes fit more data on a printed page.

Choosing paper size

Choose the paper size and paper source. The options available here depend on
the type of printer you're using.

Fitting all the data on a specified page size

The Fit to Print option allows you to fit data onto a specified paper size by
enlarging or reducing the size of the data. You can use this option to make sure
that certain report elements will be printed together and avoid wasting paper.

Always check the result of any settings you make here in the Print Preview
window before printing.

Adjust To

This option reduces or enlarges the printed report. You can enter values between
10 and 400. The normal size is 100%. To do this:

1. Click the Adjust To option button.

2. Type in a scaling percentage.
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Fit To

This option allows you to reduce the printed report so that it fits on a specified
number of pages. BUSINESSOBJECTS calculates the reduction it needs to fit the data
on the specified number of pages. You can specify independent settings for
printing width and height. To do this:

1. Click the Fit To option button.

2. Type in the number of pages Tall and Wide you want your report to print on.

Pages Wide or Across
|

Pages Tall or Down

Note: The Fit To option cancels any Start New Page settings you’ve made in the
Format Block dialog boxes.
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Example Printing two stray columns on the same page as the rest of the table

When you look at your report in the print preview window, you realize that your
report is two pages wide simply because you have one column of a table that has
gone over onto the second page. This will not give a very satisfactory printed
result, one stray column on a page.

R BusinessObjects - Efashion.rep [_ (O]
Fage Setup | Mext Pagel Erey Pagel One Page | Zoom Jn | ZoonHut | Lloze |

Marain por Gty

|Page1/10 | Last Evec: 4/9/99 05:07 PM
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You can fix this by changing the settings in the Fit To Print section of the Page
Setup dialog box. If you enter 1 in the Wide box, BUSINESSOBJECTS will reduce the
overall width to fit the contents of the two pages on one page. However, since you
haven’t specified anything in the Tall box, BUSINESSOBJECTS will use the number
of pages necessary to print the whole report.

JH BusinessObjects - Efashion.rep

PageSetgpl ﬂextPageI F'regF'ageI One Page I Zoom Jn | ZoonHut Lloze

e -
G, Margnper gy

daveary

Pages1-2/ 4 | Last Evec: 4/9/99 05:07 PM

332 InfoView User’s Guide



Preparing Reports for Printing

Setting margins

When you view your report in print preview, you may notice that the current
margins are either too big or too small. You can adjust the margin sizes directly
from the print setup window. Remember that the minimum margins you can set
are determined by the printer you are using.

1. Click the Margins button to open the Margins dialog box.
Page Setup HE

— Marginz [inches]

Lef:  [o787
Top: W
Bight:  [0.787"
Bottom:  [0.757"

()8 I Cancel |

2. Type in sizes for the Left, Right, Top and Bottom margins, then click OK.

Note: You may be tempted to reduce the margins as much as possible to fit
everything on the printed page. Keep in mind, however, that reports are often
bound or stored in binders and you need to allow an adequate margin for this.

Setting page numbers

If you have inserted page numbers in your report, you can specify how page
numbering will be handled.

e Click the Page Numbers button to open the Page Numbers dialog box.

— Page Mumber
First page number: I
— Page Order

& Over, then down

€ Dowr, ther over

QK I Cancel Help
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Setting start page number

Type in the number you want to appear on the first page of the report to be
printed. This is useful if the report is to be bound with other documents, or with
reports printed from other documents.

Setting the page order for page numbers

When you have pages wide and tall in a report, you can control the order in
which the pages are numbered.

* Check this option to number
all pages down and then
across.

e Check this option to number
all pages across and then
down.

Note: Any formatting changes you make will be applied globally to all selected
reports. If you don’t want to lose the page settings already set up for individual
reports, click Cancel.
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Preparing Reports for Printing

You can print the different reports in your document on different printers. To do

this:

1. Select the report tab of the report you want to set up.

2. Choose Page Set up from the File menu.
The Page Setup dialog box appears:

Page Setup EHE
r— Orientation =
by Margins... |
o F'  Landscape
FPage Mumber. .. |
P
=Pt Frinter...
Size: Jas = 4@
Source: IAutomaticaIIy Select j
— Fit ta Print
@& gdustto: |100 = % namal size
 Fit o |1 page(z] tall by |1 wide
Frint | Frint Prewview | QK I Cancel

3. Click Printer...

4. Choose the printer you want from the list of available printers and click OK.

5. Click OK to close the Page Setup dialog box, or click Print Preview to view the
report, or click Print to print the report immediately.
All three choices confirm the page settings and printer you have selected.
These page settings are saved with the report.
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Checking Pages in Print Preview

Print Preview displays how your printed pages will look. In Print Preview you
can:

* Move easily between the pages of the report:
* Click Next to go to the next page in the report.
* Click the Prev button to go to the previous page in the report.

e Click the Two Pages button to display two pages of the report at the same
time.

* Go directly to the Page Setup dialog box to make any necessary adjustments
and then back to the Print Preview window to see the result.

* Open the Print dialog box to print the report.

To preview a report before printing it, click the Print Preview button on the
Standard toolbar.
Print Preview

Closes the Print Preview
window and goes back to
the report window.

Zoom in and zoom out
buttons enlarge orreduce the
display.

BusinessObjects - Efashion.rep

Fage Setup | Mext Page | Erey Bage | Two Pages Zoom Jn ZoonHut Lloze

Product $ales by City

FE T ST
L) I T I 22
2 N T e

|Page1/1E | Last Exec: 2/23/99 01:53 PM i
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Printing

Once you've adjusted all your page settings, you are ready to print. You can print
a single report, multiple reports, or all reports in a document.

To print a single report

By default, you will print the active report in your document. If the report you
want to print is not the active report, select the report tab of the report you want
to print.

1. From the File menu, choose Print.

2. The Print dialog box opens.
You can check the page settings of the report. You can also make temporary
changes to the page settings for this printout of the report. For example, you
might want to change the target printer or paper size.

3. Check or make the required settings then click OK. .

— Prirter
Mame: HF Chaptal Froperties |

Status: Drefault printer; Uzer intervention; 0 documents waiting
Type: HF Lazerlet 45i

Where:  \WAmmanthp_Zchap

Camment: Imprimante situe au Zeme etage cote Chaptal 11 ™ Print ta file
— Print Range Copie:
& |l 2 Pages Mumber of copies: |1

" Pages [rom:l Lo:l Ijl- -
Collate
' Current Page
Frint ‘/hat Fage Mumber
’7(3' Selected report(s] € &ll ieports ‘ ’7|_ Mumber across selected reports

()8 I Cancel |

Changes you make in the Print dialog box will only apply to this printout. The
page settings you make in Page setup are those saved with the report.
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To print multiple reports

1. Click on the report tab of one of the reports you want to print.
The name on the report tab is highlighted.

2. Holding down the Ctrl key, select the other reports you want to print.

3. From the File menu, choose Print.
The print dialog box opens:

— Prirter 1
Mame: YWWEOSPHORENHP4 ZIBERT Broperties |
Status: Feady
Type: HP Lazerlet 4000 Series PS
Wwhere:  2nd floor IBERT
Comment: 2nd floor [EERT ™ Frint ta file
— Print Range Copie:
% Al 3 Pages Mumber of copies: |1 3:
" Pages [rom:l Lo:l Ijl -
Collate
) Curent Page
Frint w/hat Fage Mumber
’7(3' Selected report(s] € &ll ieports ‘ ’7|_ Mumber across selected reports

()8 I Cancel |

When multiple reports are selected, the Properties button is grayed out. This is to
prevent you from overriding the different page orientations and paper sizes
already set up for the individual reports.

4. Check or change the target printer or select a page range and click OK.

Tip: To modify the page settings for these reports, use the Page Setup menu. See
“Setting up pages for printing” on page 328.

To print all reports in a document

1. From the active report, go to the File menu and choose Print.

2. Check All reports in the Print dialog box.
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Using the Print button
e (lick the Print button on the Standard toolbar.
Print The selected report(s) will print directly without opening the Print dialog box.

Note: When you print multiple reports, whether using the Print dialog box or the
Print button, all the selected reports will print to the printer targeted for the first
report you selected. If you have specified different printers for individual reports
in your document, you need to select and print the reports in batches by target
printer.

Setting printing options
This section describes the options you can set in the Print dialog box.

Choosing which pages to print

Set the pages you want to print in the Print Range section:

Choose.... To...
All Pages Print all the pages in the selected report or reports.
Pages From To Print the range of pages you specify in the text boxes.
Current Page Print only the page currently displayed on your screen.
This option is only available if Page Layout view is
turned on when you choose Print.

Setting which reports to print

Choose the reports you want to print from the current document in the Print
What section:

Choose.... To...

Selected report(s) | Print all the selected reports.

All Reports Prints all the reports in the current document.
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Setting the number of copies of a report to print

Choose how many copies of a report you want to print and how the copies are

printed:
Choose.... To...
Number of Copies | Type in the number of copies you want to print.
Collate If you are printing more than one copy of a report, you

can check the Collate box so that one complete copy of
the report is printed before the first page of the next copy
is printed.

Setting how page numbers print

Use this option to number all the pages printed in a print job from 1 to ?. You can
use this option if you have several reports to print but you want them to be
numbered as if they were just one document.

If you are printing.... Choose......
selected reports in a document Number across selected reports
all reports in a document Number across all reports

Note: You cannot view the result of this setting in Print Preview. This setting
temporarily overrides any page number settings you may have made in the Page
Setup dialog box. It is applied to the printout only and is not saved with the

report.
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Printing from Broadcast Agent

You can send documents to be printed from BROADCAST AGENT.

This allows you to print the same document to different printers, for example,
one copy to the marketing department and another copy to sales. For more
information on how BROADCAST AGENT can handle printing see “Printing a
document on different printers” on page 268.

Note: The printer set up a report when it was created may not be connected to
your machine. If this is the case, the report will print on the default printer of your
machine.

Printing Documents Made in BusinessObjects 4.1

BUSINESSOBJECTS 5.x uses standard Microsoft fonts. BUSINESSOBJECTS 4.1 used
fonts which are slightly different from standard Microsoft fonts.

If you're using documents created in BUSINESSOBJECTS 4.1, you can display and
print data in the fonts used in BUSINESSOBJECTS 4.1 so that your reports retain the
same look.

To do this:

1. From the Tools menu, choose Options.
The Options dialog box is displayed.

2. Click the General tab.

3. Check the option Print as BusinessObjects 4.1.

Note: When you check or uncheck this option, you may need to minimize and
then maximize the BUSINESSOBJECTS document window to see the change in the
display.
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A Word About Printers

To get the best possible printouts of your BUSINESSOBJECTS documents, bear the
following points in mind:

* You cannot print BUSINESSOBJECTS reports on text-only and dot.matrix
printers.

e If you are using a PostScript printer, make sure you are using the PostScript
driver delivered with your printer.

e If you are using a PCL printer driver, you may need to make some color and
font adjustments to obtain satisfactory printed reports.

Frequently Asked Questions

This section provides answers to some frequently asked questions about printing
BUSINESSOBJECTS reports.

How can | print several reports in one document at one time,
when each report has a different page setup?

You need to define the settings you want for each report in Page Setup before you
print. From the File menu, choose Page setup. The settings you define in Page
Setup will be applied to any reports you have selected. When you print multiple
reports using the Print menu or the Print button, these page settings will be
retained.

How can | specify the same page settings for several reports in
one document at one time?

You can apply the same settings to multiple reports. To do this, use the Ctrl key
to select the report tabs of the reports you want. From the File menu, choose Page
setup. The settings you define in Page Setup will be applied to any reports you
have selected. When you print multiple reports using the Print menu or the Print
button, these page settings will be retained.
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How can | ensure the best quality frorn my printer?

Print on a PostScript printer using the PostScript printer driver delivered with
your printer.

How can | ensure that one of the reports in my document will
print on a different printer?

You can select a specific printer for a single report in either the Print dialog box
or the Page setup dialog box. To ensure that the report will print to the printer
you have specified, you need to print this report separately. You can either use
the Print button or the Print menu.

My document has five reports. How can | set up reports 3, 4, and
5 in my document to print to a different printer than reports

1 and 2?

First you need to select the target printer for the reports. To do this:
1. Select the report tabs of reports 3, 4, and 5 using the Ctrl key.
2. From the File menu, choose Page setup.

3. Select the printer you want for the selected reports, for example “Marketing
Printer,” and click OK.

Now do the same for reports 1 and 2:
1. Select the report tabs of reports 1 and 2.

2. Choose Page setup to select the printer you want, for example “Finance
Printer,” and click OK.

You need to print reports set up for different printers separately. So, in this
example, you must print your document in two separate phases. First, select
reports 3, 4, and 5 and click the Print button. Then, do the same to print reports 1
and 2.
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If | select three reports from my document for printing, what order
will they print in and how will this affect the page numbering?

The reports will print in the order of the Report tabs in the document. For
example, you want to print Report 1, Report 3, and Report 4 from a document.
You select the reports in this order: Report 3, Report 4, Report 1. The order of
printing is: Report 1, Report 3, Report 4.

How can | print multiple reports at one time and only print
selected pages?

When you print multiple reports, you can opt to print a range of pages from the
selected reports. You specify a start page number and an end page number in the
Print Range section of the Print dialog box.

For example, your document has two reports. Using the Page Numbering option
in the Page Setup dialog box, you have set the page numbering in Report 1 to start
at page 5. If you open the File menu and select Print Preview, you can check how
the page numbers will appear when your document prints. Report 1 displays
page 5 on the first page and ends at page 7. Report 2 starts at page 8 and ends at
page 10:

Your document has two reports k E

N 10
\] 9
N

Report 2

5 To print the first four
Report 1 pages of the document,
the print range is 1-4.

In this example, the first page of Report 1 counts as page 1 in the Print Range. The
printed page number will appear as 5 on the printout.
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You want to print all pages of Report 1 and just the first page of Report 2. To do
this:

1. Choose Print from the File menu.

2. Type Pages from: 1 to: 4.
The page numbers you enter in Print Range refer to the pages of the reports in
the order of the report tabs in the document.
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.htm file extension 313
.pdf file extension 174
.rea 192
ret files 205
.rtf file extension 172
.RTF files
Broadcast Agent 241
.sbx files 205
.spt files 205
.xt file extension 172
TXT files
Broadcast Agent 241
@variable
Broadcast Agent 295
“You are not authorized to use this
document”
error message 172
4.1/5.0 document compatibility 116

A

accessing
document lists 40
documents 40
ActiveX Viewer see enhanced
document format
Add my name to the list
(option) 269
add-ins
installing 192
running 193
uninstalling 193
using 190
agnostic documents
viewing 85

batch processing see BROADCAST

AGENT

block type options 52

BOManager 131

BOUSER/BOPASS 300
Broadcast Agent 288

Index

combined with No Password

Checking (option) 288

Document Agent Server 300

limitation with report

bursting 291

OLAP data providers, and 293
Broadcast Agent 125-135

@variable function 295

4.1 documents, support for 233

access 237

Add my name to the list

(option) 269

basics 237

BOUSER/BOPASS 288

Cartesian products in

documents 294

changing Console display

settings 278

changing document

options 253

changing schedule of corporate

documents 259

channel properties 241

channels 320

channels, publishing

documents on 240

combining Time Scheduler and

File Watcher 273

condition evaluation 283

conditional processing 242

condition-based

processing 271

Console 253

contexts 300

custom error messages with

VBA 298

custom macros 240

distinguishing between

Weblntelligence and

BusinessObjects

documents 280

distribution options 247

document distribution

options 247

document priority 239
document processing
workflow 237

documents with

prompts 236, 250

documents with user

objects 236

enhancements over Document
Agent Server 299

error management 299
event-based processing 272
faster scheduling of corporate
documents 258

features at a glance 231

File Watcher 125, 131, 272
File Watcher (example) 244
finding documents from 205
finding processed

documents 262

frequently asked questions 233
introduction to 149
notification of documents to
retrieve 198

offline 252

order in which actions are
performed 241

overview 231

Overwrite mode 248, 268
printer access 268

printing documents with 240
processing documents when a
file is present 244

prompts 299

protecting documents with
passwords 275

publishing documents as text
or RTF 270

publishing documents on
channels 275

Refresh with the Profile of Each
Recipient (option) 240
refreshing documents 240
report bursting 240, 267
report chaining 246, 273
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Resolve button, in Console 282
resolving database connection
failure 288

resolving documents with No
Password Checking
(option) 288, 291

Retrieve From Broadcast
Agent button (Document
Exchange toolbar) 163

save as PDF 241

save as RTF 241

save as text 241

scheduling corporate
documents 256

selecting actions to

perform 239

Send to Broadcast Agent
button (Document Exchange
toolbar) 163

sending documents to 238
setting a schedule 244
Some obsolete objects have
been removed (error
message) 295

tips and tricks 266
troubleshooting 265-300
unable to process
BusinessObjects

documents 252
unscheduling corporate
documents 259

user objects, processing
documents containing 295
VBA macros 240

viewing task information in
Console 278

web publishing 317

web publishing
BusinessObjects

documents 317

what’s new? 231

see also Console (Broadcast
Agent)

Broadcast Agent Console 133

available columns (description
of) 279

closing 135

features 277

illustrated 278

opening 133, 278

refreshing display 278
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and Microsoft Exchange 219
Explorer module 146
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BusinessObjects 4.1

opening documents 170
viewing documents 164

BusinessObjects documentation x=

Xiv

BusinessMiner Tutorial xi
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Error Message Guide xiii
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multimedia presentations xi
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format 56, 58
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Editor 77

viewing in InfoView 74
what you can and can’t do in
InfoView 79
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BusinessObjects Reader
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BusinessQuery
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saving documents in
BusinessQuery format 173

BusinessQuery documents

saving in BusinessObjects 173

BusinessQuery files 205
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calculation contexts

condition evaluation for
Broadcast Agent 284, 285
keywords and Broadcast
Agent 285

keywords and Broadcast
Agent (example) 285

Cartesian product

sending document to
Broadcast Agent 294

categories 43, 150, 213

assigning documents to 99
assigning to documents 181
assigning when saving
documents in InfoView 107
availability in InfoView 213
Categories dialog box 214
changing from Publish
page 121

corporate documents 213
creating 181, 214, 243
defined 177

deleting 214, 243

filtering document lists 199
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finding documents by 206
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removing documents from in
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document categories 280
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Category Management page
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adding hyperlinks to 309
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languages 61
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documents 259
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automatic publishing with
Broadcast Agent 275
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publishing with Broadcast
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setting up for Broadcast
Agent 320
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Internet Explorer 320
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publish documents 240
Web browser versions
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channels? 275, 304, 320
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for documents saved as
HTML 311
for documents you
distribute 151
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comments
assigning to a document 206
using comments to find
documents 206
Compact display 41
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Broadcast Agent 284
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(example) 285
Condition not met
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formulas 286
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value-specific formulas 287
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condition-based processing with
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configure
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client/server 157
web 157
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Batchld column 280
Categories column 280
changing display settings 278
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Cross-Platform column 280
Delete File Watcher
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Document Type column 280
Ended At column 280
Error column 280
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features 277

Index
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File Watcher column 281
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illustrated 253
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BusinessObjects User’s Guide
custom macros
upgrading from 4.1 scripts 233
customizing InfoView 47-61
changing document list
display 55
changing password 61
selecting BusinessObjects
document viewing
format 56, 58
setting a picture 48
setting start page 50

data
copying to another
application 176
exporting 176
loading into a spreadsheet 111
data providers
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finding documents by 206
finding documents by total
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finding documents by total
number of rows 208
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command 149
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finding by keyword 207
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editing documents see
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e-mail 219
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Send to Mail button
(Document Exchange
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sending documents
by 215, 219
working online when sending
documents 219
email
addresses, adding links from
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enhanced document
format 28, 115, 258, 261
illustrated 76
printing 110
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toolbar 77
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viewing 76
Enter or Select Values dialog
box 250
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error
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Message Guide

Error Message Guide xiii
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Broadcast Agent is not
online 252
No data to fetch 92
Some obsolete objects have
been removed 295
You are not authorized to use
this document 220
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Broadcast Agent 298
Error Message Guide 297
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Agent 299
viewing Broadcast Agent
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in HTML 311
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exporting
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F
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Delete the file each time the
task starts (option) 246, 274
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example 244, 273
file locations supported 131
file types supported 131
path to file 132
recommended file path
convention to use 132
typical use 131
UNC 132
viewing status in Broadcast
Agent Console 280

files
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Download.htm 316
reportname.htm 316
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Find Documents button (Document
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documents by data
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documents by keyword 207
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documents on the
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pages 37
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column in Broadcast Agent
Console 281

page
landscape 329
orientation 329
portrait 329
setting margins 333
setting numbers for
printing 334
setup 328
pages
contents 37
navigation bar 38
topbar 38
paper, setting size for printing 329
passwords
and HTML 305
changing 61
for launching
BUSINESSOBJECTS 157
in documents processed by
Broadcast Agent 275
security domain 288
PDF
online guides xii
pdf
save as with Broadcast
Agent 231
saving documents as 174
PDF Acrobat Reader 28
viewing documents in 78
PDF files 241
Broadcast Agent 241
personal
categories, creating 181
personal document
list, viewing in
BusinessObjects 177
list, viewing in InfoView 177
retrieving 177
personal documents 45
retrieve from 180
saving on server 180
send to 180
upload document to 104
Personal Documents page 45
preview
pages before printing 336
print
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generating HTML before
sending 226
groups of users 221
HTML options 225
Select Groups dialog box 223
selecting categories 224
setting up navigation for
HTML documents 227
subscribing to channels in
Internet Explorer 320
Push see channels

Q

queries 24
running 188
query options 188
Query Options dialog box 189
Quick Search 43
Quick Tour xi
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Refresh Data button (Standard
toolbar) 77, 162
refresh frequencies
Daily option 128
Hourly option 128
Monthly Interval option 130
Monthly option 129
Once option 127
User Defined option 130
Weekly option 129
refresh options
eliminating duplicate rows 188
limiting number of rows
returned 188
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refreshing
documents with a prompt 186
setting automatic options 186
refreshing documents 89, 240
automatically 125-135
BusinessObjects documents
published on the web 318
in InfoView 89
manually 89
Refresh with the Profile of Each
Recipient (option) 267
scheduling options 127-130
setting refresh options when
saving in InfoView 108
with prompts 90
with prompts and Broadcast
Agent 250
renaming
categories 182, 214
renaming categories 243
rep files
downloading 115
report bursting 149, 231, 240, 267
and Overwrite mode 268
caution about volume of
documents generated 268
distribution via repository
only 267
documents containing OLAP
data providers 293
example 267
limitation with BOUSER/
BOPASS 291
Overwrite mode 268
report chaining 246, 266, 273
Report Manager
hiding and displaying 169
report viewer see enhanced
document format
reports
opening 170
ReportScript 233
Convert from ReportScript
command 234
converting scripts to VBA
macros 233

how to fix VBA conversion
problems 234
ReportScript scripts 205
repository 20, 212, 247
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document domain 212, 237
DS_PENDING_]JOB table 288
Find Documents button
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toolbar) 163
finding documents 150
finding documents on 203
JOB_DATA column 288, 290
Publish To Corporate
Documents button (Document
Exchange toolbar) 163
publishing documents 221
Retrieve From Corporate
Documents button (Document
Exchange toolbar) 163
Retrieve From Users button
(Document Exchange
toolbar) 163
retrieving documents from 213
security domain 288
Send to Users button
(Document Exchange
toolbar) 163
sorting documents on 201
Resolve button 282, 288
Resolve button, Broadcast Agent
Console 290
Retrieve dialog box
Find options 208
illustrated 199
More>> button 208
Show only this category of
documents (option) 201
retrieve from
personal documents 180
Retrieve From Broadcast Agent
button (Document Exchange
toolbar) 163
Retrieve From Corporate
Documents button (Document
Exchange toolbar) 163
Retrieve from Personal Documents
button (Document Exchange
toolbar) 163
Retrieve From Users button
(Document Exchange toolbar) 163
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retrieving
personal document 177
retrieving documents 213
according to user profile 200
do documents remain on the
repository? 200
Document Exchange
toolbar 197
document types available 196
filtering document lists by
category 199
filtering documents by
category 201
from users 197
into folder other than
UserDocs 202
notification of documents to
retrieve 198
Open on Retrieval
(option) 203, 209
opening on retrieval 203
overview 196
processed by Broadcast
Agent 262
Retrieve dialog box
(illustrated) 199
Retrieve Into command 202
setting order of categories 201
sorting list of documents 201
toolbar button to use 197
using document
properties 150
using search criteria 203
using the Find Documents
button (Document Exchange
toolbar) 199
viewing document
properties 202
viewing retrieved documents
immediately 209
viewing retrieved documents
in BusinessObjects 209
You have no documents to
retrieve (message) 197
rich text format, saving documents
in 172
rows
finding documents by total
number of rows 208
RTF files 270
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selecting 241
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Save for all users (option) 220
Save page 107
saving documents 107
as BusinessQuery files 173
as pdf files 174
as PDF with Broadcast
Agent 241
as RTF with Broadcast
Agent 241
as text files 172
as text with Broadcast
Agent 241
BusinessQuery documents 173
character set for HTML
documents 311
in pdf format 174
in Personal Documents 180
in rich text format 172
maximum number of
characters in report tabs
(HTML) 151
Save for all users (option) 220
Save for all users option 172
WeblIntelligence
documents 175
scheduled processing see scheduled
documents
scheduling documents 125-135
based on a condition 242
BusinessObjects
documents 235
categories 243
changing distribution
options 253
changing schedule of corporate
documents 259
channels 275
combining Time Scheduler and
File Watcher 273
Condition not met
(message) 272
corporate documents 256
deleting scheduled
document 135
documents with prompts 299
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Over The Web (options) 258
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documents 258
File
Watcher 131, 244, 246, 272
frequently asked questions 233
HTML options 248
icon for scheduled
documents 259
Microsoft OLAP Services data
providers, and 292
monitoring Broadcast
Agent 277
monitoring scheduled
documents 133
OLAP data providers, and 292
OLAP server password
changes, what to do when 294
OLAP User Identification
dialog box appears, what to do
when 251
output folder 241
printer selection 241
printing 240, 268
refreshing 240
report chaining 246, 272
RTF 270
setting a schedule 244
setting start and stop dates 246
text 270
tips and tricks 266
troubleshooting 297
unscheduling corporate
documents 259
value-specific results for
condition evaluation 286
WeblIntelligence
documents 235
what happens on the
server 237
with prompts 250
scheduling documents Broadcast
Agent
BOUSER/BOPASS 288
scripts
updating to current
version 233
scripts and macros 205
search criteria for finding
documents on repository 203

All documents option 205
categories 206
comments 206
Corporate documents
option 205
data provider name 206
data source 207
document domains 205
document information 203
document properties 206
document type 203
keywords 207
name 207
Processed documents
option 205
size 207
subject 207
submission date 207
title 208
total duration 208
total number of categories 208
total number of rows 208
User documents option 205
Search page 71
searching for documents 71
Quick Search 43
Weblntelligence
documents 209
searching for documents on the
repository see finding documents on
the repository
sections
displaying delimiters 167
folding in outline view 165
security
BOUSER/BOPASS
variables 288
No Password Checking
(option) 288, 291
security domain 288
choosing 157
connecting to 157
Send Document to Broadcast Agent
dialog box 238
Send To Broadcast Agent button
(Document Exchange toolbar) 163
Send to Mail button (Document
Exchange toolbar) 163
Send to Personal Documents button
(Document Exchange toolbar) 163
Send to Users button (Document



Exchange toolbar) 163
Send to Users page 123
sending documents 123, 212
Add-ins and other types of
files 218
by e-mail 219
categories 213, 216
generating HTML before
sending 226
HTML options 225
setting up navigation for
HTML documents 227
to groups of users 221
to individual users 212
to users 216
troubleshooting 141
sending documents to Broadcast
Agent 237-253
@variable 295
see also scheduling documents
automatic channel
publishing 275
Broadcast Agent Offline
(message) 252
calculation contexts for
condition evaluation 285
Cartesian products 294
categories 243
changing Console display
settings 278
changing distribution
options 253
changing options for
documents you have sent 253
changing schedule 253
channel properties 241
combining Time Scheduler and
File Watcher 273
condition evaluation 283
Condition not met
(message) 272
conditional processing 242
condition-based publishing
over the Web 271
contexts 300
custom VBA macros 240
defining error messages in
VBA 298
distributing via server file
system 249

distributing via the
BusinessObjects

repository 248

distributing via World Wide
Web 249

error management 299

File Watcher 246, 272

File Watcher (example) 244
formulas compatible with
condition evaluation 284
monitoring document
processing 277

order of actions 241

output folder for text and RTF
files 241

password protection 275
printing 240

publishing on channels 240
refresh before condition
evaluation 284

refreshing 240

report bursting 267

report chaining 246, 272
resolving database connection
failure 288

save as PDF 241

save as RTF 241

save as text 241

saving documents as text or
RTF 270

selecting actions to

perform 239

selecting output folders for
different file formats 270
selecting printer 241

setting a schedule 244

setting distribution

options 247

setting start and stop dates 246
testing database

connection 273

testing formula before
sending 285

troubleshooting 265-300
using the Formula Editor 242
viewing errors in Console 297
Weblntelligence documents, in
InfoView 125-132

sending to

personal documents 180

server sizing for report bursting 268
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set up pages for multiple
reports 328
set up pages for one report 328
setting a picture 48
Show only this category of
documents (option) 201
size
finding documents by 207
sorting
categories on repository 201
documents to retrieve from
repository 201
sorting document search results in
InfoView 72
spreadsheets
choosing application 112
example of data from
InfoView 112
loading data into 111
Standard HTML Format
(option) 258, 261
start page
default 36
setting 50
subject
assigning to a document 207
finding documents by 207
submission date
finding documents by 207

T

tall
printing pages 330

TELNET 309

templates 205

text files 241, 270
Broadcast Agent output folder,
selecting 241

Time Scheduler
File Watcher, and 273

tips x

tips and tricks
automatically printing
documents on different
printers with Broadcast
Agent 268
channel publishing 275
condition-based web
publishing 271
Delete the file each time the
task starts (option) 272
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File Watcher 272
passwords and scheduling
documents 275
personal document
processing 269
publishing documents in
different formats 270
Refresh with the profile of each
recipient (option) 267
report bursting 267
report chaining 272
scheduling documents 266
title
assigning to documents 208
finding documents by 208
toolbars
Document Exchange 151, 163
hiding and displaying 161
Standard 162
Visual Basic 164
topbar 38
total duration
finding documents by total
duration 208
troubleshooting 137
"The document contains no
data" 140
"The required service is not
available" 140
"This script is taking an
unusually long time to
finish" 141
"You cannot export the
document as it is in 4.1 format
in the repository" 141
Broadcast Agent 265-300
Broadcast Agent and user
objects 295
Broadcast Agent Offline 252
changing language for
enhanced document format 62
changing your password when
server password has
changed 289
Condition not met (message
from Broadcast Agent) 272
documents unavailable on the
repository 200
Error Message Guide 265, 297
InfoView 138-141
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spreadsheet 139

No data to fetch (message) 92
ReportScript to VBA
conversion 234

scheduling documents with
OLAP data providers 294
Send /Publish window
partially displayed 141
Some obsolete objects have
been removed (error
message) 295

see also Error Message Guide

U

universes 24

unscheduling corporate

documents 259

updates x

updating
documents (see refreshing
documents)
personal categories 98
printing BusinessObjects 4.1
documents 341
repository categories 97
scripts that send e-mail via
Outlook 234
scripts to VBA macros 234
to Broadcast Agent 234
vewing BusinessObjects 4.1
documents 164

updating to current version
4.1 scripts/sending mail via
Outlook 234
Broadcast Agent
enhancements over Document
Agent Server 299
character set for document
names 151

upload
and send to users 105
documents created in another
application 101
to Corporate Documents
list 102
to Personal Documents list 104

Uploading
documents 47

user identification 157

user objects

Broadcast Agent, and 295
scheduling documents with
user objects 236
user profiles
real-time users 200
UserDocs folder 202, 203, 316
retrieving documents 200
users
Retrieve From Users button
(Document Exchange
toolbar) 163
Send to Users button
(Document Exchange
toolbar) 163
sending documents to groups
of users 149
using Quick Search 43

Vv

variables
creating variables for condition
evaluation (Broadcast
Agent) 287

VBA 233
tweaking macros converted
from ReportScript 234

VBA macros 205

view
outline 165

View Data button (Standard

toolbar) 77, 162

View full report (option) 308

View users in my groups only

(option) 217

viewing
BusinessObjects 4.1
documents 164
document attributes 94
documents 73
documents in
BusinessObjects 80
retrieved documents in
BusinessObjects 209

viewing documents 27, 73-77
BusinessObjects documents in
BusinessObjects 80
BusinessObjects documents in
enhanced format 76
BusinessObjects documents in
InfoView 74
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Netscape Editor 77

BusinessObjects documents in

PDF Acrobat Reader 78
created in other
applications 85

Document Results page 73
options for BusinessObjects
documents in InfoView 75
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WAIS 309
web
connection 157, 198, 201
Web browsers
that support channels 320
web page for documentation x
web publishing 303-319
and passwords 305
Broadcast Agent 317
defined 303
Doclinks.htm file 316
Download.htm file 316

downloading documents 306
enabling users to download

documents 226, 311, 314
examples 303

files and folders created 316

frames 306

frequently asked questions 306

graphics resolution 306
HTML objects 307
illustration of published
document 308

keeping data up-to-date 318

process 304

report navigation 306
reportname.htm file 316
seclinks.htm file 316

setting up navigation 311, 315
View full report (option) 308
writing HTML in reports 309

Web server
selecting Web server for
document processing with
Broadcast Agent 249
Weblntelligence
generating HTML before
sending/publishing
documents 226

searching for WeblIntelligence
documents on the
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setting HTML options for
sending and publishing
documents 225

setting up navigation when
sending/publishing
documents 227

Store HTML in document
(option) 226

Weblntelligence documents

saving 175
scheduling 235

Weblntellingence

opening documents 170
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adding links to from
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document distribution 148
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printing pages 330
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